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DRTrack Overview

Appian DRTrack adds real-time visibility to DirectRoute with fleet tracking and web-based reporting.
With the ability to use GPS data from a variety of hardware tracking systems and devices, DRTrack can
also provide online track-and-trace services for your customers, automatically updating estimated
arrival and departure times for customer locations. Trip reporting lets you compare planned-vs.-actual
route mileage, planned vs. actual driver hours and more. Web based reporting tool and GPS tracking

Capture, store and update route data automatically with DRTrack and make it more widely available to
business stakeholders—including your customers. DRTrack lets managers, customer service or sales
personnel access delivery schedules, monitor route info, review estimated delivery times and trip
history directly on the web. Give your customers secure access with DRTrack to only their shipment
data. Offer DRTrack’s high-value self-service options and win new business.

With DRTrack, our clients are provided the following services:

e Server and database maintenance

e Hardware with all associated maintenance and upgrades
e Database clustering and failover

e Physically isolated disaster recovery

e Server load balancing

e State of the art network security

e Technical support associated with DRTrack to end users

Getting Started—DRTrack Set Up

DRTrack will require setup on a single virtual/physical instance of a server or PC with minimum
configuration. Server requirements and configurations can be found in DRTrack Server/PC
Requirements. Your assigned Appian Project Manager can provide you with any updates and/or
changes, answer any questions, and assist the Site Administrator with the initial set up.

DRTrack Server and PC Requirements

Server and PC system requirements may vary and can be affected by various factors such as other
Appian software modules licensed and in use on the server and/or PC, the number of licensed users on
the server and/or per customer, and the types of operating systems in use.

The Connection Requirements Table identifies the minimum requirements necessary for users to
connect to a self-hosted DRTrack site. The Web Server Configuration Table identifies the minimum
configuration requirements for larger loads distributed across multiple servers to run each or any
combination of the primary components.

Connection Requirements

CONNECTING USERS
Browsers Minimum IE 9; recommend IE11, Chrome, Mozilla, FireFox
Required Connection High speed/broadband data connection to the internet
Monitor 19” min with 1024X768 resolution
User Permissions Internet access to the following: DRTrack website, Reporting Server
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Web Server Configuration

0-100 TRUCKS

100-350 TRUCKS

350-700 TRUCKS

1000+ TRUCKS *

Windows 2016

Windows 2016

Windows 2016

Windows 2016

Soyii;:'”g Server, 32 or 64-bit | Server, 64-bitw/lIS | Server, 64-bitw/llS | Server, 64-bit w/IIS

w/llS, .NET 4.5 and .NET 4.5 and .NET 4.5 and .NET 4.5

SQL Server 2019 SQL Server 2019 SQL Server 2019 SQL Server 2019
Database Express or greater Express, 64-bit Express, 64-bit Express, 64-bit

w/SSMS w/SSMS w/SSMS w/SSMS

Quad core 2.8 GHZ or | Quad core 2.8 GHZ or | Quad core 2.8 GHZ or | Quad core 2.8 GHZ
Processor . . . .

higher higher higher or higher
Memory 4GB 8 GB+ 16 GB+ 32 GB+

125 GB .Recommend 160 GB. Recommend 220 GB. Recommend 220 GB. Recommend
Hard Disk Raid 0, 1, or 10 Array, | Raid0, 1, or 10 Array, | Raid 0, 1, or 10 Array, Raid 0, 1, or 10 Array,

DB Growth 5+ MB DB Growth 5+ MB DB Growth 5+ MB DB Growth 5+ MB

(device/month) (device/month) (device/month) (device/month)
Network 1 GB dedicated NIC 1+ GB dedicated NIC 1+ GB dedicated NIC 1+ GB dedicated NIC
Card for Terminal Services for Terminal Services for Terminal Services for Terminal Services
Network Open /Public/ Ext IP; Open /Public/ Ext IP; Open /Public/ Ext IP; Open /Public/ Ext IP;
Connection | T1/T3 or higher T1/T3 or higher T1/T3 or higher T1/T3 or higher

Port 80 must be open for inbound and outbound traffic. Additional ports may be required for
Ports communication between IIS, SQL Server, 3rd party interfaces, etc. (dependent on how servers and

applications are deployed)

Special architectural considerations may need to be taken into account when this threshold is
exceeded to an extraordinary degree.

Server Requirements by Component

Each component can run individually or in any combination together. The server configuration for larger
server loads can be distributed to multiple servers, to run each or any combination, of the primary
components.

The following breakdown is provided for running each component as an individual server:

SQL Server (2019 Express) Operating System

Windows Server 2016, 64-bit

SS Management Studio (SSMS)
SS Data Tools (Business Intelligence) (SSDT)
Visual Studio 2017
ID with Database and System Admin credentials for DRTrack database
Deploy read/write credentials for reporting services
Admin folder permissions for a DRTrack report repository in SSRS website
Port 1433 (or other) for database connectivity
TCP/Named Pipes enabled
Backup policy and procedures (mirroring, clusters, or other failover setups as directed by user’s
organization)

Enterprise versions of SQL Server (2019 Express, 64-bit)

Virtualization supported
10/100/1000 connection to other servers if stand-alone instance
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Drive Space Requirements

o Operating System and Paging File: expect 20+ GB
o Database Primary file, Log, and temp Database, Initial size: 250 MB (expected)
o Database average growth of 5 MB per month per device (or per route)
o GPSdatais primary growth factor; rates can vary between providers based on number of
points per hour returned; range of 1 to 10+ MB/month/device
o Planned Route Data is secondary growth factor; range of 1 to 2+ MB/month/route
o Recommend SCSI, SATA2, or SATA3 HD arrays
o RAIDO, 1, or 10 for primary data file (RAID 5 not recommended)
o Separate drives for primary data file, logs, and temp Database (better performance and speed)
Memory
— Ensure operating system and database version support memory requirements
- 1+ GB for operating system (more is better)
- 1+ GB for normal database operations (more is better)
— Add 2+ GB per 100 tracking devices; add 1+ GB or more for reporting load
Processor

— Recommend Dual Quad Core (or other multi-core processors)
— 2 cores for Operating System and 2 for Database basic operations
— Add 1+ core per 50 trucks, and 1+ core for reporting services (+ = better/faster)

Website Operating System
e Windows 2016 Server, 64-bit

.NET 2.0

.NET 3.0

.NET 4.5, with .NET extendibility

e Backup policy/procedures, load balancing, and other multi-server failover setups as directed by
your organization

e Recommend Virtualization support

e 10/100/1000 connection to other servers if stand-alone instance

Drive Space Requirements
o Operating System and Paging File: expect 20+ GB

o DRTrack Website: 150 MB

o Logfile growth: conigurable log levels for troubleshooting

o Recommend SCSI, SATA2, or SATA3 HD arrays

o RAID 1,5, or 10 for redundancy and failure protection
Memory

o Ensure operating system and database version support memory requirements
o 1+ GB for operating system and add 1+ GB per 200 DRTrack users

3rd Party GPS Data Interfaces Operating System
e Windows Server 2016, 64-bit
e .NET2.0
e .NET3.0
e .NET 4.5 with .NET extendibility
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e 10/100/1000 connection to other servers if stand-alone instance

Drive Space Requirements

o Operating System and Paging File: expect 20+ GB
o Sync Service: expect 250+ MB per instance of a sync service installation
o Multiple sources of GPS data allowable, each with its own Sync Service
o Additional considerations for HD space needed
o XML, Flat, or other file interface (saved or deleted after processing)
o Local or database server
o Log file mode: ERROR, DEBUG, INFO, etc.
Memory
o Ensure operating system and database version support memory requirements
o Add 1+ GB for Operating System, and additional 1+ GB per Sync Server instance

Typical DRTrack Server Setup
DRTrack will require setup on a single physical or virtualized instance of a server with the minimum
configuration. The specs for this server are for standard users with approximately 350 vehicles (specs
would increase with more than 350 concurrent users/phones).

e Windows 2016 Server, 64-bit with IS installed

e Open/external IP (with external URL setup for accessing website)

e 24GHz

e 8GB+

e 125 GB drive space (expect 5 MB of growth per device/month)

e Port 80 open for inbound/outbound traffic

e T1 connection between servers, client access; serving pages to/from website

Other Recommendations

e Consider RAID 10 for performance/data redundancy

e SCSI, or SATA2 or SATA3 drives for faster HD drive performance to access DRTrack database
e Dual/Quad processors for larger loads

e 8+ GBRAM

e T1/T3 connection




Access and Login

Every DRTrack user will be assigned to a specific role. Each role has varying permissions, dependent on
the access level granted. Your Site Administrator will be responsible for assigning these access levels and
roles, as well as site maintenance and updates. The typical DRTrack site includes the following assigned
roles:

e Customer Service—24/7 access to current status of deliveries, searchable by Account ID, order

number, and/or order date; can be accessed from any computer or mobile device

e Dispatch (Branch)—View/modify orders, trucks and drivers; dispatch and track routes

e Account (Regional)—Add/edit branches and accounts; perform audits

e Administrator (Enterprise)—Add/assign users, module and site maintenance

To get started using DRTrack, contact your Site Administrator for access level role assignment and a
DRTrack Login ID/Password. The Site Administrator will also provide the DRTrack website URL address.

Authorized users should access DRTrack using the URL provided by the Site Administrator.

1. Launch a web browser (Chrome, Internet Explorer, etc.)

2. Type inthe URL address of your DRTrack site (provided)

3. Select a login screen
a. If assigned the Customer Service role, select the first option, Customers: Track Your Orders
b. If assigned to any other level (Dispatch, Account, Administrator), select the second option,

Login to DRTrack

c. Enter the Username/Password when requested

Username

Password

= LOGIN Version 2019.4.1.45

Figure 1—DRTrack Login for Dispatch, Account, Administrator Login

AccountID 1749

Order No
Email
From Date  3/13/2020 B8

ToDate = 3/132020 [

Refresh O
81403: Out for Delivery
A Approxc 12 hours ago
Account: 1749 Address: 3040 PIEDMONT , ATLANTA
Est. Arrival: 3/13/2020 5:04:51 AM Act. Arrival: N/A
Est. Departure: 3/13/2020 5:12:51 AM Act. Departure: N/A

Last Pos.: N/A
Stops Remaining: 2

Figure 2—Customer Service Order Tracking
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Site Administration

Within DRTrack are different levels of access, determined by roles that you may be assigned to perform.
Each role is then assigned to a User Group with specific persmissions, views and capabilities. The Site
Administrator has sole control of assigning roles and capabilities within DRTrack.

Typical User Group names include Customer Service, Dispatch, Branch Manager, and Administrator.

e The Customer Service Group may have permissions to view and modify orders only.

e The Dispatch Group may have permissions to view and modify orders, create and modify routes,
trucks and drivers within their assigned branch.

e The Branch Manager Group may have the same permissions but expanded to include all
branches, and they may also be able to create new customer accounts and orders.

e Administrators have full access to all actions within all branches, as well as the ability to create
new users and customize the capabilities of each User Group.

Site

e 4 Branch Manager

Administrator
Dispatcher o Driver

Figure 3—User Group Manager

User Group Manager

The User Group Manager is assigned to manage permissions associated with the different user roles
within each User Group. Each role is like a point of service within their respective group with abilities
assigned by heirarchy; each point within the heirarchy would have greater or lesser access/capabilities
than others.

For example, the Account Manager role could be added to this heirarchy (between Administrator and
Branch Manager) and assigned all capabilities of each role below Branch Manager, but less capabilities

than an Administrator.

To access the User Group Manager, go to Admin > Site > User Groups & Permissions.

10
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I Branch Manager
& Provision Map Manager
@& Audit
B Customers
& Dispatch
g RBouting
& Custom Inputs
& Ultilities O Licensing
- Modules
£ Settings & Configuration
© Tasks

8% | JserGroups & Permissions

& Users

Figure 4—Manage User Groups & Permissions

1. Use the drop down menu to select a User Group role to edit, or +Add to add a new one
2. Edit the following as needed:
a. Manage Roles—Assign permissions to each Role
b. Manage Modules—Assign permissions to each User Group
c. View Permissions—View current permissions assigned to the selected User Group
d. Landing Page—Set the default landing page; the ‘Home’ page for all roles except Customer
Service
e. Role—The permission levels assigned to each User Group (ex. Branch Manager, Dispatcher,
etc.) should have all the same abilities of each role assigned under the branch

S ¥ | +aDD & MANAGE ROLES

Administrator
Settings Roles

§1/ 52 modules enabled +ADD | —DELETE

o Role

2 permissions granted > 0O Administrator

Landing Page

Figure 5—User Group Manager

Manage Roles (Permissions)

The User Group Manager is generally tasked with managing roles within their group. This entails
assignhing permissions, or determining which actions each Role may need to perform.

Go to Admin > Site > User Groups & Permissions and click on View Permissions. Permissions are divided
into 12 categories.

11
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e Routing—Permissions to view, create, modify, delete, and audit routes; manage master routes
and trucks, receive emails when route time violations occur, and run optimization across
multiple routes

e Dispatch—Permissions to export routes, manually log in and off routes, and manually change
arrivals and departures

e Orders—Permissions to view, create, modify, delete, and audit orders; create, modify, and
delete appointments, manage master orders, and receive emails on completed forms and order
reservations

e Accounts—Permissions to view, create, modify, delete, and audit accounts

e Branches—Permissions to view, create, modify, delete, and access all branches

e Drivers—Permissions to view, create, modify, and delete drivers, and manage carriers

e Users—Permissions to view, create, modify, and delete users

e Devices—Permissions to view, create, modify, and delete devices

e System Task—Permissions to view, create, modify, delete, and run system tasks

e Site—Assigned as an administrator with full permissions for all actions

e Route Calendar—Permissions to edit notes on the Route Calendar

e Appointment—Permissions to grant appointment approvals

Dispatch h “ ADD = DELETE
Dispatch
O SAVE
O Routing Dispatch O Orders
Can view routes Can export routes Can view orders
[m] Can create routes ] Can manually log in and log off reutes Can create appointment slots
o Can modify routes Can manually change arrivals and departures Can modify existing appointments
o Can delete routes Can delete appointment slots
[m] Can audit routes [m] Can create orders
o Can manage master routes o Can modify orders
[m] Can manage trucks [m] Can delete orders
o Receives emails when route time violations occure o Can audit orders
o Allows user to run optimization across multiple routes o Can manage master orders
[m] Receives emails when ferms are completed
o Receives order reservation emails

O Accounts O Branches O Drivers
Can view accounts [m] Can view branches [m] Can view drivers
o Can create accounts o Can create branches o Can create drivers
[m] Can modify accounts [m] Can modify branches [m] Can modify drivers
o Can delete accounts o Can delete branches o Can delete drivers
o Can manage emails o Can access all branches o Can manage carriers
[m] Can audit accounts

O Users O Devices O System Task
o Can view users o Can view devices o Can view system task
[m] Can create users [m] Can create devices [m] Can create system task
o Can modify users o Can modify devices o Can modify system task
o Can delete users o Can delete devices [m] Can delete system task
[m] Can run system task now

Figure 6—Manage Roles

1. To edit, select the Role type from the drop down menu at the top (left) of the page
2. Place a checkmark in the box to the left of the modules and actions to be accessible to the Role
3. Click Save when done

Manage Users

The User Manager page is used to add new users and assign them to branches, assign Roles and User
Groups, reset passwords, and set up notification emails.

12
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Create a New User
Go to Admin > Site > Users and click the Add New button.

1t Branch Manager

@ Provision Map Manager

@ Audit

B Cusiomers

o Dispatch

42 Bouting
(& Custom Inputs

ilities O Licensing

- IModules
% Settings & Configuration
© Tasks

u UserGroups & Permissions

Figure 7—Manage Users

0O user First Name Last Name Email Address

o admin admin ianlogistics.com

o t appian test pappianiogistics.com

(m] appian test track@appianiogistics.com

Figure 8—Create New User

Edit User | Andmitch
General info Motification Options

[m] Notify me when dii

nd text messages

O  Notify mewhen fo

O  Notify me wher

Branch Access <—— Screen Tabs
o Branch ID Description City State -
1 Jasper Ja N
MO

Kansas City

ooooao

Figure 9—Assign Branches, User Groups, Permissions

Fill in all the fields under General Info

Assign the User Group role using the drop down menu

Select the appropriate notification boxes under Notification Options

Use the tab Branch Access tab to assign the user to the appropriate branch(es)
Use the tab Dispatch Groups to assign to any of the established Dispatch Groups
Click on the Save button when done

ok wNE

Edit Current Users
Go to Admin > Site > Users and select the user record from the list in the User/D column.
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Edit any general info as needed (name, email address, password, etc.)
Use the User Group drop down menu to designate the User Role

Select & to configure the User Group (view or change the configuration settings for each role)
Approval Code: Enter a code that identifies who/why access is approved (if used)

Notification Options: Select all options that may apply to the user

Use the tab Branch Access to view and/or edit branch assignments

Use the tab Dispatch Groups to view and/or assign to a Dispatch Group

Use the tab Permissions to view and/or assign permissions

XN AW N

Manage Modules

The Module Manager provides the Site Administrator the ability to control which menu items and
actions will be accessible for each User Group. This entails assigning permissions, or determining which
actions each User Group may need to perform.

Additionally, Quick Links shortcuts that appear on the default Home page and in the Quick Links tab on
the main menu, are selected and set up from the Module Manager.

To access the Module Manager, go to Admin > Site > Modules.

DRTrack =Dispatch~ |~ Reports -

Home / Module Manager

Module Manager

Administratar

a

elect All Parent Name Select All Parent Name Select All Parent Name Select All Parent Na/

Banner Manager

a

reate Account

[m]
a

Account History Report Account / Order status
Branch Summary Order Management
Report

DOT HOS Exception
Report

reate Order Branch hianager

a
a
]

a

Email Manager

a

Paily Planner (Bela)

[m]
(]

Provision Map
Manager

ast Position

(<]
a

Driver Performance
Report

Device Map

a

]
o omert Driver Trip Report
M Oriver Login

O o o

Edit DOT/Activity Logs

o g

Merge Driver fo Route

Figure 10—Manage Modules

Make Modules Accessible

To make modules accessible to a User Group
1. Select the User Group type from the drop down menu in the middle of the top of the page
2. Place a checkmark in the box to the /eft of the modules or actions to make them accessible to
the User Group
3. Click the Save button when done

Note: The box on the right of the module/actions, with the heart icon above it, is used to add the item to
the Quick Links shortcut.

Create Quick Links Shortcut

Quick Links appear on the far rightside of the main landing page, and in the far right of the menu at the
top of every screen.
1. Select the User Group type from the drop down menu in the middle of the top of the page
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2. Place a checkmark in the box to the right of the modules or actions to make them accessible to
the User Group as a Quick Links shortcut.
3. Click the Save button when done.

Home

Make Accessible Add Quick Link
Parent Nome O  selectas Parent Name B selectal N (] Parent Name
= B Account History Report ] @ Account/ Order status (] [ o
8 = s © tanag G a)
] i

Figure 11—Make Modules Accessible

View Permissions

View the menu items and actions, or permissions, that are currently assigned to each User Group, and
make changes when necessary.

Go to Admin > Site > User Groups & Permissions and click on View Permissions.

UsarGroup Permissions

Routing Dispatch Orders

B canview routes B  Canexportroutes B Canview orders

B Cancreateroutes B Canmanually log in and log off routes B Cancreate orders

B Canmodify routes B Canmanually change arrivals and departures B Canmodify orders

B Candelete routes @ Candelete orders

B canaudit routes B Can create appointment slots

B Canmanage master routes B Canmodify existing appointments

B Canmanage trucks B Can delete appointment slots

B Receives emails when route time violations occure @ Canaudit orders

B Allows user to run optimization across multiple routes B Can manage master orders
B  Receives emails when forms are completed
B Receives order reservation emails

Accounts Branches Drivers
B Can view accounts B Canaccess all branches B Canview drivers
@ Can create accounts @ Canview branches B Cencreatedrivers
B Can modify accounts B Cancreate branches B Can modify drivers
B cCandelete accounts @ Canmodify branches @ Candelete drivers
B Canmanage emails B Candelete branches B Canmanage carriers
B Can audit accounts
Users Devices System Task
B canview users B  Canview devices B Canview system task
B Cancreate users B Cancreate devices B Cancreate system task
B Canmodify users B Can modify devices B Can modify system task
B cCandelete users B Candelete devices B Candelete system task
B Can run system task now

Figure 12—View Permissions
1. To edit, select the Role type from the drop down menu at the top (left) of the page

2. Place a checkmark in the box to the left of the modules and actions to be accessible to the Role
3. Click the Save button when done

DRTrack Dashboard

The DRTrack Dashboard is divided into four sections, as numbered in the figure below:
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Main Menu (1)—Appears at the top of the screen on every page in DRTrack; four primary
sections provide assigned, accessible actions based on the user’s assigned role; plus Quick Links
(configured shortcuts), user admin (Hello User), and Logout

Dashboard (2)—Statistical snapshot of route and stop statistics for the current day +/- 1,
including completed, violated, delayed, active, not taken, etc.

Active Routes (3)—Provides a snapshot of active routes, including driver assignments and
devices, branch, start and end times, number of stops and miles, etc.

Quick Links (4)—Also available in the upper right corner of the Main menu, Quick Links are
configurable shortcuts for a User Group to pages within DRTrack most frequented or used by
that group (see Create Quick Links Shortcut)

Homel ! g

o

@lshboard
Routes Stops Tobar May 13, 208 Dispatch
Total Routes - 240 Total Stops- 1238

Quick Links

== Completed

= Violated
Delayed

= Active

== Noi Taken

Active Routes \
i Route Statistics Q

J

== Completed == Time Window Violations Delayed == Delayed == Not Completed

Figure 13—DRTrack Home Page

Each of these four sections is briefly described below. Click on the links to go directly to the respective
sections, or continue reading to view all.

Dispatch—Dispatch provides access to many route, order and device actions available to the
dispatcher, including order and account creation, route edits and re-dispatch, and Driver/Device
Map, Route Board, Route Calendar (Resource Planning), etc.

Reports—Provides access to configured reports, including Account History, Branch Summary,
Driver Performance, and Trip Reports, etc.

Customer Service—Provides Customer Support access to manage orders and accounts
Admin—Provides access to branch and customer accounts, set up and manage drivers, users,
and devices, input configuration requirements for import/export between DirectRoute, as well

16
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as other database management functions; access levels within this tab vary among DRTrack
users and are controlled by your site administrator

Dispatch Tab

The Dispatch tab provides access to the most frequented actions regarding daily operations. This would
include managing orders, drivers, devices and/or routes.

The following actions can be accessed from Dispatch. Click on eack link below to go directly to that item,
or continue reading to discover all actions performed through Dispatch.

e (Create Account

e Create Order

e Device Map

e Driver Login

e Last Position (Device)

e Merge Driver to Route

e Re-dispatch Routes

e Route Board Page

e Route Calendar

e Build Routes Page

®* Routes Page

e Route Summary

e Route Map

e Unloaded Orders

Create Accounts (Edit, Delete)

There are two ways to create new customer Accounts:
e Go to Admin > Customers > Accounts and select the Add New button

Using the later option, an existing account can also be edited or deleted, making this the most peferred
method. Regardless of which option is used, both options will open the Account Management Detail
screen, where all the new customer info will be entered.
1. Inputall pertinent account information (ex. Delivery Time Windows, Time Window Adjustments,
Quantity Fields, User Fields, etc.)
2. Select Geocode (top of the screen) to locate the Lat/Long matching the customer address
3. Select Save after all editing is completed

If editing or deleting a current account record, go to Admin > Customers > Accounts. Follow the
instructions above to edit any record. To delete a record, select Delete from the top right corner of hte
screen.

Additional actions available on the account page include:
1. Manually enter Lat/Long coordinates to actual stop addresses; use the mouse to move the

green circle Y 1o adjust location on the map then Update Location or Cancel when done
2. Update Load Default to the customer account
Save as Default to save as 'default’ info (see Load Default)
4. Audit will display a list of recent DRTrack type activity performed on an account

w
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Create Order

There are several ways to create an order in DRTrack, but Dispatch > Create Orders

is the most direct method. Some of the other places in which an order can be created include
1. Dispatch > Routes
2. Customer Service > Order Management
3. Dispatch > Route Calendar

Note: Any order created on the Create Orders page will be an Unloaded Order. To add/load the newly
created order to an existing route, navigate to Dispatch > Routes > Unloaded Orders.

The steps for creating an order are the same, regardless of where you start.

From Dispatch > Create Orders
1. Use the search function to identify the correct branch and AccountiD
2. Once the AccountlID is listed on the page, click on it under the Account/D column, OR
3. Select Create Account to add a new account

Branch: —All—v Q Georesult: - S SHOWALL | | © CREATE ACCOUNT

Branch ID Account ID Account Name EQCode Address

HO75 042862-1 Jeff Test Customer 5506 STONEHENGE DR
HO75 042862-2 Jeff Test Customer 2400 DALLAS PKWY STE 251
MAIN 042862-3 Jeff Test Customer 7080 MAIN ST

HO75 042862-3 Jeff Test Customer 7080 MAIN ST

MAIN 1042501 PINCH A PENNY #117 10057 W HILLSBOROUGH A
MAIN 105228-D NATIONAL POOLS OF PASCO 10208 SCENIC DRIVE

MAIN 107170-D POOL MASTERS 117 W PROSSER DR

MAIN 138044-M321 PINCH A PENNY #142 MANDALAY MARKETING 12239 W LINEBAUGH AVE
MAIN 153816-M514 RAINBOW POOLS INC. 1318 EDIANA ST

MAIN 156465-M611 PINCH A PENNY #16 / CHESTNUT 1330 Seven Springs Blvd

Figure 14—Create Order Step 1

4. Enter all pertinent Account and Order information, including Quantity and User Fields data
5. Select the Time Windows and Time of Day Adjustment tab to enter all necessary info
6. Select Finish from the top right corner, to complete the order input
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Home / Create Order

Create Order Form - Step 2 of 2

Account
City/State
Address

Zip Code

042862-1 / Jeff Test Customer
RICHARDSON / TX

5506 STONEHENGE DR
75082-4024

Branch ID Ho75 = W%

AUTOGENERATE ORDER ID

ShipTe

Same as account address

-

Order Information

Est. Ship  1/1/0001 B 12008 @ FixedTime = 0 (min)
Quantity and UserFields ~ Time Windows and Time A e
Qiy Fields  Value Unload Rate User Fields Value
Weight EstShipDate
Pallets Description
Cube LOADID
VIN
Vehicle ID
ltem
Price

Figure 15—Create Order Step 2

Upon completion, the confirmation screen will appear with the new order highlighted.

Home / Create Order

©  Order created successfully

Branch: | —Al—[=] | Q [Account ID or Name Showall | | Create Account

12345678910 Next » Page size: |20
BRANCHID ACCOUNTID ACCOUNT HAME Eacope ADDRESS oy staTe apcope
MAIN 1 Aue Russel 500 W HENDERSON ST CLEBURNE ™ 75031
MAIN -2 Soiser Rich 2060 W SPRING CREEK PLANO ™ 75023
MAIN 3 M Kenzie Charles 8501 MEADOWEROOK DR FORT WORTH ™ 78112
MAIN 0 Leon D 1200 WEST MAIN GUNBARREL ™= 75147

800 W 15TH ST
800 W 15TH ST PLANO T 75075

Teny Karl

MAIN Terry Karl

Figure 16—Order Confirmation Step 3

Device Map

Device Map allows a user to select a device and/or vehicle to view planned, completed or uncompleted
routes assigned to a specific device.

The appearance of the map itself can be customized with a variety of map styles and overlays. To change
the map style, click on the stack icon in the upper right corner of the map and select the map style and
overlays desired.
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K|

_L 7
@ {Portla,
Ic-Lb L 2ad /(;
Base Layer \_

Standard Map View

Black & White Style

i Road Atlas Style
Contemporary Style
Night Style
Smooth Style
Satellite View

Overlays

Drawing Layer
/ Routing wn
(]

Greenville, Provid}‘nce
\ 7"" OBgtnSlaDJe

e Fall'River

q.

(-]
Lghew London Vineyard Haven

eenport

50 km
20 mi

>A.|__

Search

From

To

All devices

-75.12718, 42.39540

4 Prev

GPS

Stops

11/6/2017 £

162017 B

Figure 17—Select Map Style and Overlays

Next W

Map

The Device Map info box, located below the map, displays the route details for the selected device, and
the corresponding stop information.

o Seq
e AccountID
e Account Name

e Planned Arrival/Departure
e Actual Arrival/Departure
[ ]

Estimated Arrival/Departure

o TS —.
5 a - =
o i
¥ Freserar P %
L
Se—— - —
L J ] s
- e F— -
P
0 T E
0 :'
i S [—
" [ G |
S—prr—
W .-
e i
-l "
TR opege w s g s "
g Tet 1t ot Fereara - a
. . L1 L Y
e i + L] L
[ & LY a
[l L1 LY
[ - a
[ L - - L
ot pr— o m P —— a a
[e= [ e ] ‘ ] ATy [l a

Figure 18—Device Map
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To view a device's planned, completed or uncompleted route info
1. Use the controls on the right to select a branch and device from the drop down menu
2. Select From/To dates
3. Below the date boxes, use the drop down menu to choose which devices to view

4. Zoom to a specific stop on the map by clicking on the Q zoom icon, to the right of each stop

Note: Device Map for a specific route and/or Driver from the Route Summary page (Dispatch > Routes)
by selecting the road icon ﬂ adjacent to the desired route.

The Device Map Controls and Quick Inspector menu can be undocked and moved to either the left or
ride side of the map. Use the grey drop down arrow in the top right corner of each menu to select the
docking location, or hold the arrow and drag the box to the desired location.

= Minimize
= & Undock
wel e s -
Beverly <+ Dock Left
=+ Dock Right
OBoston
Search
Quincy
) From 1vezo17 B3
Brockton
To 1yeen7 |
lidence &l devices *
=]
y =
Fall River o
o]

Figure 19—Device Selection, Device Map Controls

Driver Login
Driver Login lets you log in a driver to a route, or pre-assign or log a driver off of a route.
1. Select the branch and enter the route number, if known

2. Select the DriverID and input Login Time (Date/Time the route should begin)
3. Select DevicelD assignment (if specific to driver, this will prepopulate automatically)
4. Input TruckID for the route and Odometer Start, if known
5. Select Log In/Update (or Log Off, Pre-Assign)
[ biveriogn ]
ranch s <]
FromDate 212017  #8  Display *
o Login Route # Driver ID Device ID Login Time Vehicle ID Odometer Start Trailer1 Trailer2 Logpoff Time Odome;erEnd
o 6 Not Selected ~ Not Selected ~ 017 zooam © =] °

Figure 20—Driver Login
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Note: Only Drivers associated with the selected Branch will be displayed.

Last Position (Device)

This option allows the user to select any device to view its last reported position on the map. This
information is only available if the driver is logged in to the device.

[ LastPositionMap __J (v
# Prev Next M
—All— -
Filker ~ Search

From /22017 =

To 27272017 =

All devices -

@

Figure 21—Device Last Position

Locate the branch for the device, or select ALL.

e Filter—Search for devices by date
e Search—Search for devices by address location on the map in relation to the selected device(s)
e  Map—Search the map for last seen position stopped, moving, or clustered points

Merge Driver to Routes

Merge or unmerge drivers to and from routes.
1. Select the branch and route date and eligible routes will populate
2. Select the negative route (route to be merged) and the Merge to route, then click the Merge
Routes button

Merge Routes |
Branch —ai— -
Route Date  2/28/2020 [}
Negative Routes -2 ROUTE CALENDAR Drake Griffin v

Merge To 107 ORGANIX-IL-TEST] +

MERGE ROUTES

Figure 22—Merge Routes

To unmerge routes
1. Select the branch and route date and eligible routes will populate
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2. Select the route to unmerge, then click the Unmerge button

Unmerge Routes

Branch —ai— -
Route Date  s5/13/2020 [

Route to Unmerge 18 20 tyler corr +

UNMERGE ROUTE|

Figure 23—Unmerge Routes

Re-Dispatch Routes

From the main menu, select Dispatch > Routes.

1. Use the drop-down menu to select the correct Branch identifier

2. Setthe From date to the day that the routes are to be dispatched (defaults to the current date);
edit the time if necessary (earliest time that trucks can depart)

3. Setthe To date to the last day routes should be dispatched (same date as From unless routes
are scheduled to leave after midnight); edit the time if necessary (latest time that trucks can
depart)

4. Select Search; all routes that meet the set search criteria should now be displayed

5. Use the mouse tool to hover over and review route info, or use the menu tools to make
additional route adjustments and/or edits if necessary

DRTrack

Home / Routes

- 227

From 2/27/2017

Branches —al— 1z00aM @ To z27riz017 B nseem @

[ Advanced Search Options

Figure 24—Dispatch Routes

Load Unloaded Orders - Review and load any orders that are not currently loaded on a route
Invert Route—Reverses the order of delivery of the stops, from first to last

Reschedule - Reschedule the dispatch date of the route

Export - Export the finalized routes back to DirectRoute and/or an Order Management Module
Optimize—Use to reposition stops on a route, after changes have been made to stops that affect
delivery dates/times

Reschedule—Reschedule stop delivery window times and/or date

Move Stops—Move stops between routes, from one to another

Audit—Provides a brief overview of events that have occurred

Route Board

The Route Board is map centric; it enables viewing existing routes and orders on the map, as well being
able to see the orders and routes in list format below the map. You can access the Route Board
(Dispatch > Route Board) to review planned routes and stops, and make changes as needed.

e Additional actions that can be performed from the Route Board include

e View Unloaded Orders
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e Geocode Unloaded Orders
e Create/build new routes
e Assign Points of Interest (POI’s)

T [ Rose
S . o OPTIMIZE ~ | G INVERT ROUTES | @ UNLOAD STOPS
@ alRoustes O Mot Completed Routes

O ™ oste ®™ Logn Hre Miles E0code Wi
¢ id

Load Date: N/A Driver I0: N/A Driver Phone: N/A Device ID: N/A & MORE ACTIONS

o Acct Name Eqoode Pin Time actTime st Time weight Pallets

Figure 25—Route Board

By default, the search dates appearing will default to the current date. You only need to select the
calendar icon to change the dates.

Select the Route Board menu on the right to enable Branch and/or date selection.
1. Use the drop-down arrow to see available branches
2. Use the left mouse key to click and select a branch
3. Select the calendar icon to change the date, or type the date (mm/dd/yyyy)

Home
: 2
S .
+ Sacramento
] g
& E
A [}
OPTIMZE~ | X INVERT ROUTES | & U
® aliroutes O Not Completed Re
Master Flag
PRINT MAP DATA Routes
Loar Driver Phone: N/A Device ID: N/A ©/MORE ACTIONS
[u] Pin Time Act Time Est Time Weight Pallets A
o wa-wA
> D A~ N/A 0.00
> 0
* 0 NA-NA
o )6:24 Thu NrA-N/A

Figure 26—Route Board Properties
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The active routes for the selected branch/date will appear directly below the Route Board menu on the
right. By default, the master flag box will be checked, selecting all the routes/stops for the selected

branch/dates.
1. Deselect the Master Route box

Selected route(s) will be highlighted blue

vk wnN

will remain in the bottom screen

Select just one route (Rt# column) to view it on the map

On the bottom of the screen, the list of stops for the selected route will appear
Deselect the route in the same manner and the route lines will disappear, but the route details

Note: To adjust the map view area, click and hold the mouse button and drag the screen to adjust. You
can also zoom in/out of an area; double click the mouse over the desired area, or hold the shift key and

click the mouse to draw a box around the desired area.

v ow e

oo o oo
228

mE s

Figure 27—Route Selection
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Home / Route Board
" T Fouie Bourd a p
e ® Branch | KELLY.W B
| Q Search
I ® Daily Routes Master Routes
I L
Fom 2172000 8 Fom 217 3
To 2182018 2B
By Rt Start date ¥
| Routes [v]
5 invert = -
1 93 120 91800 0.0
3 14 85 527 61000 000
14 1as 3230 105700 0.00
PRI corete 2018 K . 10 100 2379 5100 0.00
EPRIEIIEN Coyrght 2018 ALK Teshnoioges In -0 2500
L 10 136 2860 502.00 0.00
1 88 583 83800 000
1 129 817 703.00 0.00
8 Route Detail 20 128 716 1,073.00 0.00
16 136 2355 45900 000
Route ID: 215 - Thu Load Date: 02/18/116 Driver ID:N/A  Device ID: NA & optimze 32 invent @ Unioad Stops. 19 132 150 544.00 0.00
2 15 22 s200 000
. 16 120 625 931.00 0.00
T StartTerminal  StariTerminal 06:05- 06:50 Thu 06:05.- 06'50 Th
>0 1 1014740 WAFFLE HOUSE #5 @15 07:10-07:20Thu 07400720y 3200 0,00
> 2 1074441 CEFCO #2080 @215 07:33-07:46Thu 07:33-0746Thu  18.00 000
| 3 POUR HOUSE @215 08:00-08.05Th 0800-0805Thu 1000 0,00
> 4 1103 SALTGRASSRESTAURAN @215 08:19-08:31Thu 06:19.0831Thy 3300 0,00
t | 5 1013146 GOLDEN CORRAL FAMILY @215 08:37 - 08:47 Thu /A 08:37 - 08:47 Thu 14.00 0.00
> 6 112103 WALGREEN'S #13124 @215 0914-0936Thu  NA-NA 0914-0936Thu 7000 000

Figure 28—Route Board Map

Build Routes Page

Building routes on the Route Board is designed for building routes in bulk using an existing truck profile
and a set of unloaded orders.

To enable this function, it must first be turned on in Settings & Configuration.
1. Navigate to Admin > Site > Settings & Configuration

Use the drop down arrow adjacent to Section and select U/

Type enablebuildroutes in the filter box then select Filter

Select Edit, then Value to enable the function (checkmark the box)

Select Update to save and complete

vk wnN

Now return to the Route Board (Dispatch > Route Board). Generally, the Route Board should be empty
of any active daily routes, and there should be orders ready to load in the Unloaded Orders pool.

Home / Configuration Manager

Configuration Manager Filter Settings

Section ui -

Section

ui

Y Enablebuildroutes

Name

EnableBuildRoutes

Value

Edit

Description

Determines whether or not the Build Routes option is available for use

Figure 29—Enable Build Routes
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Figure 30—Empty Daily Routes (Route Board)

To build a new route:

1. Select the Build Routes tab In the upper right hand corner of the Route Board

2. Edit Build: Branch (use the drop-down menu to locate), Dispatch date (use the calendar tool to
change the date), and Profile(use the drop-down menu to select the vehicle profile)

3. Edit Unloaded Orders: Dispatch Start date/time and Dispatch End date/time, using the calendar
tool to change the dates if necessary

4. Select Build Routes

Route Board []
Branch DFW LOCAL -
% Build Routes
Dispatch 117272006 2

Profile DFW -

Start 11/2/2016 £ 1200aM @

End 11722016 {4 11:59PM

 BUILD ROUTES

Figure 31—Build Routes Tab
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L] " Build Routes

&

Oooooo0O0OO

Figure 32—Build Routes Results

The newly built route will appear on the map and will be listed in the Route Detail list.
1. Tounload any stop, select the stop from the Route Detail list, then select Unload Stops
2. Toinvert the new route, select Invert Routes
3. To edit any other stop and/or route details, use the Route Summary page (Dispatch > Routes)
page

Route Calendar

The Route Calendar could be considered Resource Centric; it provides day/time views of your resource
availability, providing the status of your resources as well as your deliveries with visbility through out a
day, week or month and across your entire organization.

The Route Calendar can be configured to display as much or as little detail as needed. You can change
how items are grouped and displayed, what information is displayed, and add color coding to events
and/or various resources.

Some of the actions that can be performed from the Route Calendar include
e Add an order to an existing route
e Load unloaded orders
e Move a route to another resource, or another day of the week
e Schedule resources for maintenance
o (Create appointments
e Schedule driver PTO
e Build routes from Unloaded Orders using the drag and drop method
e Add driver breaks
e Geocode orders
e Assign Points of Interest (POI’s)
e Export or print delivery sheets

To access the Route Calendar, select Dispatch > Route Calendar from the main menu.
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9:30%

10:00

10:30

11:00

11:30

—
Orders and Routes o
Unloaded Orders ﬁ

Show unloaded orders 1 daybefore ¥ to 1 day afer - o»[ E)SAVEVIEW = TREFRESH = v SAVECHANGESTOORDERS OCREATEORDER = & SUGGESTRESOURCES  + GEOCODE ORDERS I
*»0 Order Location AccountName Est. Del EQCode Weight Cube Tm. Wnd. Geo
Y b4 b A g ¥: A b4
*0 WHITNEY, TX Ansari Morteza 8/10/2016 Flat 0 0 600 1900 21
>0 BENBROOK, TX Van Duyne Aaron 8/10/2016 Box 0 0 1200 1900 Level0

Figure 33—Route Calendar

The following is a brief outline of what may be found, and where, on the Route Calendar.

Branch (1)—A drop-down menu enables selection of any assigned branch (assigned by
administrator)

Schedule Resource Type (2)—Select which schedule type to display on the calendar (driver,
truck, route, etc.) ; ref. to (5) below

Calendar Date (3)—Select a date to view and plan; or select a week, month, or specific time-line
to plan future periods of time; can also view any past period of time

Scheduled Resource (4)—Each column is labeled based on the resource type selected (Routes,
Details, Drivers, Vehicles); assignments for each will be listed in the appropriate time block when
scheduled

Time of Day (5)—Displayed for each day listed; choose the number of hours to display (work
day, 24 HR, etc.)

Appointment Details (6)—List the details for each resource scheduled; details vary based on the
resource type (2) (ex. driver assignments may show vehicle# and order details, while vehicle
assignments may show driver name, drive time/service time, etc.)

Orders and Routes (7)—Bottom section of the Route Calendar

Unloaded Orders/Route Details/Unassigned Routes Tab (8)—The Unloaded Orders tab will list
each order that has not yet been loaded onto a route, the unload reasons, available drivers and
assets (suggested resources), and enables drag/drop to load each order onto a route; the Route
Details Tab displays more info about each stop/order that has been loaded onto a route; the
Unassigned Routes Tab displays those routes that have not yet been assigned to a vehicle
and/or driver
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e Action Menu (9)—A list of actions available on this page, including Save Changes, Refresh, Create
Order, and Geocode Orders.

Routes

The Routes page provides the ability to view and/or edit current routes for any branch. To access the
page, navigate to Dispatch > Routes. The default screen that appears will show all routes for all
branches.

Home / Routes
(SR outes E

~| From 1212014 B8 1200An @ To 1212014 B8 11:50PM

Branches = —All-

*| Advanced Search Options

Figure 34—Routes Page Search

1. Select the correct BranchlID for the desired location.

2. Setthe From date to the day routes are to be dispatched (default is the current date), and the
To Date to the last day routes are to be dispatched (should be same as From Date unless routes
are scheduled to leave after midnight)

3. Click the Search button

Branch |—Al— [z] FromDate 02032013 @ 0000 ToDate 02052013 @ 2350 | (I
Han invet  Reschedule  Exportfo peoplenet  Send Email
r MAIN020427 MAIN M2012-03 AL L] Al Miles 107 02/04 06:16 02/04 16:58 1 999 260 020041636 A
r MAIN020429 MAIN M2012-02 JAIME L] Jaime Aponte "7 02/04 03:41 02/04 15:21 1 8//8. 373 02041533 A
r MAIN020430 MAIN M2012-01 JIMT L[] Jim Thompson 195 02/04 04:30 02105 12:01 1 558 693 020051559 A
r MAIN020431 MAIN M2012-05 JASON L] Jason Carbone: 104 02/04 04:59 02/04 15:22 1 3310 214 020511:33 A
r MAIN020432 MAIN M2012-06 BOB L] Bob Sheehan 16 02/04 05:46 02/04 17:22 1 1010110 260 02041635 A
r MAINO20434 MAIN 421030 edm2 L] edm2 edm2 091 02/04 03:02 02/04 12:08 1 43 370 020041401 A
r MAIN 35 MAIN 604236 HDL2 L] DAVE HDL2 091 02/04 03:02 02/04 12:08 1 333 370 02/04 14:31 A
r MAIN020436 MAIN 568737 HDL3 HDL3 09.1 02104 03:02 02104 12:08 1 o3 370 NA A
r MAIN 7 MAIN M2012-03 AL o Al Miles 203 02/05 05:15 02/06 14:10 1 4 586 02051600 A
r MAIN020529 MAIN M2012-02 L] Jaime Aponte 124 02/0502:38 02/05 15:00 1 109 an 020051428 A
r MAINO20531 MAIN M2012-04 L] Jason Carbone 091 02/05 03:02 02/05 12:08 1 333 370 020051216 A
r MAIN020532 MAIN M2012-06 L] Bob Sheehan 170 02/05 05:34 02/06 11:03 1 e 436 020051535 A
r MAIN020534 MAIN 421030 L] edm2 edm2 105 02/05 05:14 02/05 15:45 1 9919 268 020051453 A
Figure 35—Routes Page

Route Summary
The Route Summary (Dispatch > Routes) displays a list of current routes in Dispatch Routes. The
summary includes the information listed below, and can be viewed in an edit mode to allow for quick
changes when necessary. Data can be sorted by selecting any of the column headers (ascending order).
e Route #—Select a route # to view the Stop Summary for that route
e  Branch—Originating BranchID for the route
e Device ID—Used by the driver generating the tracking data for that route
e Driver—Select a driver name to edit/create a Driver Login for the specified route);hover the
mouse over the name to view the DriverID
e Login—Color of the circle indicates the driver's status; green=logged in, red= not logged in,
yellow= preassigned
e Name—Name assigned to the DriverID
e Time—Total work time for the route
e Start Time—Scheduled start or departure time for the truck
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e End Time—Scheduled route end time or return time of the truck

e Legs—Section of the route displayed

e Stops—Total number of stops on the route

e Miles—Total miles of the route

e Last Position—Last reported GPS position for the route, with time and date
° A—Opens the Planned Route Map Display for the selected route

° Q—Indicates a Time Window Violation has or is projected to occur on the route

° O—Indicates an arrival delay to the stop

° " _Used to reverse the order of a route (select the icon to invert the route)

° —Indicates a message is attached to the route (select the icon to read the message)
e More Action—Select to display additional actions

e Display Truck Info—Select to view the Truck Detail screen

e Invert Route—This will cause the route to be run in a reverse order

e Switch Route—Switch selected route for another route within same branch

e Edit Route Forms—Update/edit any forms associated with this Branch

Driver Pre-Assignment

When the pre-assigned driver logs into the route, the system will correlate the driver, truck, and device
in order to display the appropriate GPS data for comparisons with the planned route. You can verify that
a driver has been pre-assigned to a route by the values under DevicelD, Driver, and Name. (Refer to
Driver Login for additional info)

A yellow circle in the Login column indicates the route has been Pre-Assigned to a driver. A green circle

in the Login column indicates the route is currently logged into GPS tracking. A red circle indicates the
route is logged out of GPS tracking and the GPS device can be assigned to another route.

LAST

ROUTE # BRANCH DEVICEID DRIVER LOGIN NAME TIME START END LEGS STOPS MILES iy P
Darryl 04/02 04/02

> E 401 101MI 621246 67663 Ay 118 1 o055 073 NA A
Landskroener 04:00 15:49
04/02 04/04

> E 402 101MI 107433 6934 Rob Sydor 525 1 o006 0% NA A
04:00 08:28
04/02 04/03

> E 403 101MI 682268 88705 Donald Farmer ~ 36.8 1 o005 108 NA A
04:00 16:49
04/02 04/02

> E 404 101MI 621247 62969 Cory Kirkland 12 1 005 04 NA A
04:00 15:11
04/02 04/03

> E 405 101MI 682266 64664 Marcus Crawford  24.0 1 0/0M13 404 N/A A
22:00 21558
04/02 04/02

> E 406 101MI 621248 7234 Russ Wiliams ~ 12.2 1 o006 133 NA A
04:00 16:10
04/02 04/03

> E 407 101MI 666261 90790 Jamar Ross 211 1 oo 379 NA A
05:00 02:03
04/02 04/03

> E 408 101MI 666262 7719 Don Wilber 217 1 oos 576 NA A
04:00 01:39

Figure 36—Driver Pre-Assignment

To change a driver pre-assignment:
1. Click on the blue entry under the Driver column for the route you wish to change; this will open
the Manual Login box
2. Select Remove Preassignment to remove the currently assigned driver
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Login
Preassigned To Darryl Landskroener

Using Device 621246

Remove Preassignment

Route # 401

Branch 101MI -
Driver ID 67663 - Darryl Landskroener *

Device D 621246~
Login Time 422015 &3 400AM O
Truck ID
Odometer Start
Trailer ID1

Trailer ID2

" i || B pesssn

Figure 37—Manual Driver Login

The Manual Login box will close and the routes list with reflect N/A for the record that was just updated.

LTS

> E 403 101MI 682268 88705 Donald Farmer 36.8 04:00
04/02
> E 404 101MI - N/A - 112
04:00
04/02
> E 405 101MI 682266 64664 Marcus Crawford  24.0 22-00

Figure 38—Driver Pre-Assignment Removed

Click on the N/A to reopen to the Manual Login box

From the DriverID drop-down list, select the desired driver for the route.

Select the DevicelD from the drop down list if necessary.

Enter the name or number of the truck being assigned in the TruckID field, or just enter the
DevicelD again.

5. Once the entries are complete, select Pre-Assign (you can also manually login the driver by
selecting the green Log In button)

N =

Edit Routes

Most route data can be edited from the Route Summary page.

To change the Start or Stop Time:
1. Select Edit Mode from the upper right corner of the page
2. Place acheck in the box adjacent the route and edit Start/End Date and/or Start/End Time
3. When complete, select Reschedule for a date change, or Change Start Time for a time change

Inverting routes will reverse the order of the planned stops. To invert a route:
1. Select Edit Mode from the upper right corner of the page
2. Place a check in the box adjacent the routes to invert
3. Select Invert

Stop Summary

The Stop Summary is a summary view of all stops assigned to any particular route. When viewing the
stops, they can be sorted by Stop, Order# or Line Items. To change the view and/or sort option, select
the header column or select the View By drop-down arrow.
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To view a Stop Summary, navigate to Dispatch > Routes.
1. Select a Route# from the column to view the Stop Summary for that route
2. Toview an Order Detail Summary (Details) for any stop, select the OrderID, or select the
Sequence# (SEQ)

DRTrack

OopoDoOooooOoO o

£ RocK

Figure 39—Stop Summary

Home / Routes / Stops / Order Detail

BranchiD: CALARK Account ID:  APMAB & Pln Arv/ Dept:  02/16 04:50 - 05:05
Route No:  THU1 Account AMERICAN PAPER Est Arv/Dept: 02/1604:50-05:05
Order ID: ;508707 - . Act Arv/Dept: N/A
Contact CURT VERNON FixedTime: |, .
Line temID: 508707 w Name:
Phone No:  501-407-3365 Closed TW: False
e 2162 Billing 11611 OTTER CREEK SOUTH Zone: 100
EqCode: 4 Address: RD
MABELVALE, AR, 72103-1659
Modified: ]
o]
Dity: Address: 11611 OTTER CREEK
Afct. Routing: [ SOUTH
%’:‘“a"ze NoT SET - City/State: MABELVALE / AR

Zip Code: 72103

ShipTo | 11611 OTTER CREEK SOUT ™

Time Speed Adjustment Delivery Time Windows

AM Start (hhmm)  PM Start (hhmm) Open Close § M T w R F A
AM End (hhmm)  PM End (hhmm) IR
AM Adj PM Adj ¢ == 0 0O 0OO0OD0OO0OD

o ¢ OO O o o o o

Earliest Date  2/16/2017 B3 Latest Date 2/16/2017 B8

Qty Fields User Fields

Quantity Stop  Order Line Item Act Value Unld rate User Field Value
Weight 200 200 200 0 0 Bill to Code SPRMEM
Pieces 0 0 0 0 0 DriverlD

Pallets 1 1 1 0 0 DevicelD

Figure 40—Order Details Summary

Order Details

e Order Info—Info includes Branch, Route, OrderID, Estimated Delivery Date, etc.

e Account Information—AccountID, Account Name, Contact Info, Ship and Billing Address

e Arrival/Departure —Indicates the planned, estimated, and actual arrival/departure times

e Time Speed Adjustment—Indicates the AM and PM Start/End Adjustment times and amount
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e Delivery Time Windows—Authorized times when orders can be received at delivery location
e Qty Fields—Quantity values for all orders associated with the stop
e User Fields—Displays any configured User Field and corresponding values, when used

Edit Arrival/Departure

From the Stop Summary page, select the Edit Mode button.
1. Place a check in the box adjacent to the stop
2. Edit dates/times as necessary
3. Select Save Changes

Move Stop

From the Stop Summary page, place a check in the box adjacent the stop you want to move.
1. Select Move Stop
2. If moving to another route, select the new route number from the drop-down box
3. Edit Leg and Seq
4. Select the Move Stops button

Mowve 1 stop(s) from route 5

To 1 [x] Leg 1 Seq 1

Move Stops Cancel

LE
1
1

T
T

COUNT ILC
DALLAS
DALLAS

COUNT NAME
DALLAS
DALLAS

Figure 41—Move Stops

Unload a Stop

From the Stop Summary page, select the stop by placing a check in the box adjacent to the stop.
1. Select Unload Stop
2. Select OK to confirm the unload, or Cancel to cancel the action

ViewMode | Edt Made
Viewsy - Viewmap | AddSiop UnloadSiop | InvertRoute | MoveSiops  Audt

@ Gosey Lutc | ColuEmuator Prov Gotaraute | wan [g] [5-oaw [g] Nex

L ’ ACCOUNT COUNT NAME PLN, ARRIDEF RRIDEF PECE

07:31-07:31 Tue

08:00 - 08:00 Tue

08:29-08:29 Tue
09:02- 09:02 Tue

DALLAS DALLAS
04H18001354 Sciarrino Joanne
04H18085502 Bongiorno Annette
DALLAS DALLAS

07:31- 07:31 Tue
08:00 - 08:00 Tue
08:39- 08:29 Tue
09:02- 09:02 Tue

= ot

Figure 42—Unload Confirmation

Add a Stop
From the Stop Summary, select Add Stop.

1. If the stop is not displayed in the Unloaded Stops list, conduct a search using the search options

2. Place a check in the box adjacent the stop to add
3. Select Next Step
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4. Edit the Leg/Sequence numbers to place the stop
5. Select Finish

Home / Routes / Stops / Add Stops

Branch —Al—[¥] Q Q Q

From Date 01/05/2013 @  ToDate 02112013 & Create Order
Page size: |10

r BRANCH ID ORDER# ACCOUNT ID ACCOUNT NAME ADDRESS EQCODE EST SHIPDATE

r MAIN TEST1 04H18001354 Sciarrino Joanne 9310 FOREST LANE, DALLAS, TX, 75243 01/07/2013 10:01

r MAIN TEST4 04H12085502 Bongiomo Annetie HARWOOD & MAIN, EULESS, TX, 76039 01/07/2013 10:02

r MAIN Hot Shot - 4005454 722 Mike's Auto Glass 4721 N Thatcher Ave, Tampa, FL, 33614 01721/2013 03:20

r MAIN 504919 7173801 Faradise Chevrolet Cadillac 28645 YNEZ ROAD, TEMECULA, CA, 02501-4683 @XXWB 012212013 13:00

r SHEA 12665 08H18163358 Zolier John 616 WEST MCLEROY, SAGINAW, TX, 76179 01/17/2013 16:00

Unloaded Stops 110§ of §

Figure 43—Add a Stop

Home / Routes / Stops / Add Stops
ORDERS ACCTID AGCOUNT NAME Ess T. SHIPDATE
TEST4 04H18085592 Bongiomo Annette HARWOOD & MAIN, EULESS, TX, 76039 01/07/2013 10:02
Branch MAIN Route # 5  EqCode @ Leg 1[=] Sequence 3
LEG SEQ  ACCOUNTID ADDRESS ACT ARVIDEP EST ARVIDEP DIST. FROM UNLD. STOP (MILES
1 T DALLAS DALLAS DALLAS, NA 07:3107:31 Tue 86
¥ 1 04H18001354 Sciarrino Joanne 9310 FOREST LANE, DALLAS, TX, 75243 NIA 08:00 08:00 Tue 203
1 2 04H13085592 Bongiomo Annette HARWOOD & MAIN, EULESS, TX, 76039 N/A 03:39 08:39 Tue 00
1 T DALLAS DALLAS DALLAS, NA 09:02 09:02 Tue 86

Figure 44—Edit Leg/Sequence Number

Route Map

Map views for each route can be accessed by clicking on the map icon A adjacent any route. The map

displays the actual stop locations, planned route, and last reported location for a selected route (GPS
history).

Below the map is a list of all the planned and/or completed stops for that route. To the right of the map
is Route Map info box that can be used to select and view additional routes and/or stops; use the drop-
down arrow to change the dock location of this info box between the left and right side of the screen,
and/or minimize the box.
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End Tesminal 8:53-19.08 Thu

Figure 45—Map View of Planned Routes

Use the Route Map info box to navigate and/or view specific route and/or stop info.

Previous/Next Arrows—Move between stops on the map display area

Branch—Select any branch from the drop-down menu to view available routes/drivers/stops
Route#/Driver ID—Select any route#/driver from the drop-down menu

Vehicle—Provides a drop-down menu of all vehicles for the branch/routes selected
Stops/Highlight Stops—Provides a drop-down menu of all stops in routed sequence order; select
any stop to center it on the map and open the stop info box

GPS/Show GPS Points—Select the GPS tab in the Route Map indicator box and place a check
mark in Show GPS Points box to display a trail of actual GPS tracking points

GPS/Speed Violation—Highlight GPS Points will highlight these points on the map for any
devices that read a speed greater than the input amount (default set to 50 or zero)

Select Set Speed Violation and GPS points that were captured when speed was exceeded will be
circled in red

Map—Provides the legend of markers displayed on the map
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- a
|V ek
~ N - o Prev | Next
01 o
MAIN [=]
5 - Patrick [=]
6027635799 - P. Acos
Sequence: 3 %
Rt/LegiSeq: 5/143 Stops || GPS || Map
Acct ID/Name: DN130T / Alberisons 958 GFS Points
AddriCity/State: 4747 E GREENWAY RD / null/ null 1000712093 052122 =
PinArviDep: 10/07/2013 07:27 / 10/07/2013 0747
EstArviDep: 10/07/2013 07:20/ 10/07/2013 07:40 Show GPS Paoints
Act.ArviDep: 10/07/2013 08:02 / 10/07/2013 08:19 ParalioaVille
se Valley
Zoomin | ZoomOut | Previous | Mext @ aq “«n
I E‘Scuttsdale Speed Violation
! . Highlight GPS Points with speed
greater than 50
@ JFJ
Set Speed Violation
oenix £k
~— Fm
oid|
, 111.80825, 33.42843 v
Tempe Sequence: 2
RtiLeg/Seq: 5/1/32
Acct ID/Name: DN1307 / Albertsans 558
AddriCity/State: 4747 E GREENWAY RD /
null / null
_ _ Pin.Arv/Dep: 10/07/2012 07:27
ACT ARV/DEP EST ARV/DEP 10/07/2013 07:47
NiA 05:00 - 05:45 Hon s e
NiA 06:09 - 06:29 Mon ActArv/Dep: 10/07/2013 08:02/
R . 10/07/2013 08:18
Figure 46—Show GPS Points
| Route Map n
4 Prev | DMext W
MAIN [=]
5- Patrick =]
6027635799 - P. Acos
= . —
Stops || GPS || Map
+ Default Map View
» Last GPS Paoint
O Planned Stop
@ visited Stop
@ Unplanned step
™ Starting Location E
[ Planned End Location
[®  sctual End Location
(t:_":) Truck Last Position
L GPS: Stopped
GPS: Slow
L] GPS:Mormal Speed
® GPSiFast
Figure 47—Map Markers

Map Markers will open the info box for that marker location and display the following:
Route/Leg/Sequence—Includes Route #, Leg #, and planned stop sequence
Account ID/Name—Planned stop
Address/City/State—Account address
Planned Arrival/Departure Time—For the stop
Estimated Arrival/Departure Time—Based on current progress of the route

Actual Arrival/Departure Time—As reported by the GPS tracking data (all times are updated

throughout the day as arrivals/departures are completed)
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The Quick Inspector box will also populate with the same marker info when the marker info box is open.
This box is normally located below the Route Map tab, on the right side of the screen, but can be
moved/docked elsewhere on the screen to customize the viewing area.

3 4 Prev | Next B
DFW [v]
Dallas 5 - N/A [v]
NIA

Map
« Default Map View
- Last GPS Point
O Planned Stop
@  visited Stop
. Unplanned Stop
]

Starting Location
Planned End Location
‘V- Actual End Location

&' Truck Last Position

®  GPS: Stopped
GPS: Slow

®  GPS Normal Speed

@ GPS:Fast

Rt/LegiSeq: Dallas5/1/8

Acot ID/Name: 2134020 / ALBERTSONS
#4173

GUS THOMASOM /

AddrICity/State:

null
912013 08:45 /
912013 D9:05
912013 08:45 /
/0912013 D9:05
ActArv/Dep: null/ null

Pin.ArviDep:

Figure 48—Quick Inspector Box

Unloaded Orders

Any order created through the Create Orders process will be an unloaded order until it is loaded on a
route. You can search for, geocode, and/or delete any unloaded order outside of the routing process in
DRTrack.

Enter the search criteria.
1. Use any or all of Branch, AccountID, Name, OrderID and From/To dates
2. Include Geocode Type (all or un-geocoded) if desired
3. If more than one order is returned in the search results, select the affected order by placing a
check mark in the box adjacent to the order
4. To Geocode or Delete the order, select the corresponding button

If no results are returned, an order can be created by selecting Create Order.

Search Unloaded Stops
Enter the search criteria.

1. From/To dates, Account Name and/or ID, etc.
2. Select Search to display results
3. To edit the unloaded order, select the order # under the Order Number column
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Home / Unloaded Orders

Branch A—[=] Q@ t Q

From Date 02022013 @ ToDale 02112013

Geocode Type Al [=] View Type | OrderView [m] Creale Cedes

Figure 49—Search Unloaded Orders

Reports Tab

DRTrack Reports are accessible from the Reports tab on the Main menu. The types of reports available
to view and/or download are dependent on your individual access level and assigned User Group. Many
of the reports can be tailored to include/exclude specific data fields and time periods (1 week, 30 days,
etc.).

Listed below are some of the common reports available. Contact your Site Administrator with any
guestions regarding access to specific reports or requests for additional or custom reports.

DRTrack Dispaich ~ | Reports ~

Home sl Account History Report
Ll Branch Summary Report

DaShboard |l DOT HOS Exception Report

Routes |l Driver Performance Report Stops

Total Routes - 259 Ll Driver Trip Report Total Stops - 1354
Ll Edit DOT/Activity Logs
Ll Miles By State Repart
Ll Payroll CSV Download

== Co [l Route Manifest
= fic == Completed
pe L Truck Capacity Utilization Report — Violated
— A DelayediMax - 0, Avg - 0)
== Not Taken

Figure 50—DRTrack Reports

Account History—Route history for specified accounts and/or branches within a range of dates
Branch Summary—Total number of routes, stops and orders by day; includes Actual vs. Planned
Duration and Distance

DOT HOS Exception—Provides a view of weekly and daily HOS times and violations for drivers

Driver Performance—Analysis of driver performance (Total Hours, Mileage, Service, and Drive Times)
Driver Trip Report—Analysis of driver performance by stops on a route; includes unplanned stops
DOT Activity Logs—Activity reports for specific branches, trucks, and drivers, by date or time.

Miles by State—Summary of miles driven per state by driver, truck, or branch (Fleet Summary also
indicates when state borders have been crossed)

Payroll CSV Download—Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.

Route Manifest—Provides detailed route info for the selected branch and dispatch date, including
actual stop arrival/departure times as indicated by GPS activity

Scorecard Report—Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.
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Time Analysis Report—Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.

Truck Capability Utilization—Downloadable capacity utilization (at truck level) by branch (daily, weekly,
monthly, quarterly, or yearly)

Account History Report

This report provides a snapshot of the route history for specified accounts and/or branches, for a
specified period of time (date range). It includes total number of deliveries, number of orders, volumes
delivered, on-time rate, and violations. Formats: Web, XML, CSV, PDF, MHTML, Excel, TIFF, Word.

To run the Account History Report,
1. Select the Branch(es) and From/To dates

2. Select how the data should be grouped (week, month, year, etc.)
3. Determine if data should be subtotaled
4. Select specific accounts or leave blank for all (Branch)
5. Select the Quantity Fields to report
6. Enter any display limits (deliveries) in results, if needed (Display # delv between 1 and 9999)
7. Select True/False to Display Subtotal (if reporting on multiple branches)
8. Click View Report

$APPIAN DRTrack = Dispatch ~ Reports 3 Customer Service ~ £ Admin ~

Home / SQL Report

Branch: KATE v Account ID: @ nuw

From Date: 1/1/2020 12:00:00 AM Account Name: 3 NULL

To Date: 4/1/2020 12:00:00 AM Qty Field1: Weight -

Group By: Month - Qty Field 2: Cube -

Display # delv between 1 and 999%

Display Subtotal O True @ False

Hod4a of 1 i 4 Find | Next b+ &

Account History Report

Account ID Account Name Month Date Range # Delv # Order #Viol =30 =860 =90 OnTimeDel Weight Cube

1193 Reasors January 01/01-01/31 4 0 0 o o 0 100 %

193 Reasors February 02/01-02/29 3 0 0 V] o 0 100 %

4301 BOK Center January 01/01- 01/31 3 0 0 0 0 0 100 %

4301 BOK Center February 02/01- 02/29 3 0 0 o o 0 100 %

55 Glacier January 01/01-01/31 4 0 0 o o 0 100 %

55 Glacier February 02/01-02/29 4 0 1 ] 1] 0 75 %

Total accounts & 21 1 95.8 %
Monthly report generated for 1/1/2020 - 4/1/2020 Page 10f1

Figure 51—Account History Report

On-time rates and quantities delivered are included in the results.

e > 30—Serviced more than 30 min. past planned arrival time

e > 60—Serviced more than 60 min. past planned arrival time

e >90—Serviced more than 90 min. past planned arrival time

e On Time Del—Serviced within 5 min. of planned delivery time

e Gallon Equivalents—Total delivered during the reporting period
e Order Weight—Total delivered during the reporting period
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Branch Summary Report

The Branch Summary Report Provides the total number of routes, stops and orders per branch by day,
and includes Actual vs. Planned duration and distance. This report is available in multiple formats (XML,
CSV, PDF, MHTML, Excel, TIFF, Word).

To run the Branch Summary Report,
1. Select the Branch or Branches, and From/To dates (date range)
2. Select Group By (week, month, and year, etc.) and Display Subtotal (if reporting on multiple
branches)
3. Click View Report

DRTrack

Home / SQL Report
Branch: KATE %]  GroupBy: Month -
From Date: 1/1/2020 12:00:00 AM ToDate:  4/1/2020 12:00:00 AM

Display Subtotal O True @ False

o4 g of 1 b ¥l 4 Find | Next [~ &

Branch summary report
From Date To Date Branch ID Routes No of Stops No of Orders Pln. Durafion  Actual Duration  Pin. Distance Actual Distance

01/01/2020 01/31/2020 KATE 4 19 165 43833 35.81 250.00
02/01/2020 02/29/2020 KATE 378 36.45 184.81 37.00

Page 1 of1

Figure 52—Branch Summary Report

The following fields are included in the report results.

e  PIn. Duration—Planned time of combined routes during the report period

e Actual Duration—Actual time spent to execute the routes during the report period

e PIn. Distance—Planned miles of the combined routes during the report period

e Actual Distance—Actual miles traveled executing the combined routes during the report period

DOT HOS Exception Report
The DOT HOS Exception Report provides a view of weekly and daily HOS times and violations for drivers.

DRTrack

Home / DotExceptionReport

Select a Branch and Driver(s)

® Show HOS violations for the selected Drivers 02/01/2017 | and  02/08/2017
Branch  —Al— e within the date interval
_‘T!: O show drivers left with weekly HOS lesser than 0 hours
river ’::Eé o Show drivers left with weekly HOS greater than 0 | hours
F100 Q show drivers left with daily HOS lesser than o hours
:‘5:,53 - Q) Show drivers left with daily HOS greater than o hours

Select DOT cycle] 7-day DOT Cycle [ 8-day DOT Cycle
| Submit |

Figure 53—DOT Exception Report

To retrieve the DOT HOS Exception Report,
1. Select the Branch or Branches, and/or Driver
2. Select the type of Driver data to retrieve, and the reporting cycle
3. Click Submit
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Driver Performance Report
The Driver Performance Report is an analysis of how well the driver is performing, based on Total Hours,
Service Time, Drive Time and Mileage.

To retrieve the Driver Performance Report,
1. Select the From/To dates and Type (daily, weekly, and monthly, etc.)

2. Select the Branch or Branches, and/or Driver
3. Click Submit
4. Download a copy of the report by selecting the Download button
=]
Search Filter Settings
From Date 01/0° & Branchkate v [ MieagePlanned  v> v 100 3 Display graph Date Vs Totalhrs Planned .
To Date 04/01/202 & DHVE':” S (O serviceTime Planned v > v 100 [ Display table data
e Clr
User Quantitynor selected cort O serviceTime Actual > v 100 Download all driversg.celfile ~ | Download
O Totalhrs Planned v> v 100
Typequarterly -
O Drivetime Planned > =~ 100
Submit
{(Quarterly summary report from 01/01/20 to 04/01/20)
X
e Total Hours [ Service Time [ Drive Time [ Mileage [ Statistics
| Delay  VarPerf(%)| (%) _Stops PlannedActual VarPerf(%) [Planned Actual VarPerf(%) [ai Qty/Hr
£1-Driver Name : Kate Clark (Kate) Go to top
101/23/20] 531539 1486 El 04/00/19] 53 0251 2650 216 263-47  82[ 10 19
Subtotal 5.3 1539 -148.6 3‘ 04/00/19 53 0251 2650 216 263-47 EZ‘ 10 19
1-Driver Name : Tyler Corr (TCorr) Go to top
102710/20] 0.1 00/00/01] 01 04 11
Subtotal 0.1 00/00/01 01 04 101
Total 5.4 1539 -148.6 3 04/00/20 54 0251 2650 220 263-47 82 11 20
& Expand/Collapse graph [Gototop]
a7
g a2
HIED
251
3 |268
=212
159
108
053
.
000 iz
Drive Dale
] KateClark
O Tyler corr

L

Figure 54—Driver Performance Report

Driver Trip Report
The Driver Trip Report is an analysis of how well a driver performs his route on a stop by stop basis,
including unplanned stops. The report results can be sorted, which is helpful when running the report

for more than one driver (i.e. by Branch).

To retrieve the Driver Trip Report,
1. Select the Branch or Branches, and/or Driver
2. Select the From/To dates
3. Click Submit
4. Download a copy of the report by selecting the Download button
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DRTrack

Home / DriverTripReport

Driver Trip Report

Branch KATE -
ALL :
DriverType «
N/A KATE Kate Clark QA TAB 1B
N/ KATE TCorr corr 4053144623 Branchid _~
DriverD v

Select Driver LastName

Deviceld -

Sort By
From Date 1/1/2020
To Date 4/1/2020
Default Activity Time 15
Default Lunch Time 30
Submit DownloadCsV
Figure 55—Driver Trip Report
Driverld - Kate Trip login - 20772020 11:54:21 AM
MName - Kate Clark Trip logoff - 20712020 12:26:26 PM
Branch - KATE Start Odometer - 5
Route# - 1 End QOdometer -
Truckld - testroute Distance -0
Actual Stop Distance Date
View Map || View Stop Summary || Edit Route Activity
Driverld - Kate Trip login - 21712020 12:27:26 PM
Name - Kate Clark Trip logoff - 21712020 6:24:00 PM
Branch - KATE Start Odometer - 1
Route# - 2 End Odometer - 39
Truckld - test2 Distance - 38
Actual Stop Distance Date
Starting from state OK ( 38 mi ) at 12:27:26
Stopped - No Match 0 2172020
Stopped - No Match 37 21772020
View Map || View Stop Summary || Edit Route Activity
) Trip on duty time 0
' Trip off duty time 0
! Trip drive time 0
: Trip sleep time 0
' Route Elapse hrs 053
' Time Duration(min) Allocated Min Allocated Exceeded hrs|
]
] Payroll - 0.53
: Trip on duty time 296
' Trip off duty time 21.04
. Trip drive time 0.19
] Trip sleep time 0
' Route Elapse hrs 594
: Time Duration{min) Allocated Min Allocated Exceeded hrs|
'
v 13:22- 147 56
'o14:29-16:19 110
I i X
]

Figure 56—Driver Trip Report Results

A Stop Summary for any of the listed stops can be viewed by selecting the View Stop Summary button,

and/or view a map with the stop on it by selecting the View Map button.

Route activity can also be updated to correct any information by selecting the Edit Route Activity button.

DOT/Activity Logs

The DOT/Activity Logs can be ran for specific Branches, Trucks, and/or Drivers for specific dates or time
periods. The logs can be edited add missing routes, delete unfulfilled routes, or edit route data that is

incomplete or incorrect.

Payroll - 5.94
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DRTrack

Home / DOT/Activity Log

Select route to add,edit and delete DOT logs

Branch ---All---- - Driver  --—-All-—- -
FromDate  2/1/2020 Truck  -—All— -
ToDate 4/1/2020

Submit Return
Branch Rt Driver TruckiD LoginTime LogoffTime
KATE | KateClark  testroute 2/7/2020 11:54:21 AM 2/7/2020 12:26:26 PM
KATE 2 Kate Clark test2 2/7/202012:27:26 PM  2/7/2020 6:24:00 PM
KATE | Kate Clark test22/10/2020 10:17:01 AM2/10/2020 10:17:10 AM
KATE 2 Kate Clark Test32/10/2020 10:18:10 AM 2/12/2020 9:29:00 AM
KATE 2 tyler corr 12342/10/2020 11:37:19 AM
KATE | Kate Clark Test3 2/12/2020 9:30:00 AM 2/13/2020 4:19:50 PM
KATE 2 Kate Clark Test3 2/13/2020 4:20:50 PM
JACK 200John Smith 1234 2/19/2020 6:00:00 PM 3/5/2020 11:32:53 PM
ROUTE CALENDAR 2 Brad Samford 100-Lift 2/28/2020 7.00:00 AM 2/28/2020 8:08:38 AM
JACK 274Test Driver test1 3/5/202011:33:53 PM
JACK 284John Smith 1234 3/13/2020 4:32:00 AM4/30/2020 10:29:00 PM
ROUTE CALENDAR 4 Drake Griffin  100-Lift 2/28/2020 8:56:00 AM
1

Figure 57—DOT/Activity Log

To retrieve a DOT/Activity Log,
1. Select Branch or Branches
2. Select a Driver and/or Truck, or ALL
3. Edit the From/To Dates (time period to see on the log)
4. Click Submit

To edit existing route data or to add a new route to a driver,
1. Identify the TruckID on the DOT/Activity Log that is associated with the route and/or driver, then
select the TruckID from the Truck drop down menu
2. Click the Submit button

DRTrack =0

DOT/Activity Logs

Select route to add,edit and delete DOT logs

Branch Al ~ Driver Al
FromDate  2/1/2020 Truck test2
ToDate 51172020

Submit Retum
BranchRtDriver  TruckiDLoginTime LogoffTime
KATE  2Kate Clark  test2 2/7/202012:27:26PM  2/7/2020 6:24:00 PM
KATE 1Kate Clark  test22/10/2020 10:17:01 AM2/10/2020 10:17:10 AM
B

AccID/Name/

Activity Date Time Gallons/  Delivered Pickup  Missing OrgTimestamp OrgAcctib/ Name/ Gallons/ Odometer  Org Delivered/ Qty/ State/ Zip  OrgPickup OrgMissing ~Actual Stop Assigned
odometer

O Not Driving (Stopped)  2/7/2020 1:22:09 PM Yes

O Driving 21712020 2:17:56 PM Yes

O Not Driving (Stopped) 21712020 2229:32 PM Yes

O oriving 20712020 4:19:54 PM ves

Modiy Delete Undo Delete
Activity Date StartTime ~End Time f::l'l':"/:fg:mmrm|wmd/my/s1axepmkup Missing

O Arival ~ 212020

0 Arval - 20712020

O Arival ~ 22020

O Arival ~ 212020

0 Arival ~ 21712020

O Arival ~ 212020

0 Arval ~ 212020

O Arival ~ 22020

O Arval - 21712020

O Aival ~ 2712020

Figure 58—DOT/Activity Log Results

To edit or delete existing route data, select the Activity box that applies to the change being recorded,
and edit each block of data that applies. Click the Modify button when complete, or the Delete button if
the route is being deleted.
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‘AcolD/Name/
Activity Date Time Gallons/  Delivered Pickup  Missing OrgTime stamp OrgAcctiD/ Name/ Gallons/ Ocometer  Org Delivered; Qty/ State/ Zip  OrgPickup Org Missing  Actual S
odometer
O Not Driving (Stopped) 2/7/2020 1:22:09 PM Yes
0 priving 20772020 2:17:56 PM ves
O Not Driving (Stopped) 2/7/2020 2:29:32 PM Yes
0 Driving 20772020 4:19:54 PM ves

Modify Delete

Figure 59—Edit DOT/Activity Log

To add new route data, complete the Arrival activity register to include the route Start Time and End
Time, Date, Odometer reading, and quantities picked up/delivered.

AcctID/Name

Activity Date Start Time End Time /Gallons /0 i d/Qty ickup Missing
0O Arrival - 21712020
O Arrival - | 2712020
O Arrival - 21712020
O Arrival - | 2i712020
0O Arrival - 21712020
O Arrival - | 2712020
O Arrival - | 21712020
O Arrival - 21712020
O Arrival - | 2i712020
0O Arrival - 21712020

Figure 60—Add New Routes to DOT/Activity Log

Miles By State Report

The Miles by State Report includes the total number of miles driven per state and indicates when state
borders have been crossed. This summary report can be limited to a specific Truck/Driver, Branch or
Branches, or a whole Fleet, and the reporting period defined.

To request a report,
1. Select the Branch or Branches, or All
Select Driver/Truck, or All
Edit the search dates (From date and To date)
Click the Submit button
Download a copy of the report by selecting the Download button

| DRTrack

Home / MilesByState

vk wnN

Select Branch ~all— - @) Detail
—All—

Select report lypeo Driver/Truck Summary

Select Driver / Truck
Q) Fleet summary

100-Lift -
Search date between 04/11/2020 and  0sM12020
Submit Download

Figure 61—Miiles by State Report Request
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DRTrack

Home / MilesByState

Select Branch —All— -
Al
[Select Driver / Truck
100-Lift -
[Search date between 01/1/2020 and 0412020
Submit
Details
Route Info Time Info
Truck
No. Activity State Start End
1234 Tyler3 Route OK 02/1011:37 02/10 12115
test] ‘ 284 Route OK ‘ 01/2404:32 01/24 12:00
test2 ‘ 2 Route 0K ‘ 02/07 12:27 02/07 17:23
Test3 2 Route oK 02/1010118 02/12 07:05
. UnExplained oK 02/1207.05 02/13 16:20
- Route OK 02/1316:20 03/18 16:01

Fleet Summary
STATEMILES
OK 28491

O petail
Select report \ypeo Driver/Truck Summary
(® Fleet Summary

Download
| odometer Info [ summary Info
Hours | Start End Miles [ Route [ Truck

00.64 | 00.00 00.04 00.04 | ok 00.04 | 0K 00.04
g 07.48 [ 155.00 155.31 00.31 [ ok 00.31 | OK 00.31
8 04.94 [ 01.00 30.00 3800 | oK 38.00 | OK 38,00
5 44.78 01.00 0229 01.29 oK 01.29
o 3326 0229 01.00 0129 OK 244.58
1 815,68 01.00 245.58 24458 oK a2

o

Figure 62—Miiles by State Summary Report

Payroll CSV Report

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua.

Route Manifest

The Route Manifest provides detailed route info for the selected branch and dispatch date, including
actual Stop Arrival and Departure times as indicated by GPS activity. This report is also available is
multiple formats (web, XML, CSV, PDF, HTML, Excel, TIFF, Word).

To retrieve a Route Manifest,

1. Select Branch or Branches, and Dispatch Date
Select View By (Stops, Orders, Line Items) and Display Actuals
FALSE will only show the Planned Stop Times for dispatch purposes
TRUE will show the Actuals as a Post Route Review
Select Specific Route when a full report of all routes is NOT wanted
Click View Report

oukwN
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Route Manifest
Branch 1D : 122-IND G.allon On.ier
Equivalents  Weight
Route # : 122-IND502-F Device ID : Vehicle D : WorkTime : 6.28 Total: 0.00 0.00
Truck ID : 502-F Driver ID : Trailer1: Drive Time: 2.76 Capacity : 0.00 0.00
Start Date : 10/07/2016 Drive Name : Trailer 2 : Miles : 119.23 Utilization : 0.0% 0.0%
Planned Actual Gallon Order
W Seq Account ID Account Name Address Dis
Arv-Dep Tm Arv-Dep Tm Equivalents Weight
Terminal (Leg 1) 03:00 - 03:30 Fri 04:33-04:33 Fri 0.0 0.00 0
1 00915161 STARBUCKS - S0UTH SOMERSET SOUTH SOMERSET TRAVEL PLAZASOMERSETPA 04:37 - 04:57 Fri 07:18 -07:32 Fri 56.0 0.00 o
2 005915145 STARBUCKS - NORTH SOMERSET NORTH SOMERSET TRAVEL PLAZASOMERSETPA 05:00 - 05:10 Fri 07:37-07:38 Fri 0.2 0.00 0
3 00915152 ROY ROGERS - MORTH SOMERSET NORTH SOMERSET TRAVEL PLAZASOMERSETPA 05:10-05:30 Fri 07:38 -07:50 Fri 0.0 0.00 o
4 00906551 SIEMON'S LAKEVIEW MANOR NRSG 228 SIEMON DRIVESOMERSETPA 06:00 - 06:18 Fri 06:12 - 06:34 Fri ER] 0.00 o
5 00703434 GG 2054 C SOMERSET 1504 NORTH CENTER AVENUESOMERSETPA 06:23 - 06:40 Fri 07:06 - 07:07 Fri 0.8 0.00 o
6 00703445 GG 3054 C SOMER EXP 1604 NORTH CENTER AVENUESOMERSETPA 06:40 - 07:00 Fri 08:24 - 0B:53 Fri 0.0 0.00 o
7 00702158 GIANT EAGLE 54-SOMERSET 1606 N CENTER AVESOMERSETPA 07:00-07:13 Fri 06:41 - 07:06 Fri 0.0 0.00 o
8 00701697 GIANT EAGLE 683-SOMERSET 4192 GLADES PIKESOMERSETPA 07:25-07:35 Fr 08:59 - 0S:00 Fri 37 0.00 o
Unplanned Stop 1 15:04 - 15:04 Fri

El RO502 Route 502 Driver Order 826 OLD ROUTE 115 NINDIANAPA 08:41 - 08:46 Fri 54.6 0.00 o
Terminal (Leg 1) 08:46 - 09:16 Fri 0.0 0.00 0

Figure 63—Route Manifest Report

Scorecard Report

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua.

Time Analysis Report

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua.

Truck Capacity Utilization Report
The Truck Capacity Utilization Report provides a capacity utilization report by branch at the truck level. It

can be retrieved for specific perioeds of time (daily, weekly, monthly, etc.) and is available in multiple
formats (Web, XML, CSV, PDF, MHTML, Excel, TIFF, Word).

To run the Truck Capacity Utilization Report,
e Select the Branch and/or Branches, and From/To dates
e Select Group By (day, week, month, etc.)
e Specify Route number, Truck ID, and Quantities 1 & 2 (optional)
e Click View Report
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Truck Capacity Utilization Report for Branch 124-LEB
RT# Truck ID Driver Start Period Tot. Stops  Tot. Mil.  Act. Mil. Gallon Qty1(%) Order Qty2(%) Max
Equivalents Weight

124

LEB1009-  1009-M Glendon, Ebersole 10/03/2016 10 256 226 1165.58 45.0% 10487.64 42.6% 45.0%
M
124

LEB1012-  1012-M Gregory, Mader 10/03/2016 3 78 81 5156.55 119.4% 49918.08 129.7%  129.7%
M
124-

LEB1014-  1014-M Thomas, Summerfield 10/03/2016 7 187 187 2495.51 70.9% 23626.38 61.4% 70.9%
M
124

LEB1017-  1017-M Grag, Kraiser 10/03/2016 8 87 82 5466.29 126.5% 52804.22 137.2%  1372%
M
124-

LEB1018-  1018-M Manuel, Peguero 10/03/2016 5 126 141 143.29 3.3% 1269.20 3.3% 3.3%
M

Figure 64—Truck Capacity Report

Some of the fields displayed in this report include

e Tot. Stops—Number of stops on the route

e Tot. Mil.—Planned Miles for the Route

e Act. Mil.—Actual miles for the route according to logs

e Gallon Equivalents—Total Gallon Equivalents the vehicle delivered

e Qty 1(%)—Capacity Utilization based on the first capacity

e Order Weight—Total Order Weight the vehicle delivered

e Qty 2 (%)—Capacity Utilization based on the second capacity

e Max—the highest Capacity Utilization of the vehicle during that date range

Customer Service Tab

The Customer Service tab was designed to be used by your end customers, Sales, or Customer Support
or Transportation; anyone assigned in the Customer Support role. This section provides access to real-
time delivery ETAs on routes in progress from any browser, smart phone or tablet.

DRTrack Dispatch # Reports @ Customner Service ~ £ Admir
Home 2 Account / Order status
W Order Management
Dashboard
Routes Stops
Total Routes - 224 Total Stoy

== Completed
= \iolated
Delayed

Figure 65—Customer Service
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Account/Order Status

Customers can check the status of any current order, limited to accounts assigned to their company
only. A simple search can be performed by Order Number or by AccountID, with additional date filtering
capabilities.

Customers do not have any edit capabilities in this screen.

Account |ID 3067
Order No
From Date = 2/1/2020 @

To Date  2/28/2020 @

Figure 66—Account/Order Status Search

DRTrack
Home / Order Tracking

AccountID 3067
Order No

From Date 2

ToDate  2/28/2020

Account Info Order ID Act. Arv Act. Dept Est. Arv Est. Dept

3067, TIFTON, GA, 31794-080 61951 N/A N/A 02/06/2020 23:51 02/07/2020 01:45
3067, TIFTON, GA, 31794-0801 65362 N/& N/A 02/13/2020 23:51 02/14/2020 01:45
3067, TIFTON, GA, 31794-0801 69504 N/A N/A 02/20/2020 23:51 02/21/2020 01:45
3067, TIFTON, GA, 31794-0801 73647 N/A N/A 02/27/2020 23:51 02/28/2020 01:45

Figure 67—Account/Order Status Search Result

Order Management

Customers can edit their Daily Orders, or maintain their Master Orders from this screen, limited to
accounts assigned to their company only.

A search for orders can be performed for either Daily Orders or Master Orders, by Branch using filters
for Date Range, Account Name, AccountID, Order Number, and the Address. Search results can be
limited to Time Violations, Completed Stops, or filtered by Date and Time.

DRTrack =pispatch ~ ¥ Reports ~ @ CustomerService ~ & Admin -

Home / Order Management

@ Daily Orders o Master Orders

Branch —Al— ~  FromDate 320200 Bl  Topate 32072000 £
Y account Name Q. order Number T Account ID Y adoress T T zip
O Time Violatien[J Completed Stops[] Filter results by Date and Time
B A

Figure 68—O0rder Management

Admin Tab
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The Admin tab provides access to areas frequented by managers to maintain and monitor
administration actions within DRTrack. Access levels within this tab can vary among User Groups, and
are controlled by your Site Administrator.

Banner Manager—Add, edit or delete a banner.

Branch Manager—Can add, edit or delete branches; create branch groups and dispatch groups.
Audit—Audit accounts, orders, routes and tasks.

Customers—Manage accounts, email notifications, POl Manager and Ship To addresses.
Dispatch—Manage devices, drivers and forms.

Routing—Manage algorithm settings, routes, EqCodes, Master Routes, trucks and unlock orders.
Site—Licensing, modules, settings & configurations, tasks, Users and User Groups, and permissions.
Utilities—Cost Savings Statistics.

# Banner Manager

1 Branch Manager

& Provision Map Manager
an Audit

B Customers

@ Dispatch

¢ Routing

@ Site

A& Utilities

Figure 69—Admin Tab

Banner Manager

Banner Manager provides a means to add a message banner that would appear across the screens of
DRTrack users within your organization. The same banner will appear at the top of every screen page.

DRTrack

@ This is a sample banner

Home

Dashboard

Routes

Total Routes

Completed

Violated
O Branch Branch Name
O MAIN Default

Figure 70—Message Banner

To add a banner, go to Admin > Banner Manager.
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Click on the Add Banner button.

Create a name (Title) for the banner and enter the words you want to display in the banner.
You can choose an icon (exclamation, warning, info, etc.) to display with the banner or not.
Select a warning level (color) for the banner; error= pink, success = green, info = blue.

Once created, banners will be listed on the Banner Manager page.

To make a banner active, click the box on the right under Set Active and then confirm.

e To edit a banner, click on the name of the banner; perform the edits and then click Save Banner.
e To delete a banner, click the box to the right of the banner title, click on the Delete Banner
button and then confirm.
“AddBanner x|

Title

, Enter in Text you would like displayed in the banner.

Choose an lcon to display at the begining of the Banner.None -

Select a warning level to change the color of the Banner. Error v

Figure 71—Banner Options

Branch Manager

Branches must be set up for order detail to flow from the backend system to DRTrack. By default, any
route that is not assigned to a specific branch code will be placed in the Branch code MAIN.

To create a branch, navigate to Admin > Branch Manager.

Home / Brar

Manager

Q

Branch
MAIN
4148
55

0000 O

58
4158

Branch Name Branch Name state Time Zone Latitude

ESBRANCHGROUPS | i DISPATCHGROUPS | ©ADDNEW | @DELETE

Longitude  Daylight Savings Server Time Offset

Default True

SPP Tampa Tampa FL 28,0325 825282 True
SCP Largo Largo FL 27.8843 827431 True

SCP Brooksville, FL Brooksville FL 28.4793 8246 True

SPP Nanles FI Nales El 261621 817557 Te

Figure 72—Branch Set Up

Add or Edit Branches

To add a new branch, select Add New and complete all required fields.

1.
2.

Add the new branch to the active branch list for each user requiring access to new branch

To edit an existing Branch ID, select the branch name in the Branch column or use the search
function to locate the branch; click on the BranchID to open and edit

To delete a branch, select the branch by checking the box to the left of the Branch column on
the Branch Management page, then select Delete
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Branch Detailed Information

Branch ID
Branch Description
City
State
Latitude
Longitude

Time Zone EST =

O Daylight Savings

O Auto Logoff with End Terminal

Figure 73—Add New Branch

To edit an existing Branch ID, locate the Branch name in the Branch column or use the search function to
locate the branch.

1. Select the Branch to open the data info box and edit the necessary branch information

2. Toadd a new Branch, select Add New and enter all necessary information, then select Save

3. To delete a Branch, select the Branch ID and then select Delete

4. Select Save when all editing is complete

Note: Once a branch is set up, add it to the active branch list for each user. This must be done to enable
export of route info from DirectRoute to DRTrack. By default, any route that is not assigned to a specific
Branch code will be placed in the Branch code MAIN.

Create a Branch Group

Branches can also be formed into groups, much like a User Group. This can be helpful when several
branches are typically dispatched at the same time, or to send notifications.

To create a group, select the Branch Groups button on the right side of the screen.

DRTrack = pispatcn -

Home / Branch Manager

Branch Management
Q Branch ID Or Name = BRANCH GROUPS
Branch Branch Name Branch Name State Time Zone Latitude Longitude Daylight Savings
MAIN Default True
BAKERY TEST OKC Test Bakery Train Oklahoma City oK 35,5283 -97.5654 True
09 Test FARGO ND False

ooo o

Figure 74—Create a Branch Group

Type the name of the new group in the Branch Group Name box, then select the Add New button.
1. To edit group members, click on the Branch Group name
2. Select branches from the column on the left (Available) then click the arrow in the middle to
send the name to the column on the right (In Group)
3. After all desired branches have been added to the group, select the Save button to commit the
changes
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DRTrack

Home / Branch Manager / Branch Group Manager

Branch Group Manager
Branch Group Name  Wes{

O Branch Group Name
* O Warehouse Home / Branch Manager | Branch Group Manager
» [ Drivers
* D

East @ Successfully added new branch group Q
Branch Group Manager

Branch Group Name
O BranchGroupName e
Branch Info x
> [ Dispatch
> [ Drivers Available In group
+ | MA
> O West BAKERY TEST OKC || MAIN
09 089
999
AUSTIN o
311-PAR
600HP
Master Routes
CKC CALENDAR T

Figure 75—Branch Groups

Create a Dispatch Group (Add/Delete)

The use of Dispatch groups was created to enable grouping asset records (as Trucks or Drivers) within a
branch, to expedite record search and record retrieval time in branches that contain an extreme high
number of records. These Dispatch Groups are only used and/or seen when using the Route Calendar.

1. To set up a new Dispatch Group, select Admin- > Branch Manager.
2. Select the + Add New button on the top right of the screen.

Home / Branch Manager

5 Branch Groups 485 Dispatch Growps @ Add New © Dekete

SAVINGS SERVER TIME, §
0

0

2345 Neds
BRANCH BRANCH NAME BRANCH NAME STATE TIME ZONE LATITUDE LONGITUDE ~ DAYLIGH
MAIN Defaut True
DFW Dallas T Fake

Nan s ” 1 1170188 Eal

Figure 76—Add New Dispatch Group 1

3. Or, select the Dispatch Groups button on the top right of the screen, and then the +Add button
on the following screen.

Pre, Nexts Pagesize (10~
NAME
ANAH-North Edj

Anah-South it
SAVPLE Edt

Groups 1103013

Figure 77—Add New Dispatch Group 2
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4. Assign a name to the new group and select the appropriate branch to which the new group will
be assigned. Select the +Add button when done.

Name

Branch | mam -

O Add Cancel

Figure 78—Dispatch Group Name

(Note: Dispatch Groups can be deleted by using the same procedures.)

5. Click the boxes to the left of the Drivers and Assets (Trucks) to include in the new Dispatch
Group; select the Save button when done.

Branches
= Delete
@ BRANCH
O MAIN
Drivers T
[ DRIVERID FIRST NAME LAST NAME
| TestDriver FName LName
& TEST Test Driver
Assets e
@ ASSETID
No RECORDS TO DISPLAY.

Figure 79—Edit Dispatch Group

To view/select any Dispatch Groups from the Route Calendar, select the Branch drop-down menu.

e

Home / Route Calendar /

Branch = AN-Sample - Highlight Reservations | By ID ~ | Q| Highlight Reservation
AN-Sample .
Branches

, Ty MAIN
DFWY

ANAH
LOSA Pbruary 05, 2018

D2
GEDA
ALBA
ALLE
ANGH
4:00°™ | ANHE
ANNZ

‘‘‘‘‘‘‘ n

3:003™

3:305m

Figure 80—Edit Dispatch Group
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Email Manager

Email Manager provides the means to manage all email addresses maintained in DRTrack for all
accounts.

Add/Edit Email Addresses

e Use the Branch drop down menu to locate the Branch to which to add/edit an email address.

e Select the box next to the name and then click the Add/Edit Emails button.

e Enter the information in the boxes (Acct ID, Email ID {email address}, first, last name), then
select the type of events from the drop down menus to indicate when to send the recipient an
email.

e Use the Add or Modify button to complete the action

Note: The list can be sorted by Branch, Account ID, Name, City, State, or Zip Code.

' DRTrack

Home /' Email Manager
Branch MancH = Q ooooozezos Q, | Email Address ﬁ
% CLEAR ALL EMAILS [# ADDVEDIT EMAILS
Branch Account ID Name #

~ MANCH 0000039203 AAAPUMP SERVICE, INC.

Figure 81—Add/Edit Email Address

Branch Account ID Name » City

¥ MANCH 0000035203 AAAPUMP SERVICE, INC. MANCHESTER

[u] AccountIDs Email 1D Email Format First Name. Last Name Event 1 Event2
o Al - o L - sese Testar Nt Logged in
(m)

Figure 82—Add/Edit Email Address

Delete or Clear Email
To delete one or more email addresses from one account,

e Use the Branch drop down menu to locate the Branch to which to add/edit an email address.
e Select the box next to the individual email account then click the Delete button.

To delete and clear all email addresses and events in the system,

e Use the *Clear All Email button.
e Confirm by selecting the OK button in the info box.

% CLEAR ALL EMAILS [# ADDVEDIT EMAILS

Figure 83—Clear All Emails and Events
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docl.dev.appiantesting.com says

Do you really want to delete all email addresses and events in the I

system?
n Cancel

Figure 84— Confirm Clear Email Action

Provision Map Manager

Audit

Audit allows the user to see recent activities that have occurred within Accounts, Appointments, Orders,
Routes, or Tasks. The types of audits that can be performed include:

e Account Audit - See activity associated with Accounts assigned under a specific Branch. Use the
search function to select the Branch, and the calendar tools to select a date range

e Appointment Audit - See all appointment activity that has occurred within a specific date range
(30 day window); the search results from this audit can also be exported to an excel spreadsheet

e Order Audit - See all activity associated with a specific Order. Search criteria by Branch and/or
Order ID

e Route Audit - See all activity associated with a specific route. Search can be filtered by Branch,
Planned Start Date, or Dispatch ID

e Task Audit - See all activity associated with a date. When Task Audit is selected, the Task Log for
the current date will open; to view another date, use the search/calendar tools to select the
date, branch, and task module

To perform an audit, select Admin > Audit and then either Accounts, Appoints, Orders, Routes, or Tasks.

I Branch Manager
& Audit @ Accounts

B3 Customers @ Appointments

@ Dispatch @ Orders
o Routing @ Routes
@ Site @ Tasks

# Utilities

Figure 85—Audit Activity

Note: Account Audit can also be conducted while viewing the Customer Account record, Admin >
Customers > Accounts.

Figure 86—Account Audit
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Figure 87—Appointment Audit

Note: Order Audit can also be conducted while viewing Order Details, Customer Service > Order
Management > Order Details.

Figure 88—Order Audit

Figure 89—Route Audit

Home / Manage Scheduled Tasks ~ Task Logs

Task Logs

From 2/8/2017 B 1200am @ To 282017

® Global O Branch 4l ~

| ©  wodks B o search |

MODULE NAME TIME LAST RAN EXECUTION TIME(ms) RESULT

Daily Maintenance 2/8/2017 7:48:08 AM 3 Deleted 0 xml files.

User Field Cache List Task 2/8/2017 7:48:08 AM 50 Success

Order Import 2/8/2017 3:36:09 AM 338 Order Import Queus processed. 1 orders processed. 0 orders failed
Order Import 2/8/2017 9:42:09 AM 302 Order Import Queue processed. 1 orders processed. 0 orders failed
Order Import 2/8/2017 10:00:09 AM 130 Order Import Queue processed. 1 orders processed. 0 orders failed
Order Import 2/8/2017 10:12:10 AM 60 Order Import Queue processed. 1 orders processed. 0 orders failed
Auto Sync License Task 2/8/2017 10:16:10 AM 4 Successfully synced 0 license(s)

Purge Deleted Data 2/8/2017 10:16:10 AM 126 Successfully purged deleted data

Order Import 2/8/2017 10:18:10 AM 40 Order Import Queue procsssed. 1 orders processed. 0 orders failed
Order Import 2/8/2017 3:48:13PM 369 Order Import Queue processed. 11 orders processed. 0 orders failed.
Tasks 11010 0f 10 Prev 1 Next

Figure 90—Task Audit

Customers

Customers provides access to key customer data fields for editing. This includes:
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e Accounts

e Emails & Notifications

e POI

e Ship To (Ship To Manager)

Accounts (Account Management)

Each customer record contains key fields unique to the customer, including name, account number,
address, delivery/service requirements (Time Windows), special equipment requirements, Unload Rates
and any other important info to help ensure successful dispatch and deliveries.

To view Account Details for any customer, select Admin > Customers > Accounts.

1. Search for any account by using the branch drop down menu, AccountID, or Name
2. When the desired account appears on the screen, select the Account ID to view the record

fetracking.com/Pages/Accounts/Accounth

[ TMW Care 4 TMW Appian W... L NetSuite (3 Cus

IR AAIRLALAAARLLAAG

Figure 91—Account Management

ADD/TERMINATE ACCOUNT
It might be necessary from time to time to add a new acount to the Account Master, or to terminate
service for an account.

To add a new account, select Admin/Account Master from the menu.
1. LEFT CLICK on the Add New button

Edit to add all the new account information

Update Activation Date to enable routing

Ensure Termination Date is set to future date

Edit order Frequency and Service/Day (Day code)

LEFT CLICK on Save when complete

oukwnN

CREATE, EDIT, MAKE INACTIVE
Customer records can be edited once the record has been located and opened, using the steps listed
above. After editing, be sure to select the Save button to commit all changes to the record.
To add a new account, select the Add New button from the Account Management page.
1. Inputall pertinent account information (ex. Delivery Time Windows, Time Window Adjustments,
Quantity Fields, User Fields, etc.)
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2. Select Geocode (top of the screen) to locate the Lat/Long matching the customer address
3. Select the Save button when after all info has been entered to commit the new record to file

To make a record inactive, open the record from the Account Management page and find the Status
box. Use the drop down menu to select Inactive, then select the Save button to commit the changes to
file.

DRTrack
Home | Account Management / Account Management Detail
Account Information v Save @ Audit @ Geocode @ Coordinates ' Load Default [ Saveas Default
Branch ROUTE CALENDAR - ID 00000999 Address1 2020 SOUTH YALE STREET  Address2
Name  Customer X EQCode City SANTAANA Lat/Long = 32.79306 -96.735
Phone Fixed Time 60 (min) State CALIFORNIA - Zone 100
Contact GEOEne 0 (f) Zip Code 92704 Geo Result 0
Status INACTIVE = Size Restr
On Finalize NOTSET = Priority
Priority
Bump

Figure 92—Account Status

Additional actions available on the account page include:

1. Manually enter Lat/Long coordinates; use the mouse to move the green circle o adjust
location on the map then Update Location or Cancel when done

2. Update Load Default to the customer account

Save as Default to save 'default' info (see Load Default)

4. View recent account activity by selecting the Audit button

w

To access the Account Management screen, navigate to Admin > Customers > Accounts.
1. Search for records using the Branch and/or the Account!D/Name drop down menus
2. Toview and edit account details for any account, click on the AccountID in the list of accounts.

DRTrack

Home / Account Management

Account Management
Branch: 101MI 3 Q. Account ID or Name
[ oseraorTack =oreco - RN -

O Show me only accounts which are active but not scheduled for service

W me only accounts which are at [m] Branch ID Account ID Account Name

£9SCHEDULE SERVICE | ©ADD NEW

o

Branch 1D ZipCode GEORESULT ShipTo

o o 1o
o o i

101

00010003-1959 sy Lot
00010005-1959 sz o

482341000 Levelt
00010016:NA 052 TAMIERD WARREN wr 48092130 Levelt
00010018-2211/1959 14351 HARPER AVE pETROIT i 213682 Levelt
00010024-0024 10200 W7 MLERD pETROIT i ag221-1904 Levelt

101 0001002 00010027-1858 19619 MACK AVE GROSSEPOINTEWOODS M 48236-2838 Levelt

101
101

10

iooooooo

Figure 93—Account Management
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DRTrack

Home / Account Management / Account Management Detail
+ Save @ Audit O Geocode @ Coordinates ¥ Load Default = (' Save as Default
neral | Address
Branch 101m1 - ID  poo10003 Address1 8292 MERRIMAN RD Address2
Name 000100031959 EQCode City WESTLAND Lat/llong 4234889 -8335139
Phone Fixed Time 0 (min) State MICHIGAN - Zone 100
Contact 7344251450 Geofence o (f) Zip Code 28185 Geo Result Levell
Status ACTVE ~+ Size Restr
On Finalize NOTSET v Priority
Priority
Bump
Delivery Time Windows Fixed Routes Time Window Adjustment
Open Close S M T W R F A Activation sar020 | () AM Start 0 (hhmm)
o (=% Termination 1089 | B AM End 0 (hhmm)
140 000800 o AMAG o
’ d @ B @ @ @ @ O Services/Day 1 PM Start 0 (hhmm)
’ 2| I T T PM End 0 (hhmm)
O CloseTw Penalty Cost o(8) PM Adj )
EarlyBuffer o (hr)  Late Buffer o (h)
Qy Flelds User Flelds
Qty Field UnloadRate = User Field Value -
3 DayCode
3 LoadID
3 DriverlD
3 DevicelD
3 PROFILENAME
3 Driver_Name
3 Delivery Confirm Phone
3 Proof Of Delivery Email
3 x Proof Of Delivery Phone =
O  stopForms
O Test

Figure 94—Account Details

DOWNLOAD ACCOUNT MASTER (DIRECTROUTE)

To download a current Account Master from DirectRoute, navigate to the main DirectRoute menu and
select DRTrack > Download Account Master.

DRTrack | Window Help

-; Upload Account Master

| Download Account Master

@4 Upload Truck Master

Upload Email Accounts
Download Email Accounts

Export to DRTrack
Export Master Routes to DRTrack

'\'—zﬂf_-

Figure 95—Download Account Master

UPDATE ACCOUNT MASTER (DIRECTROUTE)
To update the Account Master records from DirectRoute:
1. Open DirectRoute; from the main menu, select File > Open
2. Select file type Stop Files and then select the desired Account Master.xls file
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3. Toensure records are replaced by the records in the upload file, select Overwrite Account
Master
4. Select Upload Account Master

Emails & Notifications (Email Manager)

Email Manager is used to set up event-generated email notifications to selected individuals. Add or edit
existing email addresses, and select which specific event-type email notifications to be sent. The types of
events for which emails can be automatically generated include delivery notification, delivery scheduled,
delayed deliveries, reservations created or cancelled, etc.

To add/edit an email recipient:
1. From the DRTrack Menu, select Admin > Customers > Email & Notifications
2. To add or edit email addresses and event notifications, use the drop-down menu to select the
branch, or use the search function to locate the Account ID or email address

a. Use the left mouse key to place a check mark in the box and select the desired record
b. Inthe top left corner of the screen, select Add/Edit Emails

T
Q

TULLE
WHITE SANDS
ALBuQ casa
FAINTS CiFD CATO #1048 POTEAU

ICIDDDEI E

Figure 96—Add/Edit Emails

Warning: Selecting Clear All Emails will clear all email addresses from all accounts in the system. As a
precaution, a warning notice will be received and confirmation of intent to delete will be required.

Do you really want to delete all email addresses and events in the system?

Cancel

Figure 97—Clear All Emails

a. Select the appropriate Account/D (some have more than one) and Email Format type from
the drop-down menu

b. Enter the email address in the EmaillD column

c. Editthe First and Last Name of the email recipient

d. Inthe Event 1 column, use the drop-down menu to select the type of event for which to
send an automatic email notification

e. Use the additional event columns (2 thru 5) to select additional notifications, if needed

f. After all editing is completed, select Add (Modify, Delete) from the top right corner of the
screen
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Order Scheduled -
Order Scheduled
TW Viclation
= 30 min delay
= 60 min delay
=90 min delay
Order Delivered
MNet Logged In
Route Available
Form Notification
DZLINK FORM EVENT
Schedule Violation
Reservation Created
Reservation Modified
tion Rejected
Reservation Finalized
Reszervation Email
Asset Event

Figure 98—Email Event Notification

LITTLE ROCK LITTLE ROCK

Email 1D Email Format First Nama Last Name emaitrormat] | event1 Event2 Event 3 Evertd

0Oo0oDOoODOoOO0OD0DOODOAQOD

Figure 99—Edit Email Recipient
The table below lists and describes the types of email events available for which to send notifications.

EmAIL EVENT TYPES TABLE

Event Type Description Options
An email is sent out when an order is scheduled to be delivered
Order Scheduled on a route. This generally occurs at a scheduled interval and is

sent out only once per account per order.

Emails based upon an order being delayed outside of its

Time Window Violation . . .
available time windows.

Emails based on an order being flagged as potentially delayed
Delay based upon incoming arrival/departure information. Multiple 30, 60, 90
delay notifications can be set up for worsening status updates.

This email is sent out based upon an order getting delivered

Order Delivered (arrival/departure information populated).

This email is typically sent out when a route pre-assignment is
Not Logged In not logged in for a particular duration of time after the route is | Delay Time
scheduled to go out.

This email is sent out to all pre-assigned and assigned drivers to
let them know that their routes are available for log in. This
email is generally sent out manually once dispatch knows the
route building process is complete.

Route Available (Manual)

This email can go out triggered off of submission of particular
Form Notification forms. It will typically get sent out to dispatchers or sales team
representatives, depending on the form itself.
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This email goes out when drivers text message dispatch

D2LINK Form Event submission of an event based form (delivery, damages, etc.)

This email goes out when a driver or asset is double booked.

Schedule Violation .. .
This is for resource planning customers only.

This email goes out based upon reservation events: (Created,
Reservation Emails Modified, Rejected, Finalized). These are for resource planning
customers only.

Point of Interest (POI) Manager

The POI feature enables users to identify and save geolocations on the map in a library that can be used
in the same manner as a legitimate address when assigning and routing orders in DRTrack.

The POI feature can be useful for deliveries to locations where addresses may not yet be available (i.e.
new construction), deliveries to rural or unincorporated areas, or when addresses are not updated
and/or correct, but physical location is known. Customers that spend a lot of time manually geocoding
many orders will find the POI feature a great time-saver.

Capabilities include:
e Drag and drop a pin on the map and save location as a new POI
e Use Long/Lat to drop a pin on the map and save location as a new POI
e Assign POls to unloaded orders from the Route Calendar/Route Board
e Each POl is assigned a unique name, saved in a library for reuse with any unloaded order, any
customer
e The POl library can be searched and sorted, and any POI can be viewed and/or edited

The POI feature can be accessed from various locations within DRTrack for ease of use:
e Admin->Customer-»POIl Manager: Create and maintain a library of saved POls
e Route Board: Assign POls to unloaded orders with the Assign POI button
e Route Calendar: Assign POls to unloaded orders with the Assign POl button

& Admin ~

Il Branch Manager

® Audit

DaSh boal'd ES Customers = Accounts
& Dispatch £ Email & Notifications

Routes

¢ Routing 9@ POI Manager

Q@ Site & ShipTo

& Utilities

Active Routes

K Route Statistics

Figure 100—POI Manager

AsSIGN POl FROM ROUTE CALENDAR OR ROUTE BOARD

e Saved POls can be assigned to unloaded orders from either the Route Board or the Route
Calendar, and/or a new POI can be created and assigned, if one does not already exist

e Whether you start from the Route Board or the Route Calendar, the procedures are the same

e Once you've located an unloaded order, choose the Assign POI button and the application will
take you to the POl Manager page to complete the necessary actions
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Figure 101—Assign POI from Route Calendar

Figure 102—Assign POI from Route Board

1. Use the drop-down menu to select the desired branch, then days, in the unloaded orders
section
2. Left click on the box to the left of an order # to select that unloaded order

3. Left click on the Assign POI box in the top right corner of the unloaded orders list to open the

POI Manager page

4. To assign the unloaded order to one of the listed POls, ensure the order is still selected (check

mark in the box) then Left click on the applicable POI card in the column list ( v Assign)

5. Selecting the unloaded order card (check box) below the map will return a list of applicable POIs

to the column on the right (deselecting the unloaded order will remove POls from the list)

Note: Orders with no address will display a red hazard icon in the location block; hover over the icon and

an info box will display/read "No address was provided".
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POILibrary: Previously saved POIs that maich the
selected unloaded order wil appear in this list. If
none appesr, create & new POI by selecting the
+hew POI bution.

,,,,,,,

Note® Ared exclamation point icon indicales bad
georesull. Agreen check icon indicates good

Figure 103—Saved POI Library List

ADpD A NEW POI
If no applicable POls are listed/saved in the library, a new one can be created by selecting the +New POI
button in the upper right corner.

1. Use the mouse and Left click on the location on the map to mark the spot where the POI should
be located

2. Enter the new unique POI name, and City/State/Zip in the New POI Details box

3. Left click the Save New POI button when done; the newly added POI will appear in the column
to the right of the map, and the location will be marked by a gray pin on the map.

4. Leftclick on the POI card in the column listing.

c. The pin color on the map will change to blue, indicating the POI was selected
d. A detailed address/location info box will appear on the map above the POI pin

5. Toassign an unloaded order to a newly created POI, ensure the order is still selected (check
mark in the box) then Left click on the POI card in the column list ( v Assign)

New POI Details X

Paint of Interest Name* PT Materials
City* Pampa
State* TX
Zip* 79065

POl Notes Hwy 70/States Rd

Latitude* 35 50560834268319
Longitude* -100.97122192352814
Save New POI Cancel

Figure 104—New POI Details
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Note: While an order address may be sparse or incomplete, at a minimum, the Zip Code must match that
of the POI before the POI can be assigned to the order.

VIEW OR EDIT AN EXISTING POI
Details of each POI can be viewed from the column listing to the right of the map, or by selecting the POI
pin on the map.

1. When the POI pin is selected on the map, the Edit POI Details info box displays the address, date
the POl was last used, and the date the POI was created

a. To edit any of the POI details, left click on Edit and type any necessary changes, then save
the changes when complete

2. When the POl is listed in the column list to the right of the map, the POI details only list the City,
State, Zip, date the POl was last used, and any POI notes that have been added

3. Toeditany POl listed in the column list, locate the matching POI pin on the map (blue), and edit
the POl as described in 1a above

Points of Interest (PO

Q search POI + New POI
Boise, ID 83701
i Stop Count:
FE3 B + Assign
Last Used: 2/13/2018 &
POI Notes:
Denver, CO 80014
Denver Stop Count:
Last Used: 2/13/2018
@ PO Notes:
Austin, TX 78610
ACL Stop Count:
Last Used: 02/12/2018
POI Notes
Austin, TX 78610
ACL Stop Count:

Last Used: 02/12/2018
POI Notes

Carollton, TX 75006
Stop Count:
Manufacturing  Last Used: 02/12/2018
POI Notes: They make engines

Figure 105—POI Listed in Column

Denver
Denver, CO 80014
Stop Count

POl Notes: Wy
1341 | Last Used: 2113/2018
Created: 2113/2018

)

: o -
# Edit + Move —
g W | 79
Awadao ?D o
~“~fDenver ey s

Figure 106—Edit a POI

66




DRTrack User Guide

Ship To (ShipTo Manager)

The ShipTo Manager is used to manage those accounts that you ship to regularly. Customer address and
Lat/Long can be edited from this module, and/or the account can be geocoded.

ADD OR EDIT A CUSTOMER SHIPTO ADDRESS (LAT/LONG) OR GEOCODE A RECORD

From the DRTrack Menu, select Admin > Customers > ShipTo

Scroll through the list of accounts shown, or use the search function to locate a specific account

Selecting Branches All and Show Accounts or Show ShipTo will return a list of all customers

Show All option will return the customer Account Name, Address, City/State/Zip, Lat/Long and

No. ShipTo (data index number)

5. Show Ungeocoded Only will return a list of those that have not been properly geocoded (missing

Lat/Long)

a. Use the left mouse key to place a check mark in the box adjacent to the affected account

b. To edit customer ship address info, select the Account Name and edit the necessary fields
then select Save As

c. Togeocode ship address, select the customer by placing a check mark in the box adjacent to
the Account Name, then select Geocode from the top left of the screen

d. Select Save to accept the changes and update the record

Ealh A

4 6E0CoDE
city sute  Zipcode Latitude Longitude  GeoResult No.ShipTo
RICHARDSON ™
PLAND ™
FRISCO ™

PRS0 ™

PINGH A PENNY #117 TamPA L
PORT RICHEY L
PLANTGITY. L

NATIONAL POOLS OF PASCO 1052280
POOL MASTERS 1071700

PINGH A PENNY #142 MANDALAY MARKETING 138044M321

hoooooooo o

Figure 107—Show Accounts/ShipTo

Hone latitude/longitude based on

Home = Account Account Detail i
actual stops
Account Information v Save @ Audit @ Geocode @ Coordinates ¥ Load Default [ Save as Default
General Info Address
Branch H075 = ID 0428522 Address] 2400 DALLAS PKWYSTE2  Address2
(e | EQCode ity PLAN | e
-‘_Auw Latitude/Longitude %
Phone |ss5123-1212 Fixed Time 0/ (min) State TEXAS
Contact |JEFFSHIPTO Geofence o (f) Zip Code 75093433 L >
Status ACTIVE = Size Restr 3
On Finalize NOTSET v Priority
Priority
Bump
Delivery Time Windows Time Window Adjustment &
Open Closse S M T W R F A AM Start 100] (hhmm
1222 1232 @ 0O a o AMEnd 100 (hhmmi
o o
O 0O O0OO0oOoaoao AM Adj = .
o Q
ooooooo PM Start 100 (hhmm)
o 0
OO0 0O0ooaa PN End 00| (hbend
O CloseTw Penalty Cost a(s) PM Adj = I——H;
Early Buffer ofhr)  LateBuffer o (hr) ETPREEE] covyrahl @ 2017 ALK chAbiogies inc. 3 -06 82714, 33,04076
Qty Fields User Fiolds
Qty Field UnloadRate “  User Field ® :ccount master & Calculated position @ Last known actual stops
Weight EstshipDate UPDATE LOCATION CANCEL

Figure 108—Account Coordinates
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Schedule Master Routes(Fixed Routes)

Master Routes can be scheduled to automatically dispatch on a set, repetitive schedule (cycle), selecting
a weekly cycle or up to a four week cycle.

Go to Admin > Master Routes
1. Select the appropriate Branch from the drop down menu
2. Click on Add New Task, then select Fixed Routes

DRTrack =nispaich ~

Home / Manage Scheduled Tasks

e NEN TSRS B
‘ ©ADD NEW TASK ~ @ TASK AUDIT & PROCESS NOW

Branch Task = Branch 20 *  Module Al -
Fixed Routes
Build Routes

20 Fixed Routes 5/12/2020 9:47:34 AM 3 hours from nov AUSE || # EDIT | ) DELETE || J» RUN NOW
Auto Export Pre Assigned Task

Actions
Branch MODULE Last Execution Time Next Execution T

20 Build Routes Never an hour from nov

AUSE | # EDIT | () DELETE | J» RUNNOW
Tasks 1102012 Cost Savings Task

gesize: 50 -
Auto Logoff Logged In Routes Fage size

Clear Device Schedules

Figure 109—Add Fixed Routes

3. Setfrequency to Daily and edit Time (Time Zone) to select how often the Fixed Routes function
should run

DRTrack
Home / Manage Scheduled Tasks / Add or Edit Scheduled Tasks
(2 COPY SETTINGS TO ALL BRANCHES
Module Fixed Routes ¥  Branch 20 * O Will run Daily v at 0] (CsT)
Route master routes 1day ahead -

Routes will be fixed arounda 1~ weekcycle
In my organization, the last day of our work week is  Friday -

On the last day of work week, | would like to route 0 = days shead

CREATE SCHEDULED TASK

Figure 110—Create Scheduled Task

Select the appropriate Schedule Fixed Routing options.

1. Route Master Routes—Select how many days ahead to run (example in 4., below)

2. Fixed Routing Cycle—Select the number of weeks in the cycle to route, 1 to 4 weeks

3. Last day of work week—Select the day of the week that represents the last work day in your
organization

4. Route ahead at end of the week—Select how many days ahead to run the solution, if ran on the
last day of the week
Example: If the last work day of the week is Friday, and you want to route ahead for Monday,
then you would want to route ahead 3 days

5. To copy these settings to ALL branches, select the Copy settings to all branches button

6. Select the Create Scheduled Task button
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When completed, the screen will return to the Manage Scheduled Task page, with the new task listed in
the summary.

Edit Scheduled Tasks

To edit a scheduled task for a one-time change (ex: pull an order from tomorrow’s schedule, only), make
the changes from the route page for that day/route.

From the menu, select Dispatch > Routes
1. Select the Branch, and date window to view routes
2. Select the route and order to edit

To edit a scheduled task to make a permanent change (ex: pull an order from rotation permanently), or
to pause a task, go to Admin > Master Routes.
1. Use the Branch, Profile, and/or Day Code drop down menus to locate the route
2. Click on the box to the left of the Route # column to select the route, then select the
appropriate edit button from the available buttons in the upper right corner
3. Select the route and order, and edit as necessary

Schedule Service (New Account)

When a new account has been added, it may need to be scheduled for service. To schedule a new
account for service, locate and select the account in the Account Management module (Admin >
Account Management)

1. Select the record by placing a check mark in the box to the left of the AccountID/Name
2. Select the Schedule Service button

Branch  te1.TEST - a| Georesult: ¥
Georesul it
O Show me only accounts wikll O Show me only accounts which are active but not scheduled for service @ 8 SCHEDULE SERVICE
o Branch ID
a Branch ID Account ID Account Name GEORESULT
I
o 161-TEST
161-TEST
[m] 161-TEST APD2050-1 AP, DAILEY
a 161-TEST

Accounts 1to 3 of 3 Page

Figure 111—Account Management/Schedule Service

Click on the Go to Suggested Days button

Select the number of days based on frequency

Click on the Go to Create Orders button to create the order

Verify the OrderID and Pattern, then click on Go to Suggested Routes

oukWw

DRTrack will search list suggested routes with estimated costs for each.
7. Click on the Load button to select a route to load the order
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1. Volume Information. 2. Suggested Days 3. Create Orders 4. Suggested Routes 5. Success

ACCOUNT ID ORDERNO PATTERN ACCOUNT NAME CITY STATE ZIP BEST RT BESTSEQ INC.COST INC. MILES

4500645 Drummond Fall River MA 02721-1733 M-26STRD4-RT9 1

ROUTE LEG SEQ VIOLATION STOPS EST.ARR INC.COST  INC. MILES A
M-265TRD4-RT9 1 1 None 6 10/27/2014 05:15 $11.18 14.0
M-26STR4-RT3,1 1 1 None 1 10/27/2014 05:15 $65.91 434
M-48TRL2-RT3,2 1 1 Capacity 2 10/27/2014 05:45 $20.29 13.0
M-48TRL3-RT7 2 2 Window 1 10/27/2014 11:00 $63.20 834
M-265TRD4-RT9 2 3 Window 2 10/27/2014 11:55 $67.18 886
M-18STR-RT11 1 1 WorkTime, LegViolation 2 10/27/2014 12:.00 $39.15 51.2
M-18STR-RT11 2 3 WorkTime, Window 2 10/27/2014 09:30 $47.49 62.4

Figure 112—Load Order on Route

An info box will return and advise if the unloaded stop was loaded successfully.

Terminate Service

To remove an order or account from service, locate the account by selecting Admin/Account
Management from the menu.

1. Type the account name in the search box, or scroll through the listed accounts to locate
2. LEFT CLICK on the box to the left of the account ID/Name to select it
3. LEFT CLICK on the Cancel Service button, or
4. LEFT CLICK on the Account ID to open
5. Edit the Termination box to update the effective date of termination
Dispatch

Manage devices, drivers and forms from the Dispatch tab.

@ Banner Manager
1 Branch Manager
2 Provision Map Manager

@ Audit
l < Dispatch [ Devices
g ROULITIY & Drivers
@ site = Forms
& Utilities

Figure 113—Dispatch Tab

Device Management (Add, Edit or Delete)

All devices, when added, will be assigned by default to the branch MAIN. Each device must then be
reassigned (reconfigured) from the MAIN branch to the appropriate branch, if/when necessary.
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Note: PeopleNet devices do not need to be added; these will automatically update the DRTrack website
when device activity occurs within PeopleNet.

To edit a device, select Admin > Dispatch > Devices

1. Select the MAIN branch and find the appropriate AssetID (Device) that needs to be reassigned
a. Click on the device to open
b. Editthe branch assignment and any other data as needed
c. Ensure you check the box Show on the Calendar, if the Route Calendar is used for planning
2. To add a new device, select Add New and add all necessary data
3. Select Save when all edits are complete
a. Select Save as Default to save the record as the default template for new assets
4. To delete a device, click on the DevicelD to open then click Delete Device.

Home / Device Manager / Add/Edit Device

« Previous Show device: -All- - A Mext »

Device Information Device Parameters + Save [ SaveAs % SendConfig % Delete Device
D 1D
euiee GPS Interval Max no. of GPS Save points only Mo =
Password (sec) data points after login:
Phone Number GPS Read Freq 3 saved in phone: Enable Activities: Mo =
Maximum speed: 75 )
T Send Interval Validate Mo
(min) Activate Filter: no « Odometer:
IP Address Stop Spead validat -
op Spee Activate DOT ves = alidate ko
Device Type (rotselected) = (mph): Log: AccountlD:
Stop Time (min): Debug Mode: Mo =
Branch (not selected) - Start GPSon Ne
application start: Phone server url:
Loud Alerts: Mo =
Login Screen Default Data Types Default Data Types
Remember Yes ¥ BranchlD: Alpha = Min. required Time to spend in
BranchiD: Route No/LoadID Numerie = number of restricted mode:
Remember Route ves = . satellites Min. speed limit
No/Load ID: StopID: Apha = Default when leaving
Remember ves = maximum stop:
DriveriD: DriveriD: Agha = uncertainty: Max. spead limit
Remember Yes ~ VehiclelD: alpha * Restricted when leaving
Wehicle ID ) maximum stop:
Remember ves * TrailerlD: jalpha  ~ uncertainty:
Trailer ID
Odometer Parameters
QOdom. Sensitivity GPS coverage GPS Start time (hhzmmzss)
when stopped: gap (Use device's
Odom speed for compensation local time zone)
stop: factor: GPS End time (hhmmss)
Odom. Sensitivity GPS coverage (Use device's
when driving: local time zone)

gap distance

Figure 114—Figure 115—Device Management

Driver Management (Add or Edit Drivers)
Driver Management allows users to configure the default or standard device information assigned to
each driver. This allows users to preassign or manually login drivers to routes.

To manage drivers, navigate to Admin > Dispatch > Drivers.
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me / Driver Manager

Branch: AL v| {pierto or Name ©ADDNEW | LUPLOADDRIVERS ISCARRERS = ODELETE
P 12345678910 . Next Page size: 50

o Branch Driver 1D First Name Last Name DevicelD User LoginID Hours Left For Week Driver PFM

o 018 Madison Wi Todd Johnson A 1100

o 018 Madison Wi Ryan Crackenberger on NA N/A

o 018 Madison Wi Kim Cassidy NA /A

o 018 Madison Wi Tyler Davis WA 1100

o 018 Madison Wi 12 Efrain Jimenez WA A

o 018 Madison Wi 1404 John Swenson A N/A

o 018 Madison Wi 16819 James Moore N/A N/A

n 018 Madison w1 180 Michael Daley s nua

Figure 116—Driver Management

To add new drivers, select the Add New button. Fill in as much information as possible for each driver,
then select the Save button when done.

1. Select any DriverlID to edit existing drivers; select Save when all editing is completed

2. Select Add to add a new driver; select Save when all editing is completed

3. Select Delete to delete an existing driver

Be sure to fill in as much info as possible for each driver, and check the Show on Calendar box if the
Route Calendar is used for planning.

DRTrack =
Home / Driver Manager / Add/Edit Driver
/Add New Driver +Save X Delete Driver
Driver ID | Branch Code (Not Selected) - Email
First Name Device ID  (Not Selected) - Office
Last Name Driver Type Cell
Status Team Driver Yes v Home
License Class Carrier (N/&) ~ + Address 1
License Exp. =i Address 2
DOT Physical Exp. i) city
Send Expiration Sate — <
Emails
Temporary Driver [ Zip Code
Color Nore -
Order

Show On Calendar [J @

Hire Date = 5/6/2020 @
Seniority  s/6/2020 )

Birth Date =]

Create User Account [
User Name  <Email Address>

Password

Re-enter Password

Figure 117—Add New Driver

Upload Drivers

If you have multiple Drivers to update, the information can be uploaded using the Upload Drivers
button. Click Choose File to select a saved file to upload, or download a copy of the XML template and
build a new record to use/upload.
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DRTrack

Home / Upload Center
XUpload Driver Data
Upload Drivers File For Existing Devices

Downioad Sample XLS File |_CN00se File

Sheett L UPLOAD DRIVER DATA

LUpload Driver Data With Devices
LUpload Device Data
LUpload Asset Data

XUpload Product Data
Figure 118—Upload Drivers

An XML template is also provided to make speedy import of applicable records.

A B T D E F G H I J
DriverlD |DeviceID |BranchID |FirstName |LastName |Status |License€|ass |LicenseExp |D01PhysicaIExp |SendExpirationEmaiIs[Y,l’NJ |
DemoDriver  DemaoDevice Demo Driver Good  AAA 9/30/2014 10/30/2004 Y
K L M N 0 P Q R
HireDate |SeniorityDatE |BirthDate |TerminationDatE |CreateUserAn:count[‘|’fNJ |Password |Driver1ype |TeamDriver[YfNJ |
5/1/2013 5/1/2013  2/11/1969 Y Test Good ¥
S T U v W X Y I AA AB
Email |officePhone  |cellPhone  |HomePhone  |Addressl |Address2 |city |state [zip  [color |
CemoDriver@tmwsystems.com 123-456-7890 123.456.7891  (123)456-7892 101 Addressln 202 AddressLn  Los Angeles  CA %0001 None

Figure 119—Upload XML Template

Driver/Device Pre-Assignment

Whenever possible, routes should be pre-assigned to a driver before they are dispatched (depart).
When the pre-assigned driver logs into the route, the system will correlate the Driver, TruckiID, and
DevicelD and display the appropriate GPS data. Values listed in the DevicelD, Driver, and Name columns
will indicate if a driver has been pre-assigned to a route.

Branches | —All-- M F& 127,207 E‘z waM O i uzm‘ # s @ |
[ Agvanced Search Options

o Route # Branch DevicelD Driver Login  Name TRKID Time Start End Legs
>0 1 - N/A - 00.0 02/2000:00 02/20 00:00 1
>0 n - N/A - 020 02/20 08:45 02/20 10:47 1
> 0O 1 - N/A - 007 02/2008:45 02/20 09:25 1
>0 il - N/A - 020 02/2109:45 02/2111:45 1
>0 32723 1 - N/A - 020 02/2109:45 02/2111:45 1
>0 14577 n - N/A - 014 02/21 08:22 02/2109:47 1
>0 32723 1 - N/A - 00.7 02/2108:45 02/2109:25 1
>0 26059 4124 9852108408 HB63 . William Gifford 00.0 02/09 00:00 02/09 00:00 1
>0 2196 4144 A 01.7 02112 08:24 02/1310:05 1
>0 32701 a13a - N/A - 049 02/1419:45 02/1500:38 1
>0 144 - N/A - 00.0 02/14.00:00 02/14 00:00 1
>0 92241 4124 - N/A - 024 02/1409:30 0214 11:56 1
>0 4144 4054924486 TEST ° Test Driver 04.4 02/150931 02/1513:52 1
> 0O a13a - N/A - 026 02/1607:27 02/16 10:02 1
>0 144 4054824486 A313 Rick Ramsey 032 02/17 06:41 02117 09:52 1
>0 4124 - N/A - 00.0 02/17 00:00 02/17 00:00 1
>0 4124 9852108408 TEMPD1 ° Temp Driver 015 02/20 06:49 02/20 08:20 1
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Figure 120—Driver/Device Assignment

e An N/A in the Driver column indicates the route has not been assigned to a driver
e Values listed in the DevicelD column indicate association with an assigned driver or route
e The colored circles listed in the Login column indicate:

- Yellow indicates the route has been Pre-Assigned to a driver

— Green indicates the route is currently logged into GPS tracking

— Redindicates the route is logged out of GPS tracking and the GPS device can be assigned to
another route

To assign a driver to a route, select Dispatch > Driver Login from the main menu.
Locate and select the desired route using the Branch, Date and Route Number search boxes
Use the DriverID drop down menu list to select a driver
Use the DevicelD drop down menu list to select an associated device
Edit the date and time under the Login Time column

Branch JACK v Q Route Number

FromDate /12020 [ Display All Routes >

a Login Route # Driver ID Device ID Login Time

[m} 183 1234 hd 4054924486 * 1/1/2020 1030Pm ©

Figure 121—Pre-Assign Driver to Route

Update VehiclelD, Odometer Start, and Trailer fields, if applicable
Select the PreAssign button

AUTO SELECT DEFAULT DEVICE PREASSIGN LOGIN / UPDATE LOGOFF

Vehicle ID Odometer Start Trailer1 Trailer2 Logoff Time Odometer End

802456 52

Figure 122—Pre-Assign Driver

A green message will appear at the top of the screen to let you know that the driver was successfully
preassigned to the route.

Home / Routes / Driver Login

® The selected route(s) have been preassigned to the selected drivers and devices.

Figure 123—Driver Pre-Assigned to Route
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Manual Driver Login

From the main menu, select Dispatch > Routes.
Locate the route and click on the NA for that route listed under the Driver column.

Login
Route # 183 Total Hours 5.48
Branch Jack -
Driver ID | select Driver -
Device ID 4054924486 ~
Login Time = 1/1/2020 10:30PM B)
Truck ID
Odometer Start
Trailer ID1
Trailer ID2

Print Route Sheet OJ

Figure 124—Manual Driver Login

Scheduling Driver Breaks

To add a driver break to a route, breaks must first be added to the truck profile assigned to the route. If
the break start times and break duration times will always be the same for any given truck, regardless of
route, they can be added to the Master Truck File (refer to Truck Management).

When break times and/or durations vary and/or need to be added to just one route, then add them to
the specific truck profile assigned to the route.
1. Click on the route to select it, then right click and select Stop Summary
2. Select Route Info, then Truck Info to open the truck profile
3. Scroll to BreakDuration1 and add the time duration in Hours (30 minute = .5)
4. Scroll to BreakStart1 and add the time in which the break should start (ex. if break should start
at 4 hours into the route, enter 4)
Click Save and Reschedule at the top right of the page when done
6. Return to the Route Calendar and the break should appear at the scheduled time during the
route

b
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. ]
13085 Flatbed SA [ | 43166 Semi 20696 Flatbed TA 13085 Flatbed SA

51978357
RJI PROFESSIONALS INC

1
Eeo
Luis C Varguez
13085 Flatbed SA
52053730

THORNTON, CO

COPRO CONSTRUCTION
AURORA, CO
52055478

INDEPENDEALROOEL

A View Map Route »
@ Unload Orders Export 3
& Optimize Email »
[ Reschedule Print

% Mark Clean
@ Lock/Unlock Start Time
= Stop Summary

Merge »

Figure 125—Add Driver Break to Truck Profile

| ® VIEWMODE | # EDIT MODE

I & Truck Info
@ Audit This Route

iE STOP ACTIONS « iSROUTE INFO « iSROUTE ACTIONS «

D1O route - 482 DENVER CO - Denver CO v 1-N/A v Next »

Job Name Customer PO A

Figure 126—Truck Info

WorkDay 0 OtCost4 0
BreakDuration 5

BreakDuration2 0

BreakDuration3 0

BreakStart1 D

BreakStart2 _E

BreakStart3 0

Figure 127—Break Duration, Break Start
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eeeeee—————————
20696 Flatbed TA_| 13085 Flatbed SA

Do ]
-
oResult:

Figure 128—Route with Break Scheduled

Add/Insert Driver Breaks on the Calendar

Pick any stop location within a route to insert a break before or after the stop, or at a specific time.
1. Click on the stop to open the info box, then select Before, At, or After
a. Before—Will insert the break before the selected stop
b. After—Will insert the break after the selected stop
c. At—Will open another info box from which to input a specific time for the break
2. Select Save when done

y, january 27, 2017
Phill_Testd Phill_Test5 21852 Conveyor 21944 Conveyor 23107 Conveyor | 2|

Unload

Order Details

Duplicate

Mark Clean

Export 4

Insert Driver Break 4 @ Before
Print @ At

© After

Figure 129—Add Driver Break on the Calendar
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Insert Driver Break x

Starttime 11/16/2016 B s51am @

End time 11/16/2016 B 921am @

@ SAVE % CANCEL

Figure 130—Add Driver Break at Specific Time

Note: The default break time (15 minutes = 0.25 hours) can be edited in the configuration settings. Any
break entered that is less than the minimum time set, will be removed from the calendar, as will any
break that is scheduled before or after the route start or end time.

Delete a Driver Break on the Calendar

To delete a scheduled driver break on the calendar, locate break on the schedule.
Right-click on a break and select the Delete Driver Break info box

TD&*Iete Driver Break

1) 34420347

Figure 131—Delete Driver Break

Move a Driver Break on the Calendar, Merge Breaks, and Change Break Duration
Breaks on the calendar can be moved to another time during the route, or to another route, using the
drag and drop method. If a break is dropped outside the route start/stop times, the break will revert to
it's previous start (time).
1. To move a break, locate break on the schedule.
2. To move to a different time within the route, right-click and hold the break then drag/drop it in
on the desired time (location) within the route
3. To move to a different route, right-click and hold the break then drag/drop it in on the desired
time (location) on the new route
The Add Break info box will open; select Before, After or At to schedule the break when needed
To merge breaks, right-click on one break and drag it to overlap another
6. To change the timed duration of a break, right-click and hold the the break and drag it up or
down to increase or decrease the time

uoe

After each successful driver break action has been completed, a message will be displayed at the top of
the page to advise of the status and/or what was changed (break time is inserted, moved, deleted, etc.).
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@ Added 30-minute break to route

® Moved break on route.

© One or more breaks were merged due to overlapping breaks

@ Moved break on route.
© One or more breaks were clipped to fit within the route start and end

A A Break was deleted due to a move

@ Resized break on route.

Figure 132—Break Status Messages

Home | Account Management | Accoun! Managemend Dead

Account Information 5 @ Geocode = Coordinates = (= Lood Default | (& Save as Default
Branch  MAIN[v]| ] Addiosst Address?
Hams EQGodis City LatLeng
Phone Focod Time {min) State | (Mot Selected)  [v] Zone
Condact Goolence " Zip Code G Rl
Status ACTVE [~] Sire Restr
Delivery Time Windows Fized Routes Time Window Adjustrment
OPEN CLOSE S5 M T W R F A Activation anoms B A Stan (hhamen)
o o OO0 O0n0on0onoao Terminabion oS & AM End (hhenm)
o[ ol D oOoOOoOaoO il - Ak
vl Oooooooan Senices/Day 1 PM Start ifvheran)
O Close TW Ponalty Cost (] PM End frr—
Earty Bufers (tw}  Late Buller ) M Adj
Oty Fields User Fiokds
aTY FIELD UNLOAD RATE . USER FIELD VALUE
Carls ERoute
Do
Truck Type
Sequence
hwded
DAYCOOE

Figure 133—Add New Account

Routing

Manage algorithm settings, alias, assets, EqCodes, Master Routes, Trucks, delete Routes and unlock
orders.

Master Routes
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Create Master Routes (Fixed)

The Master Routes function allows users to create and/or upload a group of routes (from DirectRoute),
to clone and schedule for recurring, automatic dispatch. When performing mostly fixed routing, this
option can be a great time saver. And when necessary, Master Routes can be modified, added and/or
deleted and exported for further analysis (Excel, DirectRoute, etc.).

Export Master Routes from DirectRoute

1. From the DirectRoute main menu, select DRTrack > Export Master Routes to DRTrack
2. Select the Branch, Profile, Start and End Dates
3. Click on the Export button

DirectRoute

File  View Modify Map ResourcePro  Window  Analysis | DRTrack | TourPro  Help

= . b .. [J Upload A t Mast

Y} E D § & 7 .f pload Account Master r
8 Westcott_MasterRoute.STOP Map E Download AccolntMaster I:
E p M Upload Truck Master
~

Download Truck Master

e

Upload Email Accounts

Downlead Email Accounts

. ug Export to DRTrack

. 8 |.£‘ Export Master Routes to DRTrack

Download Master Routes

Figure 134—Export Master Routes from DirectRoute

Export Master Routes To DRTrack

| Export Routes
Profile Type: -
-
Branch: Westcott
Start Date: ’ 4/1/2020 ﬂ
End Date: \ 4/1/2020 ::]

[] Overwrite Fraquency in Account Master

Select option(s) and click export button....

Figure 135—Export Master Routes to DRTrack

Note: Occasionally, large Route Files may take several minutes to export. If necessary, adjust time-out
settings in DRTrack and DirectRoute. Contact your System Administrator if assistance is necessary.

After Master Routes have been uploaded to DRTrack, they can be modified, added or deleted, cloned
and scheduled for automatic dispatch.

Note: When Master Routes are uploaded to DRTrack, DRTrack can auto-create Master Truck Profiles. The
newly created Master Truck Profiles will bear the same name as the Master Routes Profile Name.
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Uncheck Ignore Empty Routes while uploading Master Routes to prompt the creation of the new Master
Truck Profiles.

Manage Master Routes
Master Routes uploaded to DRTrack can be accessed through the Admin > Master Routes option in
DRTrack. Master Routes (and Stops) can be modified, added or deleted, cloned and scheduled for
automatic dispatch at specified times on a recurring basis using just DRTrack.

1. Select Admin > Master Routes from the DRTrack menu

2. Routes can be sorted and searched, scheduled and rescheduled from this page

© Admin ~

bme 2 Account Management

© Alias Manager

ashboard Bl Assels Manager

Poutes Stops 2 Branch Group Manager

Total Stoy B Branch Manager

Complele & Configuration Manager
ol ate

Delayed % Delete Routes

Delayed {

Delayed (

Total Routes
Completed
fiolated
Delayed
Active

Aot Taken

coococoo

il Device Manager
& Driver Manager
Ctive ROLItES 1N Equipment Code Manager
[ Form Manager
@ Manage Schedule Tasks
© Module Manager
@ Order Audit

Figure 136—Admin/Master Routes

DRTrack

Home / Master Routes

SR OLEES View Mode Edit Mode

Branch Al [v| DayCode Allv] W

[*) Reschedule £ Optimize [ Schedule Task @ Delete

234 Nexts Pagesize: (25 ~
[1 RoutE# BRANCH DEVICEID DRIVER LOGIN TIME START END STOPS MILES LASTPOS. MAP A @ = =
O NA MAIN - N/A 035 02/07 14-40 02/07 21:47 01016 109 NA A
O Na MAIN - NA o771 02107 23:44 02/08 0724 0013 103 vae A O
O NA MAIN - N/A 082 02/07 23:44 02/08 07:53 0013 056 e A O
O wna MAIN - NIA 145 02/07 2344 02/08 14:16 0013 060 A A O

Figure 137—Master Routes Summary Page

Note: Ensure DRTrack Admin/Configuration settings are updated to enable Fixed Routes. Select
Admin/Configuration and scroll to locate EnableFixedRoutesForDSD and/or
EnableFixedRoutesForService. Select the Edit button and place a check mark in the box, then select the
Update button. Repeat for EnableBuildRoutes, if necessary. Upon update, it may be necessary to exit
DRTrack to allow updates to process, then login to reenter. If assistance is needed, contact your DRTrack
system administrator.

Edit Master Routes

Routes and Stops can be viewed and/or modified from various points in DRTrack.

To edit routes from Admin > Master Routes
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Locate the desired Route by using the Branch and Day code selection options. From the list of eligible routes,
select the desired route to view all stops assigned to the route.
Use the action buttons on the top right of the screen as needed:
View By—Select stops to view by delivery sequence, orders to view all (consolidated) orders, or Line
Items to view each item on the order
View Map—Shows each Stop as it appears on the map
Add Stop—Add additional Stops to the Route
Unload Stop—Unload a Stop from the Route
Optimize—Use this option to reposition Stops on the Route, after changes have been made to individual
Stops that affect delivery dates/times
Reschedule—Reschedule Stop delivery window times and/or date
Invert Route—Reverses the order of delivery of the Stops, from first to last
Move Stops—Move Stops between Routes, from one to another
Audit—Provides a brief overview of events that have occurred

a. To edit Arrival/Departure, click on the Edit Mode button provided in the top right corner
of the screen and insert the new date/times in the appropriate boxes; to exit the edit
mode and close the boxes, click on the View Mode button

2. Use view or edit orders from the Order Management page (Customer Service > Order
Management)
a. Locate the stop and click on the OrderID to open the order summary
b. Edit the order details, save, and move to the next stop record to edit additional stops

7. To use the Route Board to view/edit Routes and orders, locate the route and/or stop and click
on the Order ID to open the order summary
a. Editthe order details, save, and move to the next stop record to edit additional stops

DRTrack

Home / Master Routes / Stops

View Mode  Edit Mode

= viewBy - M ViewMap @ AddStop [ UnioadStop @ Optimize  [“] Reschedule  JC InvertRoute <+ Move Stops @ Audit

Gotoroute - | MAIN[V| | NA-NA[v]

O LEG SEQ ACCOUNT ID ACCOUNT NAME ORDER ID PLN. ARR/DEP ACT. ARR/DEP EST. ARR/DEP
O 1 T PAWTUCKET PAWTUCKET 18:52 - 19:22 Tue N/A - NIA 18:52 - 19:22 Tue
| Od 1 1 4504509 CAPE COD HOSPITAL 4504509 21:00 - 22:30 Tue N/A - NIA 21:00 - 22:30 Tue
| O 1 2 4504504 FALMOUTH HOSPITAL 4504504 23:06 - 23:51 Tue /A - NIA 23:06 - 23:51 Tue
O 1 T PAWTUCKET PAWTUCKET 01:21 - 01:36 Wed N/A - NIA 01:21- 01:36 Wed o

Figure 138—Modify Stops

Route Violations

The following is a list of route violations that can occur on planned routes and stops.
@ Capacity (CP)—Truck capacity, as set in the Truck File, has been exceeded

EQ Code (EQ)—The assigned truck and loaded stop are incompatible; a unique requirement is not
being fulfilled

m Time Window (W)—Delivery is expected outside of the allowed times for the stop
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Additional Violations—A red circled number appearing next to 2 other violations indicates that 3
or more violations have been incurred; use the mouse to hover over the red circled number to
view the additional violations
Drive Time (DT)—The total allowed drive time, as set in the Truck File, has been exceeded
Work Time (WK)—Work Time as set in the Truck File has been exceeded
Return Time—The terminal return time for a driver, as set in the Truck File, has been exceeded

Max Distance (MD)—The max distance for the truck, as set in the Truck File, has been exceeded

Delay—The truck is delayed (the number of minutes delayed); a yellow icon indicates 60 minutes
or less, and an orange icon indicates more than an hour.

28666606

@ Wait Time—The truck has exceeded the allotted wait time at the current stop

Optimize Routes

Optimize routes to reduce miles, trucks and costs. This cost saving tool allows DRTrack to reorder stops
on or between routes for better efficiency.

Branches  —Al v From snzzz0 B 200aM @ To sz B 1iseem O
B Advanced Search Options 3C INVERT 9RESCHEDULE OTEXTDRIVERS | SOPTIMIZE v BIEXPORT ~ $2TRIM
Route # Branch DevicelD Driver Login  Name TRKID Time start End Legs Stops OPTIMIZE WITHIN
OPTIMIZE BETWEEN ROUTES

ORGANIX-IL-TEST1 - N/A - N/A 16 05/12 03:00 05/1214:34 -

0/011 A [voreacTonsy | |

woreAcTions |

B
ORGANIX-ILTESTI - N/A - N/A 00.0 05/12 00:00 05/12.00:00 1 0/0/0 000 N/A
ORGANIX-ILTEST! - N/A - A 136 05/12 0336 05/1217:10 1

1

A
0/0/9 469 NA - BA o
A

ORGANIX-IL-TESTI - - 05/12 0301 05/1216:47

Figure 139—O0Optimize Routes

Truck Master Management

The Truck Master is a collection of vehicles assigned to each branch, that can be assigned to routes and
drivers. All pertinent vehicle information is listed for each individual truck, including volume limits, cost
factors, work rules, assigned branch (depot/origin location), and special equipment.

Add or Edit Trucks

To manage the Truck Master and add, edit, or delete vehicles, navigate to Admin > Routing > Trucks.

Truck 1D Avsiable

oooooDOo 0 o

Figure 140—Truck Master Management

1. Select any TruckiID to edit existing vehicles; select Save when all editing is completed
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2. Select Add to add a new vehicle; select Save when all editing is completed
3. Select Delete to delete an existing vehicle
4. Select Profile to view (add or delete) existing vehicle profiles

Be sure to fill in as much info as possible for each truck, including Work Rules, Cost Factors, Quantity
Values and User Fields. After adding each new vehicle and assigning the depot/origin location, select the
Geocode button at the top right of the screen, to add the Lat/Long location of the vehicle’s primary
location to the record.

DRTrack

Home / Truck Master Management / Truck Master Detail Management

< Previous ~ Next:>

Truck Details [ SaveAs | P LoadDefault @ Geocode = @ Cancel
General Info Locatior Time of Day Adjustmer
Branch 069 Address Al Start (hhmm)
Profile Andersen city AM Enet: (hhmm)
Truck  Truck Id or Name & AN Ad:
EQ Code Zip Code PM Start (hhmm)
Asset  nene - Longitude 0 PM End (hhmm)
UnldPer ° Latitude 0 PM Adj
Min Time 0 () Available O Venicle Profile —select—  ~
Zone 0 One-way O
Turn Time o (miny Redispatch o
Hot Shot O
Work Rules Cost aty values User Fields
NomalStart HourCost 0 3 0 DayCode
EarlyStart DistanceCost 0 3 0 DriverlD
EDay o UnloadHourCost 0 3 0 DevicelD
LateStart DropCost 0 3 0 PROFILENAME
LateFinish WaitHourCost 0 3 o Driver_Name
LDay o UnitCost 0 3 o LoadDate
Max\WorkTime o FixedCost o 3 0 OrgRoute
TargetWorkTime o LayoverCost o 3 0 RTMatch
MaxDriveTime o OtHrst 0 3 0 Truck Size

. Figure 141—Truck Master Details (Page 1)

Site
Licensing, Modules, Settings & Configurations, Tasks, UserGroups and Permissions and Users
Utilities

Cost Savings Statistics
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DRTrack

Home

‘Gost Savings

Branch ID Jack

Cost Savings Statistics

EndDate 3202020 () ﬁ

~  StartDate vz [

Cost Savings - Fixed Vs Optimized Routing
580,00000

§70,00000
60,0000
50,00000

40,00000

Cost

§30,00000
52000000
10,0000

50,00 LmEm
ar

En g 1o

Date

a2 4 16

an ¥5 36 AT 3B 3 30 3 32

Baseline — Optimized Within — Optimized Between

Total statistics for the given date range

Filter By: TotaiDisterce ~

87455

Baseline
Optimized Within
Optimized Between

93979

73051
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Figure 142—Cost Savings Statistics

Export (Upload) Routes to ERP/WMS/OMS

Once routes have been finalized, an Upload File (UPL) can be created and exported back to an order
management system, or host system, for processing. The most common way that routed orders are
uploaded to a host system is by using the menu option, File—> Upload option in DirectRoute.

The Upload File (UPL) can be created as either a text upload file (.xml) or a fixed length field text upload
file (.urp). The primary difference between the two file types is the selection of fields (data) that will be
passed in the Upload File, back to the host system.

The *. XML Upload File contains a specific set of data fields that will be included in the file

The *.URP Upload File enables control and selection of data fields that will be included in the file

Any member of the Implementation & Training team can assist you in creating the initial formatted
Upload File. Once the file is created, it will be written for export to the host system each time the
File->Upload option is used in DirectRoute (refer to the DirectRoute User Guide, 11 Creating Upload Files

for more information).

“Rogcefesponse enlnsixsi="heop: frvwww w3, opg 2001 LS chasa -1}

<Dispatchiate>2014-0&-16</DispatchDatel>

CVEESLOAMSC/ VEESLON>

<TruckProfilelamesCopy</TruckProfileame’

<BranchID>Dewnay</BranchlDs

<DRTrackPreferencess
coverNEiteERistingRouresrtrae</OverNeireExisingRaures>
LHoDTHeE ! ned>0</ HoOfWeekaClonedy>

<Update, tascer>faleed/ UpdarehocounctHasters
«FinalizeRouteasfalsss/FinalizeRonteas
</DRTrackPreferences>
<DRSolucionSummaryScatistics>
<icatiaticax»
cDays>22</Daysr
<Diat>2817.08</Diat>
cOroploac»i</DropCoaty
<DrvTime>PTT 301 1H438</ DrvTime>
cElapaedline>FT10BHSIM23S5</ElapacdTize>
<EndTime>2014-06-16T23:56: 30</EndTime>
cFartheacStopDiscance>143. 3733« /FazchearSropDiavance >
<FixedCost>»0</FixedCost>
<HzCoat>2252.91</Hz >
{IncrementalCost»0</IncrementalCoaty

Example XML Upload File

Figure 143—Upload File

| Fed RTUPLOAD umt-baaepQilIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIi
File Edit Fesmat View Hedp

Wed 1 005329 L08020-00 0927 0942 P6O
Wed 2 008739 L08007-00 0948 0048 PE
wed 2 006739 L08006-00 0948 1013 P69
Wed 3 005134 L08054-00 1048 1110 P69
Wed 4 006753 L08097-00 1133 1141 69
wed 5 005129 L07257-00 1300 1340 P69
wed & 101870 257292 1353 1431 P69
wed 7 102768 257420 1450 1620 PO
wed 8 101523 257268 1644 1704 PED

|

Example UPL Upload File
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Cost Savings Scenario Tool
The Cost Savings Scenario Tool provides statistics for a given date range, and offers filtering options such
as Optimized Within and Optimized Between Routes.
1. Navigate to Admin-> Manage Scheduled Tasks
e. Select a branch from the drop-down menu
2. Select Add New Task—>Cost Savings Task

To populate the data, run the Cost Saving Task.
Admin->Cost Savings Statistics
Click on Cost Savings Statistics
Select branch and date range, then click search
Admin->Cost Savings Statistics

Home | Manage Scheduled Tasks

Giobal @ Branch IRVINGTWE ¥ | Mocule | Cost Sawngs Task v [JICIEREERY @ A0 e sk w

Fieed Routes

IRVINGTIVE Cast Savings Task 4212018 8:17.00 AM 7 hours from now (]

Home / Cost Savings Statistics X Account Management

e — % Algorithm Settings Manager
& Alias Manager

Branch ID | IRVINGIWK ¥ Start Date  91/2017 2  EndDate am7eo1s B | & Assets Manager

X Branch Group Manager

i= Branch Manager

#+ Configuration Manager

Cost Savings - Fixed Vs Dynamic Rou

$6.500.00 ® Delete Routes
56.000.00 - B Jll Device Manager
m N A X Driver Managesr
£5,500.00 - Il Equipment Code Manager
Form Manager
T $5,000.00 1 ¢ License Manager
8 54 500.00 - © Manage Scheduled Tasks
t3 Master Routes
$4,000.00 - X Master Routas Profile Management
2 Module Manaaer
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Home / Cost Savings Statistics

Branch ID | IRVING r Start Date  4p7zne 2 End Date 4272013 B2

Branch ID | IRVINGTWK ¥ | StartDate  wnazon

End Date  4z7es

Filtse By Total Distancs ¥
Coslt Savings - Fixed Vs Dynamic Routing

57.000.00

$6.000.00

I ‘

$5.00000
., $400000
8 437867
e §3,000.00 Fued Routing

Faxad Rouling - Cpbenized
e - Dynamec Routing - 1Hr
- ® Dynamic Routing - 2
s1.00000
$0.00 - AOAR i
1001 029 " 2 21 218 ) s o
Date
4000 4200 4400 4600 4800 5000 5200

Fixsd Routing = Fixed Routing - Optimized m Dynsmic Routing - h m Dynamic Routing - 201z

Home / User Group Manager 2 Account Management
& Algorithm Settings Managear
& Alias Manager

i Assets Manager

B 0 Doz 4 Branch Group Manager
GROUPID DESCRIPTION £= Branch Manager
> 1 Administrator & Configuration Manager
> 3 Customer Service ® Delete Routes h
> 4 Eranch Administrator Jll Device Manager
> 5 Driver L Driver Managar
> 6 Test Il Equipment Code Manager
6 items in 1 pages 1 Form Manager
O License Manager
Only User Groups with no users can be deleted. ® Manage Scheduled Tasks

31 Master Routes

1 Master Routes Profile Management
@ TMW Systems, Inc. £

tking solution integrated w
@ Order Audit ral support call us at: 440

@ Route Audit

W ShipTo Manager

@ Task Logs

= Truck Master

= Truck Profile

B Unlock Orders

2 User Field Cache Maintenance

& Module Manager

L User Managar
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DRTrack ERP Interface

An XML interface is provided to pass order information between the ERP system and DRTrack. The
details and specifics of each field used in the XML schema is given below.

The DRTrack Export Table contains data for finalized routes that can be retrieved for use in the ERP
system. The XML Order Import Table is laid out as follows:

e Column 1—Field Name

e Column 2—Field Type {Enumeration (E), String (S), Numeric (N), Duration (DU), Date (D), Time

(T), Boolean (B)}

e Column 3—Width

e Column 4—Required (R), Optional (O)

e Column 5—Field Description

e Column 6—Sample Field Value

XML Order Import Table

1 2 3| 4 5 6
Key N R An unique identifier for each DRStop element 1
Branch S 20 R The name of the branch the customer belongs | MAIN, OKC or DALLAS
Name S 50 R The name of the customer Appian
Contact S 50 |O The name of a contact at the customer site Joe
Phone S 25 |0 [Telephone number of the customer 800-893-1250
ID1 S 30 |R A unique identifier for this stop. Typically, an A0001
account number
ID2 S 25 R A unique secondary ID normally used for order | 00001
number
ID3 S 25 R Third Identifier field normally used for a line L0001
item number or SKU. Can be default value for all
records
Address S 100R Street address for the customer 10317 Greenbriar Pl
Address2 S 1000 Secondary address information (e.g. suite Ste 100
number, building, etc.)
City S 35 R The name of the city for this customer Oklahoma City
State S 2 |R 2 character abbreviation for the state or OK
province
Zip S 10 R The zip code or postal code of the customer 73159-1514
FixedTime DU R Number of minutes at this customer. Each PTOH25M
customer can have a different fixed time
RouteNumber N O [The route number that this stop is normally 1
placed on
Leg N O [The leg number that this stop is normally placed| 1
on
Seq N O  [The position of this customer within a route 1
SizeRestriction | N O [This field corresponds to the Capacity 1 field in | 42000
the Truck file
EqCode S 50 |0 Equipment code for assigning account to @AB-BH
particular vehicles
DRVolume R Volume to be delivered. One field for each See Volume Table for
(unlimited) volume used (ie. weight, cube, pallets, etc.) details
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1 2 3| 4 5 6
DRTimeWindow O |Open time and close time of delivery time See Time Window Table
window and the day of delivery. for details
Zone N O |Speed zones used to increase or decrease truck | 125

driving speed within a delivery area. An
example would be if the customer is located
within a congested downtown area. A value of
125 increases driving time by 25%. Similarly, a
value of 90 decreases the driving time by 10%.

OrderType E R Add—New Order, Modify—Update Order,
Delete—Delete Order. If Modify is set as
OrderType and if that order doesn’t exist in
DRTrack then it will be added as a new order

Longitude N 6] Longitude of customer (calculated by -97.5225
DirectRoute)
Latitude N 6] Latitude of customer (calculated by 32.7545
DirectRoute)
DRUserFields O  |Optional data fields with additional information | See table 4 for details
(Unlimited) pertaining to the account.
Symbol S 10 [0 [The symbol displayed on the map when orders | Diamond
are downloded to DirectRoute
Size N O  [The size of the symbol displayed on the map 16
when orders are downloaded to DirectRoute
Color S 10 [0 [The color of the symbol displayed on the map Green
MaxSplits N 2 |0 Maximum number of times an order can be split| 0
EarlyBuffer DU O  [The EarlyBuffer, in conjunction with the PT1H25M30S

LateBuffer and PenaltyCost, is used to create
Soft Time Windows. The Early Buffer applies a
buffer, noted in hours, to the Time Windows. A
buffer set to half-an-hour (.5) would stretch the
front of the Time Windows by a half-an-hour.
(l.e.: Time Windows of 07:00-11:00 would
actually be computed as 06:30-11:00). When a
stop uses the offered buffer, a penalty cost can
be applied, as laid out in the PenaltyCost Field

LateBuffer DU O [The LateBuffer, in conjunction with EarlyBuffer | PT2H
and PenaltyCost, is used to create Soft Time
Windows. Late Buffer applies a buffer, noted in
house, to the Time Windows. A buffer set to
half-an-hour (.5) would stretch the back of the
Time Windows by 30 minutes (l.e.: Time
Windows of 07:00-11:00 would actually be
computed as 07:00-11:30). When a stop uses
the offered buffer, a penalty cost can be
applied, as laid out in the PenaltyCost Field

PenaltyCost N O [The PenaltyCost column, used in conjunction 50
with EarlyBuffer and LateBuffer, is used to apply
a penalty to stops that use the buffers; penalty
cost, applied in Cost per Hour. Penalty Cost is
used to calculate not only penalty charges for a
stop using the buffer, but also during
optimization. DRTrack will attempt to move a
stop with a penalty cost to another route,
eliminating the penalty.

89



DRTrack User Guide

(delivered, unloaded and out) by the late time

window time, this field will be TRUE.

1 3| 4 5 6
Estimated R The Date/time the order is expected to deliver | 2010-01-10T18:05:00
DeliveryDate
EarliestDate O |When a Stop must be delivered within a certain | 2010-01-08

timeframe, then Earliest Date may be used to
ensure that the stop is completed within the
restrictive time.
LatestDate 0 Latest Date is used in conjunction with Earliest 2010-01-12
Date. This is the latest that a stop may be
serviced. LatestDate may be the same as the
Earliest Date, if there is only one day in which
the stop may be serviced
CloseTW 6] If the customer's delivery must be completed True or False

XML Order Import Volume Table

material per hour. It will take 2 hours to
deliver 2000 units at an unld rate of 1000

units/hr (Pass 0 to ignore unload rates)

1 2 3 4 5 6
No N R | ID Field Value
Name S 25 | R | Name of the Qty Field Weight, Cube, Pallet
Volume N R | Amount to be delivered to the stop 2000
UnldRate N R | The amount of time it will take to unload 1000

Note: Service Time at delivery locations are calculated based upon Fixed Time and Unload Time. Setting
unload rates to 0 will make the fixed time be the total service time.

XML Order Import Time Window Format Table

Allowed Characters:
S—Sunday
M—Monday

T- Tuesday
W—Wednesday

R- Thursday
F—Friday
A—Saturday

1 2 3 |4 5 6
Open T R Open time of the delivery time window. 07:00:00
(seconds are ignored)
Close T R | Close time of the delivery time window. 13:30:00
(seconds are ignored)
Pattern S 7 R | Day of the delivery. MWFA, SMF, RFA

XML Order Import DR User Fields Table

1 2 3 4 5 6
No N R ID Field Value
Name S 25 R Name of the UserField SalesPerson
Value S 255 | R Value of the UserField Bob
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The XML schema contains optional tags for DRTimeWindow, DRBreakTime, DROvertime, DRTruck, and
DRTruck Envelope that are used in a different interface (can be ignored).

< Pemi version="1.0"encoding="utf-8"?>
<[DR5topEnvelope

sminsxsd="httpfwww. w3 org/2001/XML5che

ma™>
<DR5top Key="2">

<Address»3102 AVENUE I</Address>
<Address2 />
<Branch>Main</Branch>
<City>SCOTTSBLUFF/City>
<CloseTW>falses,/CloseTWz]
«<Color>14</Color>
<Contact />
<EarliestDate>2005-01-08</EarliestDate>
<EarlyBuffer>PT05<EarlyBuffer>

Figure 144—XML Sample File

<EstimatedDeliveryDate>2005-01-

10=</EstimatedDeliveryDate>

<EgCode />

<FixedTime>FPT15M< FixedTime=
<ID1>83250</01>
<ID2>26522</102>

<iD3>2<iD3>
<LateBuffer>PT05</LateBuffer>
<latestDate>2010-01-12</LatestDate>
<latitude>0</Latitude=
<Longitude>0</Longitude>
<Maxsplits>-1</Maxsplits>
<MName>THE HOME DEPOT #3210</Name>
<0rderType>Add</OrderType>
<PenaltyCost>5</PenaltyCost>
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DRTrack Order Import Module

Order Import Module is a windows based service used to send customer orders to DRTrack for route
tracking. The module expects specific XML formatted data and accepts CSV or tab delimited extract file
from an ERP system.

The data flow process for a typical DRTrack implementation project

ERP System—>Extract File Directory—> DirectRoute—>DRTrack

No custom code is required to integrate with DRTrack

Debugging tool to analyze extract file

Windows application to analyze converted data

Can export corrected/saved file from here and will identify error fields to correct

DRTrack will send an email notification when validation errors are detected in the extract file
The data file can be configured using DRProject.config file in DirectRoute

Data flow process for using Order Import Module:

Model 1: Start->Load Extract->Validate Orders—>Convert to XML-> Export to DRTrack

o Process one order at a time
o Removes special characters (™, ©, @, ...)
o EQCodes should not be affected

Model 2: ERP->Extract File to Directory—> Window Service

o The service scans for files then sends the files to DRTrack
o Generates estimated ship date if not available in the extract file

Required Columns
o ID1/1D2

Optional Columns

Branch (if empty, defaulted from config file)

Action (possible values if empty, defaulted from config. file...add, modify, delete, delete all)
Estimated Ship Date (if empty, defaulted to current date with an option to offset days)
Quantify field, User field (need to be configured in DRProject.config file)

ID3 (if empty, defaulted to ID2)

Address, address 2, city, state, zip, Lat/Long

Time Window, EQCode, FixedTm, EarlyBuffer, LateBuffer, EarliestDate, LatestDate, Penalty
Cost, Zone

O O O O O O O
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Okta Authentication API With SAML Single Sign-On (SSO)
For DRTrack

Okta Authentication API has now been enabled to allow the DRTrack LDAP sync component to
communicate directly with our customer's LDAP Server URL to sync authorized users into the DRTrack
database. Previously, the sync service required communication directly with the server, a method that
could pose a potential security risk to both our customers and the software.

Okta is a Certified OpenlID Connect provider and the Okta Authentication APl provides operations to
authenticate users, perform multi-factor enrollment and verification, recover forgotten passwords, and
unlock accounts.

Organizations only need to run the SSO-LDAP Sync Task to sync active users from DRTrack, and maintain
the list by adding new users when necessary.

System Administrators: To run the SSO-LDAP Sync Task:

e Navigate to Admin—->Site->Users (User Manager) and review the list of current DRTrack users;
add/delete any new or old users (as needed) and complete any needed updates to user info
(ensure each user has a current email address)

e Navigate to Admin->Site->Tasks (Manage Scheduled Tasks) and select Global Tasks from the
drop down menu

e Onthe LDAP Sync Task click the Run Now button (if not listed, select ‘Create New Task' and add
the task)

e Click the Process Now button on the right side of the screen, then refresh the web page

e The 'Next Execution Time' should have reset and the 'Last Execution Time' should display the
current date/time (indicating the task was just completed)

e Login to Okta to view your organizations active (Okta User Store) and compare the list to the
users listed in DRTrack* to ensure the sync task updated the necessary records

e Additional info is available at https://developer.okta.com/docs/api/resources/users.html#list-
users

*Note: There may be users saved in DRTrack that are not in the Okta user store

New users with a valid email address can be assigned to the DRTrack application and added to Okta via
the sync task at any time by their organization's System Administrator. When added, a new user will
receive an automated email from Okta with instructions to activate their account using a link provided in
the email. Only after proper activation will new users be able to use their credentials to login to the
DRTrack site via SSO. Additional info on creating new users in Okta can be found at
https://developer.okta.com/docs/api/resources/users.html#create-user.



https://developer.okta.com/docs/api/resources/users.html#list-users
https://developer.okta.com/docs/api/resources/users.html#list-users
https://developer.okta.com/docs/api/resources/users.html%23create-user

DRTrack Configurations and Settings

Most users will have access to the Settings and Configuration Table within DRTrack thru the Admin tab
(Admin->Site->Settings & Configuration) on the main menu. Settings and configuration inputs control
the behavior of different functions, and in some cases, the appearance of different keys and buttons
used through DRTrack. It's important to understand the current behavior and the expected behavior of
each item before making any changes. The Settings and Configuration Table identifies and describes
many of the settings and options available, and can help you determine if or when you might want to
change a particular setting.

Please note, this may not be a complete list and/or you may not have access to see or edit all options,
based on your role assignment as determined by your Site Administrator. If you have questions about
any of these functions, ask your manager or the Site Administrator for help. Additional assistance can
also be provided by your assigned Appian Project Manager or contact Trimble MAPS Support,
support@trimblemaps.com, Phone: (800) 663-0626, Option 6 then Option 7.

Configuration Settings Table

Section Name Value (Sample) Description
10-4 10-4 Send Position Events APl URL https://uat.10- 10-4 API URL to Send Position
4.com/atlas/frex Events.
api/shipment/po
sition
10-4 10-4APIKey 827nls77E1RXdT 10-4 Client API Key
Q
10-4 10-4APIRELATIONSHIPURL https://uat.10- 10-4 Client URL for Relationship
4.com//atlas/fre endpoint
xapi/relationship
10-4 10-4APISHIPMENTURL https://uat.10- 10-4 Client URL for Shipment
4.com//atlas/fre endpoint
xapi/shipment
10-4 10-4ETASourceOfTruth True (V') or False 10-4 is ETA Source of Truth
10-4 10-4GPSSourceOFTruth True (V') or False 10-4 is GPS Source of Truth
10-4 ENABLE10-4 True (V') or False Indicates whether the 10-4

integration is enabled

ApptScheduler

AUTOGENORDERID

True (V') or False

Edit

The time window used when
creating an order for Appt
Scheduler.

ApptScheduler

MANAGERAPPROVALDIFF

100

Edit

The amount when met or
exceeded will require manager
approval (0 for unlimited).

ApptScheduler

MAXORDERSTOREMOVESEEDSTOP

Edit

The number of orders that must
be added to a route before the
seed stop is deleted.

ApptScheduler

MAXTIMEWINDOWTHREADCOUNT

Edit

The maximum number of threads
to use when calling time window
suggest routes.

ApptScheduler

ORDERTIMEWINDOW

Edit

The time window used when
creating an order for Appt
Scheduler.
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ApptScheduler

SERVICERADIUS

1000

Edit

The route radius used when
calling suggesting routes for Appt
Scheduler.

ApptScheduler

TIMEWINDOW

Edit

The time window used when
calling suggesting routes for Appt
Scheduler.

Csv

EnableExportToCSV

True (V') or False

Edit

Determines whether or not to
show the Export to CSV option.

Ccsv

Notes

Edit

Uses tokens to determine what
information will be displayed in
the Notes column.

Csv

StopDescription

Edit

Uses tokens to determine what
information will be displayed in
the Stoplnformation column.

d2link

ArrivalFormldV2

Edit

Default Arrival Form for D2LinkV2

d2link

DetailsDisplay

Edit

Configures the format in which
stop/order details are displayed
to the driver.

d2link

EnableArrivalForms

True (V') or False

Edit

Enables arrival forms for d2link
devices

d2link

ExportEndTerminals

True (V') or False

Edit

Makes End Terminal visible on
D2Link schedule.

d2link

OrderHeaderDisplay

{OrderID}

Edit

Configures the format in which
orders are displayed to the driver
on a D2Link device.

d2link

ReExportCompletedStops

True (V') or False

Edit

DRTrack will export already-
completed stops to D2Link when
routes are re-exported. It will
send those stops as Completed
stops to D2Link.

d2link

StopHeaderDisplay

{Customer
Name}

Edit

Configures the format in which
stops are displayed to the driver
on a D2Link device.

d2Link

LINEITEMDETAILDISPLAY

{LineltemID},
{user:Jobname},
{Customer}

Edit

Determines how line items are
displayed in D2Link

D2Link

D2LinkAccounts

IntegrationDB

D2link accounts

D2Link

D2LinkV2Accounts

IntegrationDB

D2linkV2 Accounts

D2Link

FirebaseURL

D2link FirebaseURL

D2Link

LINEITEMHEADERDISPLAY

{LineltemID},
{user:Jobname},
{Customer}

Edit

Determines how line items are
displayed in D2Link.

D2Link

TestD2LinkClientName

Edit

Configure an optional test client
name. Use in conjunction with
TestD2LinkDevices.

D2Link

TestD2LinkDevices

Edit

Comma separated list of device
IDs to use with the
TestD2LinkClientName.

dotnet

DefaultDisplayQtyAlias

Pallet Qty,
Hazmat

Edit

Configuration to display up to two
QtyAlias in aspx page. Please
enter comma seperated QtyAlias
(value from
TBLQTYFIELDS.QTYALIAS column).
Ex: Cube,Pallets
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dotnet

DefaultDisplayQtyAlias

Pallet Qty,
Hazmat

Edit

Configuration to display up to two
QtyAlias in aspx page. Please
enter comma seperated QtyAlias
(value from
TBLQTYFIELDS.QTYALIAS column).
Ex: Cube,Pallets

dotnet

AlgoConsolidateFixedTimes

True (V') or False

Edit

Consolidates fixed time if set to
true

dotnet

AllowlnsertingStopsimmediatelyAfter
LastCompleted

True (V') or False

Edit

Allow dispatchers to insert stops
immediately after the last
completed stop. They will be
warned that this could be a bad
idea.

dotnet

AllowModifyFinalizedOrder

True (V') or False

Edit

Enables the ability to refinalize a
modified or added order

dotnet

AppendCaretToDuplicatedLineltems

True (V') or False

Edit

AppendCaretToDuplicatedLinelte
ms

dotnet

ApplyTimeBoundariesOnRelated
Routes

True (V') or False

Edit

Consider resources assigned to
surrounding routes to apply
constraints to routing functions to
prevent overlapping resource
allocation.

dotnet

AutoCorrectLoginTime

True or False

Edit

Automatically adjusts login time
based on actual performance to
determine when a route was
started.

dotnet

AUTOEXPORTROUTESMODE

None

Edit

Determines which auto export
action to take when routes are
added to DRTrack. Options: XRS,
TomTom

dotnet

AutogenerateOrderlds

True (V') or False

Edit

Determines if order ids need to be
autogenerated or not

dotnet

AutolLoginPreassignedRoute

True (V') or False

Edit

Checks for open route
preassignments every few
minutes and automatically logs in
devices at the appropriate time
based on the route start time.

dotnet

AutologinPreassignedRouteBuffer
Time

15

Edit

Allows for an early login time
when automatically logging in
preassigned routes near the route
start time. Provide a value in
Minutes.

dotnet

BranchDropDownDisplay

BranchID

Edit

Determine how the branch drop
down should look.

dotnet

ColorRouteRowsWithDelay

True (V') or False

Edit

Determines whether or not to
color the entire row of routes
which exhibit a delay.

dotnet

ColorStopsWithDisplayColor

True (V') or False

Edit

Determines whether or not to use
the DISPLAYCOLOR field to color
stops on the EditRoutes page.

dotnet

CompactStopSummaryMenu

True (V') or False

Edit

Enables compacting stops
summary page button menu to
the pre-7x layout
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dotnet CONDITIONALLYUPDATEACCOUNT  |True (v') or False|Edit |Enables conditional updating for
account fields when updating
from the web service.
dotnet ConsolidateByAddress True (v') or False|Edit |Consolidate by Address
dotnet ConsolidateByID1 True (v') or False |Edit |Consolidate by AccountID
dotnet CopyPlannedToActuals True (v') or False |Edit |This enables copy planned to
actuals on the stops page.. was
teleflora custom functionality
dotnet DefaultDisplayUserAlias Delivery Edit |Configuration to display up to two
Instructions, User Fields where applicable.
Customer PO, Please enter comma seperated
Job Name, aliases (value from
FixedTime, TBLUSERFIELDLIST.ALIAS column).
Address Ex: Spcinstr,LoadID
dotnet deletegpsxmilfile TRUE Edit |If false, GPS data XML received
from 3rd party application or sync
service will not be saved.
dotnet DRAlgorithmType Regular Edit |Configures the algorithm type
settings
dotnet DRGeocodingFallbackLevel Levell Edit |Determines what action needs to
be taken for Geocoding Fallback
Level.
dotnet EditableUserFields Edit |Determines a list of user fields
which can be edited directly on
the stop summary page. Comma
delimit the aliases.
dotnet EMAILHEADERACCOUNTID Edit |Alias for AccountID
dotnet EMAILHEADERACCOUNTNAME Edit |Alias for Account Name
dotnet EMAILHEADERETA Edit |Alias for ETA
dotnet EMAILHEADERLOADID Edit |Alias for LoadID
dotnet EMAILHEADERORDERID Edit |Alias for OrderID
dotnet EMAILHEADERSEQUENCE Edit |Alias for Seq
dotnet EMAILHEADERSTATUS Edit |Alias for Order Delivery status
dotnet EMAILQTYFIELD1 Edit |Qty field 1 in email
dotnet EMAILQTYFIELD2 Edit |Qty field 2 in email
dotnet EMAILUSERFIELD1 Userl Edit |Alias name for userfieldl
dotnet EMAILUSERFIELD2 User2 Edit |Alias name for userfield2
dotnet EMAILUSERFIELD3 User3 Edit |Alias name for userfield3
dotnet EnableAssetSelectionOnDriverLogin |True (V) or False|Edit |Determines if the Asset ID drop
down should be shown on the
driver login page.
dotnet EnableD2Link True (V') or False |Edit |Enables D2Link-specific DRTrack
functionality
dotnet EnableDefaultCoordinatesToAccount |True (V') or False|Edit |Enables Coordinates defaulting to
Master the Account Master Lat/Lon when
adding stops. no 0,0
dotnet EnableGeotab True (v') or False|Edit |Displays Export to Geotab button
in routes page
dotnet EnableHOS True (v') or False|Edit |Enables Peoplenet HOS
dotnet enablelnnovative True (v') or False|Edit |enable innovative specific
functionality
dotnet enablelnnovative True (v') or False|Edit |enable innovative specific
functionality
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dotnet EnableRouteBoardDefaultTo True (v') or False|Edit |Checks or leaves unchecked all
UnloadedStops routes when opening
RouteBoard. Set true if
performance is slow. Disabled by
default
dotnet EnableRouteExportXml True (v') or False|Edit |Displays Route Export Xml button
in routes page when enabled
dotnet EnableShiftBuilding True (v') or False|Edit |Decides whether or not
wave/shift building is available.
dotnet EnableTimeWindowCodes True (v') or False|Edit |Decides whether or not time
window codes are available.
dotnet EnableTMW True (v') or False|Edit |Enables Export to TMW
functionality.
dotnet ENABLETOMTOM True (v') or False|Edit |Enables ENABLETOMTOM-specific
DRTrack functionality
dotnet enableTripSheetStatus True (v') or False|Edit |Enables Trip Sheet Status Column
in Route List on Route Board
dotnet EnableUleQtyFields True (v') or False|Edit |Determine if volume fields should
be classified as ULE (routable) vs
non-routable
dotnet EnableUPL True (V') or False|Edit |Displays Export to UPL button in
routes page
dotnet EnableXata True (v') or False|Edit |Displays Export to Xata button in
routes page
dotnet EnableXRS True (v') or False |Edit |Displays Export to XRS button in
routes page
dotnet EnforceSecurityForDataExchange True (V') or False |Edit |This prevents unauthenticated
data download
dotnet ExpandStopSummaryMenu True (v') or False|Edit |Enables expanding stops
summary page button menu to
the pre-7x layout
dotnet ExportToTable True (v') or False|Edit |Sets caption for the export to
table button in routes page
dotnet GeocodeOrdersBeforeRouting True (V') or False|Edit |Geocode orders before routing
dotnet GeocodingEngine PCMiler Edit |Geocoding engine type
dotnet GeocodingURL http://geocoding|Edit |Geocoding service for street level
service. data
routetracking.
com/DRRouting
Service.svc
dotnet GoogleAPIKey AlzaSyCBgOillsjw|Edit |Google API key to use google
koYOqgDTzQgo3X geocoding service.
nPNkrAK-Ow
dotnet GoogleGeocodeAccuracyLevel Approximate Edit |Determines what action needs to
be taken for Google Geocode
Accuracy Level.
dotnet gpsmapspeed 65 Edit |NULL
dotnet IgnoreEQCodeOnConsolidation True (v') or False|Edit |This flag will determine whether
or not DRTrack will use EQCodes
when consolidating.
dotnet isTeleflora True (v') or False|Edit |Enables Teleflora Specific
functionality
dotnet LastPingTime 10/31/2017 9:16 |Edit |Last ping time
dotnet LoginBufferIntervallnMinute 0 Edit |Buffer for login time
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dotnet

LoginStatusEmailNotification

True (V') or False

Edit

Enable or Disable Processing of
login status email notifications

dotnet

MaxEmailsPerSession

90

Edit

Determines the maximum
number of emails that
BEmailManager will allow to be
sent in one SmptClient session.

dotnet

MaxNumberOfRoutesToOptimize
Between

Edit

The maximum number of routes
that can be selected for
optimization between.

dotnet

MaxNumberOfRoutesToOptimize
Within

Edit

The maximum number of routes
that can be selected for
optimization.

dotnet

MaxOrderlmportThreadCount

Edit

The number of threads used in
the order import process.

dotnet

MergelncomingOrderlmportQueues

True (V') or False

Edit

Determines whether Incoming
OrderlmportQueues need to be
merged

dotnet

milesadjustmentpercent

10

Edit

NULL

dotnet

NotLoggedInEmailPriorityRoutesOnly

True (V') or False

Edit

Modifies the default
RoutesNotLoggedIn logic to
exclude routes which are not
priority routes.

dotnet

ondutywithdrivetime

True (V') or False

Edit

NULL

dotnet

OnFinalizeActions

ApplyFinalize
Lock|DeleteFake
Orders

Edit

Enables optional behaviors when
Finalize occurs

dotnet

ONFINALIZELEAVEORDER

True (V') or False

Edit

Defines the default behavior for
the finalize route process

dotnet

OrderManagementDisplayUserAlias

Job Name,ltem
Number
Description

Edit

Configuration to display up to two
User Fields in order management
module. Please enter comma
seperated aliases (value from
TBLUSERFIELDLIST.ALIAS column).
Ex: Spcinstr,LoadID

dotnet

PERFORMORDERIMPORTHASHING

True (V') or False

Edit

Determine whether or not the
order import process should
perform the hashing algorithm.

dotnet

RemoveEmptylLegs

True (V') or False

Edit

Enables removal of empty legs
from routes when moving or
unloading stop or route

dotnet

RestoreFakeOrders

True (V') or False

Edit

Decides whether or not fake
orders should be restored when
real orders are deleted.

dotnet

RouteBoardGeocodeOnlyUngeocoded
Default

True (V') or False

Edit

Routeboard - Geocode Only
Ungeocoded Records Default

dotnet

SecondaryGeocoder

Google

Edit

Determines what action needs to
be taken for Secondary Geocoder.

dotnet

SetStopSummaryViewModeToOrders

True (V') or False

Edit

This defaults teh stop summary
grid view to "Orders"

dotnet

ShiftBuildingMatchCriteria

TimeWindows

Edit

Decides how orders are
determined to match a shift.
Either by Time Window or by
Estimated Ship DateTime
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dotnet ShiftBuildingMode TimeWindowCo |Edit |Decides how Shifts are
des determined in the system. One
can either use "Custom" shifts or
"TimeWindowCodes".
dotnet SMTPENABLESSL True (v') or False |Edit [true/false
dotnet SMTPFROMADDRESS Edit |from address that is displayed in
the recipients email
dotnet SMTPFROMNAME Edit |from name that is displayed in
recipients email
dotnet SMTPLOGINNAME Edit |login info needed for smtp
authentication
dotnet SMTPLOGINPASSWORD Edit |password needed for smtp
authentication
dotnet SMTPPORT Edit |smtp port number
dotnet SMTPSERVERNAME Edit |smtp address
dotnet TRACKACCOUNTROUTEAUDIT None Edit |Enables tracking of the Account
Route Audit
dotnet UpdateUserFieldValueslIfExists True (v') or False |Edit |Determines whether or not user
field values will be updated by the
PeopleNet sync service if they
already exist in DRTrack.
dotnet UseAccountTWForServiceWizard True (v') or False|Edit |Set to false to use the geolocation
algorithm to get nearby account
time windows, true to pull the
Account Master time windows
dotnet UseDistanceEngine True (v') or False |Edit |Use the TMW Distance Engine to
generate distance entries rather
than using crow-fly distance.
dotnet UseGoogleForGeocoding True (v') or False|Edit |Use google for geocoding.
dotnet UseShiftsForOrders True (V') or False |Edit |Decides whether or not to use
shifts when recieving an order
and assigning the time window
dotnet UseZeroVolumeForCloning True (v') or False|Edit |Use zero for quantity volume
during cloning process.
DotNet DefaultEnableConfirmationOnRoute |True (V') or False|Edit |Determines if Confirmation Popup
Board Window on RouteBoard is
enabled by default
DotNet EnableTripSheetOnRouteBoard True (v') or False|Edit |Enables Print TripSheet button
and TripSheet Status indicator on
RouteBoard
DotNet OpenPatternsAndDatesOnOrders True (v') or False|Edit |Opens order delivery window
BeforeBuild patterns and earliest/latest date
when building routes.
DotNet ShowGeoresultUnloadedStopsRoute |True (V') or False|Edit |Shows GeoResult column on
Board Unloaded Stops Grid on Route
Board
DotNet ShowRoutesStopCountOnRoute True (v') or False|Edit |Shows Stop Count column on
Board Route List on Route Board
geocoding RunAddressCleanup True (v') or False|Edit |Determines whether or not to run
address cleanup routines when
geocoding
geocoding UpdateAddressAfterCleanup True (V') or False|Edit |Determines whether or not to
update an account with updated
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information from Address
Cleanup

GEOTAB

Database

Edit

Geotab Database

GEOTAB

Password

Edit

Geotab Password

GEOTAB

Server

Edit

Geotab Server

GEOTAB

Username

Edit

Geotab Username

iBright

AssetsBaseURL

https://api.ibrigh
t.info/vl

Edit

URL to Sync Drivers and Devices
in iBright with DRTrack.

iBright

EnablelBright

True (V') or False

Edit

iBright Integration. Options true
or false.

iBright

JobsBaseURL

https://flow.ibrig
ht.info/vendorap
i/vl

Edit

URL to export Routes/jobs to
iBright.

iBright

UseEditldentifierAsDevicelD

True (V') or False

Edit

Default Value false. This option is
used while synchronizing Device.
If false, XML element Name will
be used as DevicelD. If true, XML
element Editldentifier will be
used as DevicelD.

iBright

UseEditldentifierAsDriverID

True (V') or False

Edit

Default Value false. This option is
used while synchronizing Driver. If
false, XML element LinkingCode
will be used as DriverlD. If true,
XML element Editldentifier will be
used as DriverlD.

login

EarlyLoginBuffer

Edit

Manual logins must fall within X
hours before the planned start
time. Administrators can override.

login

EarlyLogoffBuffer

12

Edit

Manual logins must fall within X
hours before the planned end
time. Administrators can override.

login

LateLoginBuffer

Edit

Manual logins must fall within X
hours after the planned start
time. Administrators can override.

login

LateLogoffBuffer

12

Edit

Manual logoffs must fall within X
hours after the planned end time.
Administrators can override.

login

UseSingleSignOn

True (V') or False

Edit

Determines whether or not to use
a configured SSO Service for login.

NavTrak

Applicationld

Edit

Credentials to access NavTrak
webservice.

NavTrak

DisplayAddress

True (V') or False

Edit

Display Address in Garmin unit in
detail section. Options true or
false.

NavTrak

DisplayOrderld

True (V') or False

Edit

Display Orderld in Garmin unit in
detail section. Options true or
false.

NavTrak

EnableNavTrak

True (V') or False

Edit

NavTrak Integration. Options true
or false.

NexTraq

Applicationld

True (V') or False

Edit

Credentials to access NexTraq
webservice.

NexTraq

DisplayAccountld

True (V') or False

Edit

Display Accountld in message
section. Options true or false.
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NexTraq DisplayAccountName True (v') or False |Edit |Display AccountName in message

if not checked section. Options true or false.

NexTraq DisplayAddress True (v') or False|Edit |Display Address in message
section. Options true or false.

NexTraq DisplayOrderld True (v') or False|Edit |Display Orderld in message
section. Options true or false.

NexTraq DisplayPlannedArrivalDeparture True (V') or False |Edit |Display Planned Arrival and
departure in message section.
Options true or false.

NexTraq EnableNexTraq True (v') or False|Edit |NexTraq Integration. Options true
or false.

NexTraq NexTraqLastPingtime Edit |Default value blank. If blank,
when NexTraq executes for first
time, INIValue will be updated to
CurrentDate. If older than 7 days,
INIVAlue defaulted to
CurrentDate.

OMM AcceptableGeoResultsForReservation [Manual,LevelO,L |Edit |Comma delimited list of

Merge evell,71 acceptable georesults for orders
to be merged onto reservations.
oMM CreateShipToWithinOMM True (v') or False|Edit |Determines whether or not create
Ship To accounts as part of the
OMM process
oMM EnableValidateGeoResultsFor True (v') or False|Edit |Determines whether or not the
ReservationMerge geoResult of incoming orders
determines whether or not to
merge the order onto
reservations.

oMM GeocodeReservationOrdersBefore True (V') or False|Edit |Determines whether or not to

Merging geocode orders with reservations
before merging.

oMM OverwriteAccountEQCodeWithin True (v') or False|Edit |Enables updating the account eq

oMM code when updating from the
OMM.

oMM UpdateEqCodeWithinOMM True (V') or False|Edit |Updates Eq Code within OMM

oMM UpdateShipToLatLongsInOMM True (v') or False|Edit |Set to true to use update the
lat/longs when the address
matches the ship to and the
lat/longs dont, false to not
overwrite with new lat/longs on
matching address

oMM GeocodeAndRescheduleRouteOn True (v') or False|Edit |Determines if Modify Orders sent

AddressChangeWithinOMM through OMM get geocoded and
their routes rescheduled during
Import Orders scheduled task
oMM GeocodeAndRescheduleRouteOn True (v') or False|Edit |Determines if Modify Orders sent
AddressChangeWithinOMM through OMM get geocoded and
their routes rescheduled during
Import Orders scheduled task
oMM UPDATEACCOUNTLATLONGINOMM [True (¥) or False|Edit |Update Account Lat Long In OMM
oMM UpdateFinalizedOrdersinOMM True (v') or False|Edit |Allows finalized orders to be
updated through the OMM.
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OMM

UpdateFixedTimelnOMM

True (V') or False

Edit

Fixed Time fiedl in Account
Master will be updated when this
setting is set to true

OMM

UpdatePriorityBumplnOMM

True (V') or False

Edit

Priority Bump Factor field in
Account Master will be updated
when this setting is set to true

OMM

UpdatePriorityInOMM

True (V') or False

Edit

Priority field in Account Master
will be updated when this setting
is set to true

peoplenet

DispatchVehicleNumbersWith
Preassignments

True (V') or False

Edit

Determine whether or not to
send the vehicle_number with
route exports. Turning this ON
will automatically log the route in.

peoplenet

EnablePeoplenet

True (V') or False

Edit

Configuration to enable or disable
Peoplenet in DRTrack

peoplenet

PEOPLENETDATA1

Edit

userfield alias goes in here

peoplenet

PEOPLENETDATA2

Edit

userfield alias goes in here

peoplenet

PEOPLENETDATA3

Edit

userfield alias goes in here

peoplenet

PEOPLENETDATA4

Edit

userfield alias goes in here

peoplenet

PEOPLENETDATAS

Edit

userfield alias goes in here

peoplenet

PeoplenetQtyAlias

Edit

Determines the quantity field that
will be processed to show as
planned quantity in PeopleNet
devices.

peoplenet

PeopleNetQuantitySplitPickupAnd
Delivery

True (V') or False

Edit

Show the PeopleNetQtyAlias
quantity field as a dichotomy of
pickup/delivery

peoplenet

ProcessSequenceNumberWith
CustomerID

True (V') or False

Edit

Use customer ID to determine the
true sequence number between
PeopleNet and DRTrack. This is
more accurate for preventing
desyncs.

peoplenet

UpdatelLatAndLonglnLandmark

True (V') or False

Edit

Possible values (true,false). False:-
lat & long values will not be sent
from DRTrack to peoplnet while
updating the landmark table;
True:- when updating the
landmark table, Lat & long values
from DRTrack will also be sent to
peoplenet system.

peoplenet

UseShiptolnLandmark

True (V') or False

Edit

Possible values (true,false). False:-
use accountmaster address in
landmark table; True:- use shipto
address in landmark table.

Report

ReportExecActDomainName

Hosted

Edit

Enter the Windows account
domain name used to access the
SQL report.

Report

DefaultReportQtyAlias

Pallet
Qty,Hazmat

Edit

Default Qty Alias Fields for Report

Report

DefaultReportUserAlias

LOADID,OrigSeq

Edit

Default User Alias Fields for
Report

resources

AuthCompanyName

Edit

Determines the company
authentication credential used to
communicate with the resource
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service. Leave blank to configure
automatically.

resources

AuthPassword

Edit

Determines the password
authentication credential used to
communicate with the resource
service. Leave blank to configure
automatically.

resources

AuthUsername

Edit

Determines the username
authentication credential used to
communicate with the resource
service. Leave blank to configure
automatically.

resources

Url

http://resources.
routetracking.
com/

Edit

Configures the Url of the service
DRTrack will use for storing and
retrieving large resources.

Resources

ImageMimeType

image/jpeg

Edit

Tells the image processor what
file type to save images as.

Resources

ImageResizeMode

maximum

Edit

Tells the image processor how to
treat image size and aspect ratio.

Resources

MaxHeight

1024

Edit

Provides the height option for the
image processor.

Resources

MaxWidth

1024

Edit

Provides the width option for the
image processor.

Resources

Processimages

True (V') or False

Edit

Upload images with post-
processing options.

routeupload

AutoExportPeopleNet

True (V') or False

Edit

Enable or Disable Exporting
routes to PeopleNet on Upload

routeupload

CommitTransactionForEveryRoute

True (V') or False

Edit

Forces the route upload module
to commit the current database
transaction for each and every
route. This is needed for very
large route uploads.

routeupload

DoNotUseTransactionsDuringRoute
Upload

True (V') or False

Edit

Determine whether or not
transactions should be used
during the route upload process
at all.

routeupload

EmailRouteManifestToDrivers

True (V') or False

Edit

Enable or Disable Processing of
login status email notifications

routeupload

EnableShipToForRouteUpload

True (V') or False

Edit

Enables shipto for routeupload

routeupload

SendOrderScheduleEmailOnUpload

True (V') or False

Edit

Enable or Disable sending Order
Schedule notifications on export

routeupload

UpdateAccountMasterWithinOMM

True (V') or False

Edit

This flag will update Account
Master contact and address
information with new information
from the Order Management
Module.

routeupload

UpdateEditableTruckUserInfo

True (V') or False

Edit

Determines if editable truck user
fields need to be shown or not.

RouteUpload

AutoGenerateProfileMaster

True (V') or False

Edit

Allow the system to automatically
generate a profile master for the
given branch ID if one does not
exist.

stopdetection

AutologoffMaxGracePeriod

180

Edit

Maximum number of minutes
vehicle can be stationed at the
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terminal without triggering auto-
logoff even if other minimums
have not been met.

stopdetection

MatchStopListWithLegAndSeqOnly

True (V') or False

Edit

This flag affects services which
provide StoplLists in lieu of GPS
detection. If true, stops will be
matched based on Leg & Seq and
not AccountlDs.

stopdetection |MinPercentageRequiredForAuto Edit |Minimum percentage of route
Logoff completion required before
Autologoff can be triggered.
stopdetection |MinRequiredDurationForAutoLogoff |30 Edit |Minimum number of minutes that
the vehicle is at the terminal
before auto logoff can engage.
stopdetection |MinStopsRequiredForAutolLogoff Edit |Minimum number of actual stops

that must be detected for
Autologoff to be triggered.

stopdetection

UtilizeGPSTrailWithFormBasedArrival
Departure

True (V') or False

Edit

Determine whether to use
historical GPS data to help buffer
form arrival/departure in addition
to fixed time.

StopDetection

DetectZeroMinStopsAtPInStoplLoc

True (V') or False

Edit

Legacy configuration option.
Currently unused. Set
StopDetectionDurationNrPInStop
to 0 to achieve this.

StopDetection

DetectZeroMinStopsAtTermLoc

True (V') or False

Edit

Legacy configuration option.
Currently unused. Set
StopDetectionDurationNrTerm to
0 to achieve this.

StopDetection

MatchMultipleStopsWithSame
AccountID

True (V') or False

Edit

Default value false. If false, stop
matching will cease when a stop
is attempting to be matched to
multiple instances of the same
AccountID. If true, stops will
continue matching all occurrences
inside a geofence regardless of
accountlD.

StopDetection

MatchNonContiguousStops

True/False

Edit

Allows matching multiple stops
that satisfy the conditions of a
geofence without checking to
make sure their sequence
numbers are contiguous.

StopDetection

ProcessEmaillnSeperateThread

True (V') or False

Edit

Property to configure the delay
email notification needs to be
processed on a seperate thread.

StopDetection

StopDetectionDuration

15

Edit

Determines the minimum
duration required to consider a
series of points as a stop.

StopDetection

StopDetectionDurationNrPInStop

10

Edit

Overrides StopDetectionDuration
for points within a planned stop
geofence.

StopDetection

StopDetectionDurationNrTerm

Edit

Overrides StopDetectionDuration
for points within a terminal
geofence.
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StopDetection

StopDetectionSpeed

15

Edit

Maximum speed allowed for a
point to be considered in stop
detection logic.

StopDetection

StopDetectionStopGeofence

1500

Edit

Default geofence for a planned
stop location. Can be overridden
at Account Master level.

StopDetection

StopDetectionTerminalGeofence

2500

Edit

Default geofence for a planned
terminal.

StopDetection

StopMatchingStopGeofence

1500

Edit

Determine the geofence to use
for matching a stop to a planned
location. Dial this in if your stops
are clustered nearby one another.

StopDetection

StopMatchingTerminalGeofence

2500

Edit

Determine the geofence to use
for matching a stop to a terminal
location. Dial this in if your stops
are clustered nearby one another.

StopDetection

StopMergingDistance

1500

Edit

Determine the maximum allowed
distance for two stops to be
merged together into one stop.

StopDetection

StopMergingDuration

Edit

Determine the maximum allowed
duration between consecutive
stops for the stops to be merged
together into one stop.

TELETRAC

Accountld

Edit

Credentials to access TeleTrac
webservice.

TELETRAC

EnableTeleTrac

True (V') or False

Edit

Enables TeleTrac

TELETRAC

Password

Edit

Credentials to access TeleTrac
webservice.

TELETRAC

Routelnfo

Edit

Property for route information

TELETRAC

Stoplnfo

Edit

Property for stop information

TELETRAC

UserName

Edit

Credentials to access TeleTrac
webservice.

TOMTOM

OrderDisplayFormat

{Customer
Name}\n

Edit

Determines the format for order
detail data that is sent to
WebFleet/TomTom devices.

TOMTOM

OrderNoFormat

{AccountID}_
{OrderID}

Edit

Determines the format of the
order number sent to
WebFleet/TomTom

TOMTOM

Account

Traxxisgps

Edit

Account

TOMTOM

Password

XXXXXXX

Edit

Password

Username

Thom

Edit

companyname\username

TOMTOM
ui

AllowModifyStopAccountMaster

True (V') or False

Edit

Determines if stop needs to be
updated with new Account
Master information.

ui

BarCodeFields

confphn={user:D
elivery Confirm
Phone}|job={use
r:Job
Name}|confeml
={user:Delivery
Confirm

Email}| podphn={
user:Proof of
Delivery

Edit

Token string for bar code user
fields
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Phone}|podeml=
{user:Proof of
Delivery Email}|
ui CalendarQuantityDisplayLabel PT Edit |Displays user set Alias on route
calendar appointment block.
ui CalendarTruckCapacityQtyAlias True (V') or False |Edit |Displays QTY Alias on route
calendar appointment block.
ui DefaultDriverBreakTime 0.5 Edit |Allows user to set a default driver
break time in hours.
ui DefaultLoadDayCode 1 Edit |Set default Day code for Route
Board Master Route Search
ui EnableAutoRefreshOnOrderTracking |True (V) or False|Edit |Enables a user to auto-refresh the
order tracking page
ui EnableBuildRoutes True (v') or False|Edit |Determines whether or not the
Build Routes option is available
for use.
ui EnableSaveUserRouteStartTime True (v') or False|Edit |Keeps start times changed by
Changes users when optimizing
ui ExpandedStopSummaryMenu True (v') or False|Edit |Enables expanding stops
summary page button toolbar to
the pre-7x (expanded) layout
ui FixedRoutesAction None Edit |Determines what action needs to
be taken for fixed routes.
ui HazmatLimit 1000 Edit |Shows Hazmat warning on
Delivery sheet if total route
exceeds amount.
ui LassoStopsAction Build new route |Edit |Determines what action needs to
be taken when stops are lassoed.
ui LineltemDetailDisplayQtyFields Quantity,Hazmat|Edit |[Determines the quantity field that
will be displayed when viewing
line item details.
ui LineltemDetailDisplayUserFields ltem Edit |Determines the user fields that
Number,ltem will be displayed when viewing
Number line item details.
Description
ui MoveRoutesBetweenBranches True (v') or False|Edit |Determines if move routes
between branches button needs
to be enabled or not.
ui OrderBlockTokenString {CUSTOMERNA |Edit |Determines what fields show on
ME}| Pallets: Order Block in Detail View of
{Qty:Pallet Calendar
Qty}|{ORDERID}
[{CITY}, {STATE}
ui OrderCardQtyAlias1 True (v') or False|Edit |Displays QTY Alias 1 on order
card.
ui OrderCardQtyAlias2 True (v') or False|Edit |Displays QTY Alias 2 on order
card.
ui OrderCardUsrFIdAlias1 True (v') or False|Edit |Displays QTY Alias on order card.
ui OrderCardUsrFIdAlias2 True (v') or False|Edit |Displays QTY Alias on order card.
ui OrderSearchDatelLimit Edit |Sets the limit of the number of
days to be returned
ui OrderToolTipTokenString Customer Name:|Edit |Determines what fields show on
{CUSTOMERNA Order ToolTip in Detail View of
ME}|Address: Calendar

107




DRTrack 23.1

{Address1}|City,
State: {CITY},
{STATE}| Pallet
Qty: {qty:Pallet
Qty}{TIMEWIN
DOWS}|Job
Name: {user:Job
Name}|Custome
r PO:
{user:Customer
PO}|Order
Number:
{ORDERID}|Note
s: {user:Delivery
Instructions}
ui ReservationBlockTokenString Edit |Determines what fields show on
Reservation Block in Detail View
of Calendar
ui ReservationToolTipTokenString Edit |Determines what fields show on
Reservation Tooltip in Detail View
of Calendar
ui SearchQtyFields Weight,Quantity |[Edit |The qty fields on the application
search cards.
ui SearchUserFields Job Name,Proof |Edit |The user fields on the application
Of Delivery Email search cards.
ui ShowAccountAddress True (v') or False|Edit |Determines if account address
needs to be shown in the
routeboard and routesummary
page
ui ShowActualDeliveryQuantitiesin True (v') or False |Edit |show the actual gty in stop
StopsPage summary page
ui ShowAddressOnStopsPage True (v') or False|Edit |Displays the Address column/field
on the stop summary page
ui ShowEqCode True (v') or False|Edit |Determine whether or not to
show the EqCode column where
applicable.
ui ShowlLoadAndAssignForSuggest True (v') or False|Edit |Determines if load and assign
Routes needs to be shown in suggest
routes.
ui ShowMasterSearch True (v') or False |Edit |Enables search for order
ui ShowOrderBlockConfiguredFields True (v') or False|Edit |Show configured fields setting for
Only order block
ui ShowTruckCapacity True (V') or False|Edit |Determine whether or not the
truck capacity column will show in
the routes page
ui ShowTruckCapValueOnRoute True (v') or False |Edit |Displays truck loaded/capacity on
CalendarAppointment route calendar appointment
block.
ui SortRoutesByDisplayName True (V') or False |Edit |Set sorting routes by display
name property
ui SuggestStopsDisplayUserFields Edit |Select up to (2) user field aliases
to show in the suggest stops
window for each unloaded order.
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ui TruckCapacityQtyAlias Pallet Qty, Edit |Determine which quantity alias to
Hazmat use for showing truck capacity.

Default implies the first Qty.

ui UseDeliverySheet True (v') or False|Edit |Use the Driver Delivery Sheet

ui UseTruckProfileForSuggestRoutes True (V') or False |Edit |use truck profiles for route
suggestions

ul HideTempDrivers True (V') or False|Edit |Hides temporary drivers from
driver list drop downs.

UPL DateFormat Edit |The format used for dates

UPL EndingTerminal True (v') or False|Edit |Export the ending terminal

UPL HeaderRecord True (v') or False|Edit |Export the header record

UPL LineltemLevel True (v') or False|Edit |Include fields at the line item
level.

UPL OutPutFileName Edit |The name of the output file

UPL OutPutFilePath Edit |The server path to the output file

UPL OutPutFileSuffix Edit |The suffix of the output file

UPL QtyFieldAlias1 Weight Edit |The gty field to use for SFQTY001

UPL QtyFieldAlias10 Edit |The gty field to use for
SFQTY0010

UPL QtyFieldAlias2 Edit |The gty field to use for SFQTY002

UPL QtyFieldAlias3 Edit |The gty field to use for SFQTY003

UPL QtyFieldAlias4 Edit |The gty field to use for SFQTY004

UPL QtyFieldAlias5 Edit |The gty field to use for SFQTY005

UPL QtyFieldAlias6 Edit |The gty field to use for SFQTY006

UPL QtyFieldAlias7 Edit |The gty field to use for SFQTY007

UPL QtyFieldAlias8 Edit |The gty field to use for SFQTY008

UPL QtyFieldAlias9 Edit |The gty field to use for SFQTY009

UPL StartingTerminal True (v') or False|Edit |Export the starting terminal

UPL TimeFormat H:mm Edit |The format used for times

UPL TUserFieldAlias1 Edit |The user field to use for
TFUSERFLDO001

UPL TUserFieldAlias10 Edit |The user field to use for
TFUSERFLD0010

UPL TUserFieldAlias2 Edit |The user field to use for
TFUSERFLDO002

UPL TUserFieldAlias3 Edit |The user field to use for
TFUSERFLDO003

UPL TUserFieldAlias4 Edit |The user field to use for
TFUSERFLD004

UPL TUserFieldAlias5 Edit |The user field to use for
TFUSERFLDOO5

UPL TUserFieldAlias6 Edit |The user field to use for
TFUSERFLD006

UPL TUserFieldAlias7 Edit |The user field to use for
TFUSERFLDOO7

UPL TUserFieldAlias8 Edit |The user field to use for
TFUSERFLDO008

UPL TUserFieldAlias9 Edit |The user field to use for
TFUSERFLDO009

UPL UserFieldAliasl Edit |The user field to use for
SFUSERFLDO001

UPL UserFieldAlias10 Edit |The user field to use for
SFUSERFLD0010
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UPL UserFieldAlias2 Edit |The user field to use for
SFUSERFLDO002

UPL UserFieldAlias3 Edit |The user field to use for
SFUSERFLDO003

UPL UserFieldAlias4 Edit |The user field to use for
SFUSERFLD004

UPL UserFieldAlias5 Edit |The user field to use for
SFUSERFLDO005

UPL UserFieldAlias6 Edit |The user field to use for
SFUSERFLD006

UPL UserFieldAlias7 Edit |The user field to use for
SFUSERFLDO007

UPL UserFieldAlias8 Edit |The user field to use for
SFUSERFLDO008

UPL UserFieldAlias9 Edit |The user field to use for
SFUSERFLDO009

Whiteboard CreateNewRouteWhenDraggingStop |True (v') or False |[Edit |Creates a new route on the

ToEmptySlot resource planner when a planned
stop is dragged to an empty slot
in Details view. If false: Reassign
route

Whiteboard DefaultDaysAheadForRoutes 0 Edit |Defaults the calendar view to
show routes X days ahead of the
scheduler.

Whiteboard DefaultDaysAheadForUnloaded 7 Edit |Defaults the calendar view to

Orders show orders X days ahead of the
scheduler.

Whiteboard DefaultDaysBehindForRoutes 0 Edit |Defaults the calendar view to
show routes X days behind the
scheduler.

Whiteboard DefaultDaysBehindForUnloaded 7 Edit |Defaults the calendar view to

Orders show orders X days behind the
scheduler.

Whiteboard DefaultPromptAcceptBehavior AlwaysAccept |Edit |Determines the default
AlwaysAccept behavior for the
scheduler prompts.

Whiteboard DefaultPromptBehavior AlwaysPrompt |Edit |Determines the initial prompt
behavior when working with the
scheduler.

Whiteboard EndOfBusinessDay 21:00:00 Edit |Declares the end of the business
day for the default calendar view.
(HH:mm:ss)

Whiteboard LineltemDisplayQtyFields Quantity Edit |Determines which quantity fields
to show for line items in the
whiteboard.

Whiteboard LineltemDisplayUserFields ltem Edit |Determines which user fields to

Number,ltem show for line items in the
Number whiteboard.
Description

Whiteboard MinutesPerRow 15 Edit |Declares how large time
increments are defined for the
whiteboard.

Whiteboard RouteCalendarDefaultResourceView |Assets Edit |Determines the default resource
view in the whiteboard.
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Whiteboard RouteCalendarDefaultView Details Edit |Determines the default view in
the whiteboard.

Whiteboard RowHeight 15 Edit |Defines how tall (in pixels) a single
row in the scheduler displays.

Whiteboard Show24HoursByDefault True (V') or False |Edit |Defaults the calendar view to
show all 24 hours by default.

Whiteboard ShowNotesPanel True (v') or False|Edit |Shows notes panel on Route
Calendar

Whiteboard ShowUnloadedOrdersByDefault True (v') or False|Edit |Determines whether or not the

WhenViewingMap unloaded stops layer will be

visible by default when viewing
the map in the route calendar.

Whiteboard StartOfBusinessDay 6:00:00 Edit |Declares the beginning of the
business day for the default
calendar view. (HH:mm:ss)

Whiteboard UnloadedOrderDragDropBehavior Initialize Edit |Determines how to handle
unloaded orders that are dragged
onto the resource planner.

Xata ExportShipTo True (V') or False |Edit |Exports ShipTo address to Xata
when set to true

Xata ParentOrganizationID 0 Edit |ParentOrganizationID

Xata Password Edit |Password

Xata UnitQtyAlias Edit |Sepcify a gty alias that needs to
be exported as units to Xata

Xata Username Edit |companyname\username

Xata WeightQtyAlias Edit |Sepcify a gty alias that needs to
be exported as weight to Xata

XRS CompanylLoginID 599979 Edit |XRS Company Login ID

XRS ExportShipTo True (v') or False|Edit |Exports ShipTo address to XRS
when set to true

XRS Password Edit |XRS Password

XRS ProductCodeAlias Edit |Sepcify a user field alias that
needs to be exported as product
code to XRS

XRS RootOrganizationlD 0 Edit |RootOrganizationID

XRS UnitQtyAlias Edit |Sepcify a gty alias that needs to
be exported as units to XRS

XRS UnitQtyTypeAlias Edit |Sepcify a user field alias that
needs to be exported as unit type
to XRS

XRS Username VSawyer Edit |companyname\username

XRS WeightQtyAlias Edit |Sepcify a gty alias that needs to
be exported as weight to XRS
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Frequently Asked Questions

Note: Your routing procedures may be different than others. Some people route from the Calendar, some
from the Map, and some route from the Route Board. The following questions/instructions are answered
mostly with the assumption routing is performed from the Route Board. If you route from the Calendar
or Map and have the same the question/problem, you can still use the same instructions, or try the
resolution offered from the calendar. Some of the steps may be different on the Calendar, but you should
be able to glean some direction from the answers provided.

How do I see if a route has been Finalized?
e Go to Dispatch > Routes

— Select search criteria

— Finlized Routes will display the letter “E” in a column in front of the route number

— Any modification to the route after finalization will trigger #. to appear in front of the “E”

- will also appear in various route detail screens/windows to advise of the route
modifications

— Be sure to Re-Finalize to clear the warning and send the modified route details

How do | see if a route has been Exported?
e Go to Dispatch > Routes

— Select search criteria

— Exported Routes will display the 6-digit branch code in front of the original route number
(ex. 121-AKR28016-W)

— Any modification to the route after finalization will trigger £+ to appear in front of the “E”

— Re-Finalize & Re-Export to PeopleNet to send modified route details to PeopleNet

How to load Unloaded Stops?
e Go to Dispatch > Routes

— Select the branch and date range, then select the Load Unloaded Orders button

— Select the Load button and review results, then close the confirmation window (note that
only unloaded ‘real’ orders matching search criteria will be loaded/placed against existing
route placeholders)

— Go back to Dispatch > Routes

— Select the branch and date range, then select the Unloaded Stops tab

— Select the stop(s) to be loaded, activate the desired route number(s), then indicate the
desired sequence(s) and select Add Stop, OR

— Select the stop to be loaded, activate desired route number, then hold CTL key and mouse
click on the map in the desired delivery position, OR

— Select stop to be loaded, then select Suggest Routes; load the stop on the desired route

How do | move stops from one Master Route to another?
e Onthe Same Day

— Go to Dispatch > Routes
— Select the branch, then select Master Route
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— Select the Day Code, the route involved, and the stop sequence of the shipment
— Select View Alternates OR Unload Stop to process manually
e On a Different Day (Method A)
— Go to Dispatch > Routes
— Select the branch, then select Master Route
— Select the Day Code and the route involved
— Expand the shipment and select the Order ID hyperlink, then the Account ID hyperlink
— Change the delivery day pattern in the Delivery Time Window, then save & close
— Change Est Del Date to a new date (stay within the same week, Sunday to Saturday)
— Change the Delivery Day Pattern to a new day, then save & close
— Select the stop sequence of the shipment
— Select View Alternates OR Unload Stop to process manually
e On a Different Day (Method B)
- Goto Account Management
— Select the branch and Account ID
— Select the Account ID hyperlink and modify the required fields (Delivery Days & Frequency)
— Save the changes then return to Account Management main screen
— Select radial box of account

— Select Schedule Service and specify Master Route Profile to be adjusted from the drop
down menu

— Select Go to Suggested Days
— Select Select to Delete existing services for this account
— Complete the Schedule Service Wizard process
e On Multiple Different Days
- Goto Account Management
— Select the branch and Account ID
— Select the Account ID hyperlink and modify the required fields (Delivery Days & Frequency)
— Save the changes then return to Account Management main screen
— Select radial box of account

— Select Schedule Service and specify Master Route Profile to be adjusted from the drop
down menu

— Select Go to Suggested Days
— Select Select to Delete existing services for this account
— Complete the Schedule Service Wizard process

How do | adjust Capacity Gauge values?
e Method 1

— Go to Route Board > Master Routes and select the Day Code

— Make active the route to be changed

— Launch the Truck Info tab (right side of screen)

— Select Edit in the Truck Info window and the Truck Details box will open

— Under the Qty Values column, update each quantity value

— Save and reschedule

— Close additional browser tabs, then refresh the Route Board screen to view new values

e Method 2
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— Go to Admin > Master Routes and select the branch

— Specify the Day Code and select the Route # hyperlink, then select the Route Info tab
— Select Truck Info and under the Qty Values column, update each quantity value

— Save and reschedule

— Close additional browser tabs to return to Master Routes

How do | adjust the Start time of a Master Route?
e Method 1

— Go to Route Board > Master Routes and select the Day Code
— Make active the route to be changed
— Launch the Truck Info tab on the right side of screen
— Select Edit in the Truck Info window and the Truck Details widow will open
— Under the Work Rules column, update EarlyStart and LateStart
— Save and reschedule
— Close additional browser tabs and refresh the Route Board screen to view the new Start
Time
e Method 2
— Go to Admin > Master Routes and select the branch
— Specify the Day Code and select the route # hyperlink, then select the Route Info tab
— Select Truck Info under the Work Rules column and update EarlyStart and LateStart
— Save and reschedule

— Close additional browser tabs, return to the Master Routes main page and refresh to view
the modified route Start Time

How do I find a specific order?
e Go to Customer Service > Order Management and enter the order number

How do I find a specific route?
e Go to Dispatch > Routes > Advanced Options and enter the date range and route number

Where do | find unloaded orders?

e Go to Dispatch > Route Board and select branch, date range, and then Search
e Go to Dispatch > Unloaded Orders and select branch, date range, Daily or Master, and then
Search

Driver did not login to the route; how do | create a login?

e Go to Dispatch > Routes and select branch, date range, and then Search

e Find the route you want to create a login

e Select NA under the Driver column
— Select the DriverlD for the driver running the route
- Input the date/time the driver started the route
— Select the DevicelD of the tracking device
— Input the TruckiD
— Input the starting Odometer value of the truck (may have to input 0 if unknown)
— Select Assign Driver
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What drivers are running behind today?
e Route Details; far right column with symbol =) (= Delay Timer)

How to move stops from a current route
e Dispatch > Routes; select branch and date range, then select the stop to move
— Select View Alternates; find the route or best option, then select load

How do | see where my driver currently is?

e Dispatch > Routes; locate the correct route and select A

How do | export route to PeopleNet?

e Dispatch > Routes; select the box for the desired route and then select Finalize > Export to
PeopleNet

Adding new account to master routes
e Admin > Account Management

Select Show me only accounts which are active but not schedule for service
Select Account ID hyperlink

Update any missing information

Go through Schedule Service Wizard

How do | Create a new Daily Route?
e Dispatch > Routes > Create Route
e Select the Load Date and TruckID, and LoadID (RoutelD),
e Create Route > Add stops
e ** Fnsure that the “Truck/Route” isn’t currently a cloning Master Route (see Master Routes)
e ** Fnsure that the “Truck” has an EDay = 1 (see Truck Details)

How do | log a driver off a Route?

e *Method 1*- Dispatch > Routes > Select search criteria > Driver Column Hyperlink for Route # >
"Logoff” data fields > Specify Date > Specify Time > Indicate Correct Odometer End > LOG OFF >

Export to PeopleNet
e *Method 2*- Homepage/Dashboard > Route Details > Driver Column Hyperlink for Route # >

"Logoff” data fields > Specify Date > Specify Time > Indicate Correct Odometer End > LOG OFF >

Export to PeopleNet

How do | assign a different driver to a route?
1. Daily Route

e *Preassigned*- Dispatch > Routes > Select search criteria > Driver Column Hyperlink for Route #

> ”"Remove Pre-assignment” > Reselect Driver Column Hyperlink > Select Driver > Pre-assign
e *Logged In*- NOTE: The active or Logged in Driver MUST log off the route and complete the

“Route Release” process. You can then proceed to Pre-Assign the replacement driver > Dispatch

> Route Details > Driver Column Hyperlink for Route # > Select Driver > Pre-Assign > Export to

PeopleNet
2. Master Route
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e To Change a Preassigned driver - Admin > Master Routes > Select search criteria > Driver Column
Hyperlink for Route # > “Remove Pre-assignment” > Reselect Driver Column Hyperlink > Select
Driver & Record Driver ID # > Pre-assign new driver > Select Route # hyperlink of changed driver
> Route Info > Truck Info > Indicate NEW DriverlD (recorded during earlier step) > Save All

Un-consolidate and Move Orders/Stops

e Dispatch > Routes Page > Select branch-date range > Identify Route > View Stop Summary >
Select stop/order to be moved > Stop Actions > Move Stops > Select “To” Route from Dropdown
> Indicate Stop Sequence > Select “Move Stops”

Daily Tracking
e Routes (see how drivers are doing, locate driver location)
e Dashboard (locate drivers who are delayed, snapshot of day)

Daily Routing
e Route Board (adding unloaded orders)
e Routes (finalize and export to PeopleNet, move driver to new route)

Creating Dummy Orders

e Dispatch > Create Order > Select Account to place order off of (Note* If account does not exist
within DRTrack you can create an account). Once account is created fill out create order
information (time windows, order details, etc.) Click finish in top right corner. That order can
now be found under the unloaded orders tab.

How to find an order within DRTrack?

e Customer Service > Order management > select criteria (branch, account name, order number,
etc.) > click search.

How to add a new user?

e Admin > Site > Users > Click Add New (top right corner) > Fill out the general information at top
of screen (Note* be sure to select appropriate branch at the bottom of the screen then click
save).

How to delete a user?

e Admin > Site > Users > Check box beside user you are wanting to delete out on left hand side
(that line/row will highlight in the color of blue) go to the top right corner and hit delete.
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